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Prefacio

Obrigado por ter adquirido o receptor, 0 equipamento de
medicdo ou acessorios Topcon (0 “Produto”). Os materiais
disponiveis neste Manual (o “Manual”) foram preparados pela
Topcon Positioning Systems, Inc. (“TPS”) para proprietarios dos
produtos Topcon. Ele é designado a dar assisténcia aos
proprietarios para o uso do Software (o0 “Software”) para ser
usado com o produto e 0 seu uso esté sujeito a estes termos e
condicdes (os “Termos e Condicdes™).

@ AVISO

Favor ler estes Termos e Condi¢cdes com
atencao.

Termos e Condicdes

USO PROFISSIONAL - Produtos Topcon séo designados para
serem usados por um profissional. O usuério deve ser um
agrimensor ou técnico profissional ou ter um bom conhecimento
de topografia e agrimensura para que entenda as instrucdes de
uso e de seguranca.antes de operar, inspecionar ou ajustar. Deve-
se usar sempre 0 vestuario de seguranca exigido (sapatos de
seguranca, capacete, etc.) quando estiver operando os Produtos.

DIREITOS AUTORAIS - Toda informacéo contida neste
Manual é material de propriedade intelectual, e de direitos
autorais da TPS. Todos os direitos reservados. Ndo pode ser
usado, acessado, copiado, salvo, mostrado, usado para criar
outros trabalhos, vendido, modificado, publicado, distribuido, ou
permitir 0 acesso de qualquer terceira parte, qualquer gréfico,
contetdo, informagdo ou dados deste Manual sem o
consentimento por escrito expresso da TPS, e tais informacdes
somente podem ser usadas para o cuidado e operagdo do seu

Vii
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Produto. As informac6es e dados deste Manual séo recursos
valiosos da TPS e sdo desenvolvidos a custo de trabalho
consideravel, tempo e dinheiro, sdo o resultado da sele¢éo
original, coordenacdo e adaptacdo realizada por TPS.

MARCAS REGISTRADAS - Topcon® , e Topcon Positioning
Systems™ sdo marcas ou marcas registradas da TPS. Windows®
e ActiveSync® sdo marcas registradas da Microsoft Corporation.
A nomenclatura Bluetooth® e logos séo de propriedade da
Bluetooth SIG, Inc. e qualquer uso de tais marcas pela Topcon
Positioning Systems, Inc. esta sendo usada sob licenca. Outros
produtos e nomes de companhias aqui mencionados podem ser
marcas registradas dos seus respectivos proprietarios.

RETRATACAO DE GARANTIA - COM EXCEGCAO DE
QUALQUER GARANTIA DO APENDICE OU UM

CARTAO DE GARANTIA ACOMPANHADO DO
PRODUTO, ESTE MANUAL , O PRODUTO E QUALQUER
OUTRO SOFTWARE ACOMAPNHANTE SAO
FORNECIDOS “NAS CONDICOES EM QUE SE
ENCONTRAM”. NAO HA OUTRAS GARANTIAS. A TPS
DESAPROVA QUALQUER GARANTIA QUE IMPLIQUE
COMERCIO OU CONVENIENCIA PARA QUALQUER USO
OU PROPOSITO PARTICULARES. A TPS E SEUS
DISTRIBUIDORES NAO SERAO RESPONSAVEIS POR
ERROS TECNICOS OU EDITORIAIS OU OMISSOES
CONTIDAS AQUI, BEM COMO POR DANOS ACIDENTAIS
OU CONSEQUENTES DANOS, RESULTANTES DO
EQUIPAMENTO, PERFORMANCE OU USO DESTE
MATERIAL, O SOFTWARE, OU O PRODUTO. TAIS
DANOS INCLUEM, MAS NAO SAO LIMITADOS A: PERDA
DE TEMPO, PERDA OU DESTRUIGCAO DE DADOS, PERDA
DE LUCRO, INVESTIMENTOS OU RENDA, OU PERDA DO
USO DO PRODUTO. ALEM DISSO, A TPS NAO E
RESPONSAVEL POR DANOS OU CUSTOS INCORRIDOS
NA OBTENCAO DOS PRODUTOS SUBSTITUIDOS OU
SOFTWARE, REIVINDICAGAO DE OUTROS,

viii
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INCONVENIENCIA, OU QUAISQUER OUTROS CUSTOS.
EM QUALQUER SITUACAO, A TPS NAO TERA
RESPONSABILIDADE ALGUMA POR DANOS OU, DE
OUTRA FORMA, POR VOCE OU ALGUMA OUTRA
PESSOA OU ENTIDADE QUE EXCEDA O PREGCO DE
COMPRA DO PRODUTO.

ACORDO DE LICENCA -0 uso de qualquer programa de
computador ou software fornecido pela TPS ou baixado do site
TPS (o “Software”) a serem usados com o0s produtos Topcon
constitui aceitacdo destes Termos e Condicdes contidos neste
Manual, assim como um acordo para executar estes Termos e
Condigdes. Ao usuario é concedido uma licenca pessoal, ndo-
exclusiva, ndo-transferivel para o uso de tal Software sob os
termos aqui descritos e em qualquer caso somente com um
Unico produto ou um Unico computador. Vocé pode fazer uma
cOpia de seguranca do Software. Assim sendo o Software nao
pode ser copiado ou reproduzido. Vocé ndo pode homear ou
transferir o Software ou esta licenga sem expresso consentimento
por escrito da TPS. Esta licenca é efetiva até que seja concluida.
Vocé pode acabar com a licenga a qualquer momento, destruindo
o Software e 0 Manual. A TPS pode cassar a licenca se vocé
falhar em cumprir quaisquer dos Termos ou Condigdes. Vocé
concorda em destruir o Software e 0 manual assim que acabar o
seu uso do Produto. Toda propriedade, direitos e outros direitos
de propriedade intelectual e do Software pertencem a TPS. Se
estes termos de licenca ndo sdo aceitaveis, devolva qualquer
software e manual ndo utilizados.

CONFIDENCIA — Este Manual, seu contetdo e 0 Software
(coletivamente, o “Confidential Information™) sdo informac6es
do proprietario e confidenciais da TPS. Vocé concorda em tratar
as Informacdes Confidenciais com um grau de cuidado ndo
menos estrito que o grau de cuidado que vocé usaria para proteger
0 seu segredo comercial mais valioso. Nada sobre Informaces
Confidenciais, neste paragrafo, deve ser mantido confidencial aos
seus empregados, se necessario para operar ou cuidar do Produto.

IX
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Tais empregados devem também manter as Informagdes
Confidenciais em sigilo. Na necessidade de vocé se tornar
legalmente obrigado a revelar quaisquer Informagdes
Confidenciais, vocé deve notificar a TPS, imediatamente, para que
possam procurar uma ordem de prote¢éo ou outra solugéo
apropriada.

WEBSITE; OUTRAS DECLARACOES - Nenhuma
declaracdo existente no website TPS (ou outro website) ou em
outras publicagdes ou matéria/literatura da TPS ou feito por um
empregado ou contratado independente da TPS modifica estes
Termos e CondicGes (incluindo a licenca do Software, garantia e
limitacdo de responsabilidade).

SEGURANCA - O uso impréprio do Produto Topcon pode
levar a acidentes com pessoas ou propriedade e/ou mal-
funcionamento do produto. O Produto somente deve ser reparado
por centros autorizados de servigo com a garantia TPS. Os
usuarios devem revisar e prestar muita atencdo aos avisos de
seguranca no manual que acompanha o produto.

MISCELANIA - Os Termos e Condicdes acima podem ser
retificados, modificados, substituidos ou cancelados, a qualquer
momento pela TPS. Os Termos e Condic¢des acima serdo
administrados e construidos em acordo com as leis do estado da
Califérnia, sem referéncia a conflito de leis.

Suporte Técnico

Para suporte técnico referente a este software, por favor
entre em contato com o seu distribuidor.

X
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Convencdes deste Manual
Este manual utiliza as seguintes convencdes:

Examplo Explicacdo

File->Exit Cligue o menu File e depois Exit.

Enter Indica o botéo ou a tecla Enter.

Topo Indica 0 nome da caixa de dialogo ou tela.
Notes Indica um campo da caixa de diadlogo ou uma

opcéo dentro da caixa de didlogo ou tela.

$ DICA

Informac0Oes adicionais, as quais podem ajudar a
configurar, manter, ou iniciar um sistema.

@AVISO

Informacg@es adicionais que podem ter um efeito no
sistema operacional, na performance do sistema, nas
medidas, ou seguranca pessoal.

é PRECAUGAO

Notificacdo de que uma agéo tem possibilidade
de afetar negativamente a operacao so sistema, o
performance do sistema, a integridade dos dados
ou a saude pessoal.

Xi
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O Que Ha de Novo no Topcon Tools 1.20

O Que Ha de Novo no

Topcon Tools 1.20

As seguintes informacdes descrevem, rapidamente, as novas
funcdes e caracteristicas da Versdo 1.20 do Topcon Tools.

= Pds-Processamento dos dados de cinematico continuo

Pontos cinematicos e as observagdes (vectores) podem
ser mostradas e pds-processadas.

= A disponibilidade de personalizar datum e projecdes. Veja
“Adicionar uma Projecéo Personalizada” na pag 2-12 e
“Adicionar umDatum” na pag 2-14 para detalhes.

= Mais opgoes de Filtros

Duas novas opgdes foram implementadas na selecdo do
tipo (agora na aba chamada de “By Type”).

« By Time filtra od dados baseados no tempo dos
dados coletados.

* By Code filtra os dados com base nos c6digos usados
para 0s pontos, as observacdes e ocupacdes.

Veja “Filtrar Dados” na pag 4-27 para detalhes.

= Atualizacdo da lista de colunas para as abas TS Obs e GPS
Obs na vista tabela

A coluna AutoReject indica se as observagdes tém ou ndo
tem a permissdo de realizar o ajustamento, podendo ser
modificadas usando as op¢Oes da lista.

Xilii
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O Que Ha de Novo no Topcon Tools 1.20

A coluna Adjustment status indica se as observagdes
foram ou ndo ajustadas, auto-rejeitadas ou desabilitadas.

Para a aba GPS Obs, a coluna Orbit mostra o tipo de
dados da 6rbita (Broadcast, Precise, or None) disponivel
para o processamento desta observacéo, caso ela ndo
esteja processada. Se estiver processada, esta coluna
mostra o tipo de dados de drbita utilizado no
processamento. Esta informacdo ndo se aplica as
observagbes RTK.

= Medic3o a Trena

Topcon Tools processa e ajusta 0s dados de medicdo a
trena. Quando uma obra contém os dados de trena, uma
nova aba sera mostrada na vista Tabela. Veja mais
detalhes em:

» “Aba Tape Dimension” na pag 4-10 para a descri¢do
da aba na Vista Tabela.

» “Editar Propriedades da Medicdo a Trena” na pag 5-
36 para detalhes da caixa de dialogo Properties.

= Personalizacdo da Barra de Ferramentas

Esta nova funcéo, adiciona e personaliza a barra de
ferramentas para o uso pessoal. Os botdes da barra de
ferramentas também podem ser personalizados para
funcGes ou agbes especificas.

Para personalizar a barra de ferramentas para o uso
pessoal, veja “Personalizar Barra de Ferramentas” na
pag 4-33.

= Avancos no Controle de Qualidade

X1V

O painel Quality Control na caixa de didlogo Job
Configuration tem, agora duas novas abas: Precisions e

Topcon
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O Que Ha de Novo no Topcon Tools 1.20

Automatic Tests. Veja “Definicdo do Controle de
Qualidade” na pag 2-19 para detalhes.

* A aba Precisions define, manualmente as precisdes
requeridas para TS, RTK, and PP. Estes parametros
definem as precisdes desejadas das medic¢des da
obra. Quaisquer medig¢des que ndo atendem a
precisdo desejada, serdo consideradas suspeitas e
serdo sinalizadas em vermelho.

« A aba Automatic Tests habilita ou desabilita a
execucdo automatica dos testes de retaguarda. O
novo teste automatico inclui: “pontos idénticos”,
“OcupacBes GPS sem Nome” e “Ponto Autotopo
sem Nome”. Os trés testes sdo automaticamente
incluidos nos relatérios. Quaisquer entidades tidas
como suspeitas, serdo sinalizados em vermelho.

= Fechamentos Interativos

Veja “Processar 0s Fechamentos e Visualizar o
Relatério” na pag 7-3 para detalhes.

= GIS

O Moddulo GIS esta disponivel para visualizar e
processar dados DGPS. Veja “GIS Module” na pag 1-13
para detalhes. Quando esta no modo GIS, o termo
“GPS+" sera mostrado como “DGPS”.

XV
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Introducao

Bem vindo a Topcon Tools™, o mais amigavel e poderoso
software de pos-processamento disponivel no mercado. Topcon
Tools fornece um ambiente de apresentacdo integrada para uma
simples e réapido processamento e ajuste das observacGes de
campo, coletados com os instrumentos Topcon.

Topcon Tools é composto de mddulos, tais como: Processamento
de dados de Estacdo Total e/ou RTK, Pds-Processamento das
Observacgdes GPS ou Combinacédo dos trés opgbes de Madulos.

Os iniciantes e 0s veteranos experientes no campo da geodésia
podem usar:

Topcon Tools para:
* Pds-processamento.

* Linha de base GPS.

Processamento de observagdes de ET e/ou RTK.

Ajuste de Redes.

Visualizacdo e Edicdo de coordenadas e dados brutos.

Importagdo de dados.

Importagédo de dados de receptores Topcon GPS+, controlador,
Estagdo Total a um computador.

» Exportacdo de arquivos.
Topcon Tools tem visualizagdo Tabular e Gréfica dos dados:

» A Tabular possibilita a visualizacdo dos pontos sobre a linha,
dos vetores e informacdes de ocupacdo, dos pontos com 0s
mesmos nomes e ainda, classificar as linhas em ordem

1-1
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alfabética por tempo, ou por aumento ou diminui¢do de
valores.

« Utilize a vista Map para mostrar a configuracdo da rede
comum, a estimativa da posi¢cdo mutua de pontos e vetores e
busca de pontos e vetores.

« Utilize a vista Occupation para visualizar as ocupagdes.

» As modificagOes realizadas em determinada vista sdo aplicadas
também em outra vista, permitindo a visualizacdo e edicdo
dados, bem como a estimativa de resultados de forma réapida,
conveniente e eficaz.

Instalando Topcon Tools

O software Topcon Tools é fornecido no CD para ser instalado no
computador.

1. Insira 0 CD Topcon Tools no drive CD-ROM. O aplicativo
InstallShield® Wizard ser& aberto.

2. Pressione Next na caixa de didlogo do assistente de instalacdo
do Topcon Tool para iniciar o processo de instalagéo.

Topcon Tools v.1.20 &l

‘Welcome to the InstallShield Wizard for Topcon
3 Tools

The InstallShield® wizard will install Topcon Tools on waur
camputer. Tao cantinue, click Next,

Cancel

Figure 1-1. Inicinado a Instalagéo

1-2
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3. Pressione Yes caixa de didlogo da License Agreement.
Pressionando a opcéo No, ir4 interromper a instalagéo

Topcon Tools v.1.20

License Agreement

Please read the fallowing license agreement carefull . .

Fress the PAGE DOWH key to see the rest of the agreement

Please 12ad this software license agrsement carsfully before pressing the "Yes" button, -~
Having pressed the "Yes" button pou are agreeing to be bound by the terms of the license
by installing, copying, or othenwize using product. [f pou do not agree to the terms of the
license, press the "Back” button and returm the Topcon software to the place where pou
obtained or get in touch with your Topean distributor. |f vou downloaded the Topean
software from web site, just delete it from the computer.

1. Software License. 4l software and documentation accompanying this License
Agreement whether on disk, in read only memory, on any other media o in any other form
are licensed to pou by Topcon Positioning Spstems or its daughter enterprises. “our awn

-

Do you accept all the terms of the preceding License Agieement? If you choose No, the
setup wil close. Tainstall Topeon Tools, you must accept this agreement.

< Back Yes Mo

Figure 1-2. Acordo de Licencga

4. Informe o nome do usuério e 0 nome da companhia. Depois
pressione Next.

Topcon Tools v.1.20

Customer Information
Please enter your information. I h

User Name:

[Yohn &, Public

Company Name:

[arymshere. Inc

Install this application for

& Anyans wha usss this computer [all users)

" Only for me (TOPCON)

< Back Next N Cancel

Figure 1-3. Informacédo do Usuério

1-3
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5. Na caixa de dialogo Choose Destination Location pressione
Browse para selecionar a pasta ou digite uma nova pasta na
qual serd instalado o Topcon Tools. Pressione Next.

Topcon Tools v.1.20

Choose Destination Location

Select folder where Setup wil install files
Setup willinstall Topean Taols in the fallowing folder

To install to this folder, click Mext. Toinstall to & different folder, click Browse and select
another folder.

Destination Folder

C:\Progiam Files\Topcon' TopeonT ools 1.204 Browse

< Back

Carcel |

Figure 1-4. Escolha da Pasta

6. Aceite a pasta default, selecione a pasta da lista, ou digite o
nome da nova pasta para o Topcon Tools. Depois pressione
Next.

Topcon Tools v.1.20

Select Program Folder

Pleass select a program folder

Setup will add program icons to the Program Folder listed below. Y'ou may type a new folder
name, or select one from the existing folders list. Click Mext to continue,

Program Falders:
|Topcon

Existing Folders:
Arcessories

< Back Next >|i Cancel

Figure 1-5. Selecao da Pasta do Programa
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Inicia o processo de instalagéo.

Topcon Tools v.1.20 (X
Setup Status _ 'ﬂ‘

Topcon Toaks Setup is perfarming the requested operations.

C:\Program Files\TopconhTapconToals 1.20 1.2048Geoid35Fiker. dl

69%

Figure 1-6. Instalagdo em Andamento

7. Click Finish to exit the installation (Figura 1-7)

Topcon Tools v.1.20

Instali5hield Wizard Complete
N

Setup has finished instaling Topcon Tooks on your computer.

Figure 1-7. Término da Instalacéo

8. Crie o icone do Topcon Tools na tela do computador para o
inicio rapido do programa.

TR TeeE

Figure 1-8. icone do Topcon Tools

1-5
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Instalando Microsoft Activesync

Para importar dados do controlador TPS para o Topcon Tools,
instale primeiro o ActiveSync® da Microsoft® no computador.
ActiveSync estabelece a conexdo entre o computador e
equipamentos moveis, como o Controlador TPS. O equipamento
movel deve possuir o sistema operacional Windows CE.
ActiveSync esta  disponivel no website da Microsoft
(http://www.microsoft.com).

Siga 0s seguintes passos para estabelecer a conexdo entre o
computador e o Controlador TPS:

1. Caso necessario, faca o download e instale o Microsoft
ActiveSync seguindo as instrucfes da tela do Microsoft.com e
o instalador do ActiveSync.

2. Usando o cabo de interface RS-232 ou cabo USB, conecte o
Controlador TPS na porta serial ou USB do computador. Com
0 conector Ethernet, é possivel conectar o Controlador TPS a
uma rede.

Ligue o Controlador TPS e o computador.
4. Inicie o Microsoft ActiveSync.

5. Pressione Next na caixa de dialogo Get Connected.

Get Connected @

Get Connected

To connect your device to this PC:

1. Connect the cable to the PC
2. Tum on the device

3. Place the device in its cradle

ActiveSyne should automatically detect your device.

IF your device is not autrnatically detected, click Ne#t
If you are wsing infrared (IR), click Help

Cancel | Heo |

Figure 1-9. ActiveSync — Conectar

1-6
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O computador estabelece a conexdo com o Controlador TPS. Se o
Controlador TPS esta ligado e configurado para a porta serial,
USB, ou ainda, a rede local (LAN) a seguinte caixa de dialogo sera
mostrado.

|
&3 Microsoft ActiveSync 0 [ S
File View Tods Help

@6@

Sync Siop || Detais Explore Optiors
Guest

+
Connected S

Information Type | Status

Figure 1-10. Conex&o entre PC e Controlador

A janela do sistema mostra um circulo verde para indicar a
conex&o do Controlador TPS ao computador.

£:16 PM Suceessiul

:l.:?mnﬂ 0@&53 Connection

@ Figure 1-11. Conexéo Establecida
AVISO

TopSURV mantem os arquivos .tsv no formato que
podem ser abertos somente nos equipamentos
Windows CE e ndo nos PC’s. Durante a importacéo
de dados do Controlador TPS ao PC, o Topcon Tools
converte o0s tais arquivos para o formato acessivel
(*.tlsv).

é PRECAUCAO

Para evitar a perda de dados durante a
exportagdo de arquivos *.tsv do Controlador TPS
ao PC, use somente o Topcon Tools ou Topcon
Link.

1-7
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Caso o PC tenha somente uma porta serial (COM):

1. Inicie Microsoft ActiveSync.

2. Pressione File->Connection Settings.

File Wiew Tools Help

Synchronize
Stop

Mabile Device 2
Explare
Delete Partnership

Get Connected. .,

Connectiol

Close

Figure 1-12. Abrir Configuragdo da Conexéao

3. Nacaixa de dialogo Connection Settings, pressione e
habilite os seguintes parametros:

« “Allow network (Ethernet) Remote Access
Service (RAS) server connection with this desktop

computer”
113 H 1 7
+ “Show status icon in Task bar
Connection Settings E‘
Q Click Get Connected to connect pour mobile device ta this
i@@ computer.
Status: Device connected
W llovs senal cable of infrared connection to this COM pork:
Status:  COM port is avallable
v Allow USE connection with this desktop computer.
Status: Connected
[ Allow network [Ethernet] and Remaote Access Service [RAS)
servel cohnection with this desktop computer.
Status:  MNetwork is available
Status icon
¥ Show status icon in Taskbar,
oK | Cancel | Help

Figure 1-13. Configuracéo da Conexao
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Neste caso, 0 ActiveSync ndo pede a porta serial apds
desconectar o Controlador TPS do computador. A porta
serial conecta o computador ao receptor TPS GPS+ ou a
Estacédo Total.

Caso tenha duas ou mais portas seriais no computador:

1. Inicie Microsoft ActiveSync.
2. Pressione File->Connection Settings.

3. Na caixa de didlogo Connection Settings:

 Habilite a opcdo “Allow serial cable or infrared
connection to this COM port”

« Selecione a serial desejada da lista, geralmente COM 1

Connection Settings x|
joij Click Get Connected to connect your mobile device to this
T, cemeler

Statusg: \Waiting for device to connect Get Connected...

¥ Aliow serial cable or infrared connection to this COM port

[comz =

Status:  COM port is available

Figure 1-14. Configuragéo para Multipla Porta Serial

Neste caso, Microsoft ActiveSync solicita a porta serial ap6s
desconectar o controlador do computador. Esta porta serial estara
disponivel somente para 0s equipamentos com 0 sistema
operacional Windows CE.

$ DICA

Reserve uma porta serial para conectar o Controlador-
Computador e outra para a conexao Receptor/Estacado Total-
Computador.

Para re-conectar o Controlador ao computador, utilize a
mesma porta serial definida no Connection Settings.

1-9
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Iniciando Topcon Tools

Dependendo dos mddulos do software, sera necessario tanto o
hardware lock, como um c6digo de acesso para iniciar 0 Topcon
Tools.

1. Caso tenha hardware lock (dongle), instale-o na porta paralela
(LPT). Topcon Tools necessita desta chave para iniciar.

Insert Hardware Lock
Into Computer's
LPT Part

Figure 1-15. Conectar o Hardlock

2. Inicie o Topcon Tools de duas maneiras:
* Pressione Start->Programs->Topcon->TopconTools.

* Cligue duplo no icone Topcon Tools.

3. Para iniciar outros Modulos, é necessario ter um Codigo de
Acesso. Entre em contato com o seu distribuidor TPS para
adquirir o tal codigo. Informe o cédigo de acesso e pressione
OK.

&4 Enter Access Code
Kew Value |JEKE-MJDI-HIFE-RFBG

Access Code |

Accessz Code iz available from Topcon Sales Support

oK Demao Mode ‘ Cancel ‘

Figure 1-16. Informe o Cddigo de Acesso
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Topcon Tools também dispde do Mddulo Demonstracao, onde
é possivel acessar todas as fungbes do software, porém esta
restrito a processamento de cinco ocupacgfes de cada obra. Para
utiliza-lo como Demo, pressione 0 botdo DEMO da caixa de
didlogo Enter Access Code.

A tela principal do Topcon Tools serd mostrada:

;4 artup

3
CiProgr... 17:2..  16:41:16 08 Jun 2004
@ PrownTPS  CProgr..  15:0..  14:40:25 01 Jun 2004
@ Ratcliffrd CProgr... 120, 134145 28 Apr 2004 Open job
@ Rosic Par CiProgr... 142, 16:42:07 08 Jun 2004

@ test CiProgr... 10:3..  10:37:11 01 Jun 2004
@ TPsiobsite  C\Docu.. 134, 13:42:06 28 Apr 2004
@ westland CiiProgr... 1S:5..  11:43:34 08 Jun 2004

Browse:

Close

Figure 1-17. Tela de Inicio do Topcon Tools

A tela inicial mostra automaticamente mostra a pasta destino da
obra ou abre a obra mais recente.

» Veja Getting Acquainted na pag 1-14 para detalhes de varias
ferramentas e menus disponiveis no Topcon Tools.

* Veja “Job Files” na pag 2-1 para detalhes da tela inicial e suas
selecdes.

* Veja “View Options” na pag 4-1 para detalhes da visualizagdo
de dados disponiveis no Topcon Tools.

Topcon Tools também permite a técnica “arraste e solte”. Topcon
Tools pode ser aberto ou fechado através de:

1. Windows Explorer e navegar até o local do arquivo
desejado.

2. Clicar e segurar 0 arquivo a ser aberto.

1-11
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3. Arrastar e Soltar o arquivo a ser aberto.

w4 Topeon Took

| & | "5

B Ede Vew Fpeortes

Q- Q
s [0 Ciprogram FesTopsonTesstods 121,200 ¥, [ &0
Fukirs . Momg =

= a badhm

= O ToonTocks 120 B AdTiktte
: Prownl s tp

§ ety
% Westand i

Figure 1-18. Abrir Arquivo através de Arrastar e Soltar
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Esteja Familiarizado

Esta sessdo apresenta vérias fungbes como, visualizacdo,
configuragdo ou edicdo de dados disponiveis no Topcon Tools.
AVISO

Dependendo dos Mddulos adquiridos, as opgoes, as
visualizacdes e as funcbes podem variar.

Mdédulos do Topcon Tools

Topcon Tools can be packaged as a module based on the needs
and requirements of different jobs.

Mddulo P6s-Processo
Inclui as funcdes de pos-processo dos dados GPS+.

Médulo RTK

Inclui as fungdes de importacao, visualizacdo, ajustamento,
exportacdo e relatério de daods RTK (dados coletados no
modo RTK, usando o TopSURV ou outro software de
coleta de dados).

Médulo TS (Estacédo Total)

Inclui as fungdes de importagdo, visualizagdo, ajustamento,
exportacdo e relatorio dos dados coletados com Esta¢des
Totais.

Mddulo GIS
Versdo menos precisa e menos sofisticada do Médulo Pos-
Processo para processamento de dados DGPS.

1-13
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Tela Principal

A tela principal do Topcon Tools tem o0s seguintes
componentes:

* Barra de menu — contém o menu de sele¢do para varias
fungdes do Topcon Tools.

 Barra de Ferramentas — contém botdes de icones para as
fungdes freqlientemente usadas.

« Barra de Estado — mostra mensagens informativas sobre
Topcon Tools e diversos arquivos como caixa de aparéncia
para rapida troca das medicGes usuais.

Barra de Menus Barra de Ferramentas

c Par - Topcon Tools

ieve  Select Process PReport  Window  Help

A B - AR - - A =N A= N -

Ready \ | Meters | DMS | Cratum Lat, Lon, EILH | WiGSEE y

Barra de Status

Figure 1-19. Tela Principal

Uma vez iniciado, a tela principal mostra:

* Obras disponiveis, incluindo o nome da obra, destino, data
de criagdo e a data do Ultimo acesso.

 Botdes para definir nova obra, para abrir uma obra, para
procurar a obra e para fechar a tela principal.

1-14
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Barra de Menu

A barra de menu, formado por oito opcBes que por sua vez
abre a lista de selecdes e fornece acesso a maioria das fungdes
usadas no Topcon Tools.

$#l ob Edit Wiew Select Process  Report  Window  Help
Figure 1-20. Barra de Menu

Menu Obra
No menu Obra é possivel:

* Criar, abrir, salvar e fechar obras;

 Imprimir informacg6es da obra que esta ativa;

Modificar as configuragdes da obra que esté ativa;
 Importar e exportar dados;

* Mostrar arquivos recentemente acessados.

Mew Job
Cpen Job
Save Job

Close Job

Irnpart... F3
Import from Device,., Shift+F3
Expart... F4

Print... Chrl+P
Prink Preview
Ptink Setup...

Job configuration Ctrl+Fz
Job info

1 TPSjobsite.ttp
2 RatcliffRd.ttp
3 TPSjobsite. tp

Exit

1-15
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Figure 1-21. Menu Obra

Menu Edicdo
 Refazer e desfazer a ultima operacao;

« Cortar, copiar, colar ou apagar informacdes;

» Modo panoramico na vista Mapa para aumentar e
arrastar;

* Proibir ou permitir o uso de pontos marcados,
ocupacao ou observacao nos futuros calculos;

 Mostrar propriedades dos pontos marcados, da
ocupacao ou da medicéo:

Undo Localization  Ctr4+Z

Uk Chrl+i

Copy Chrl+C

Paste Crrl+
Delete Deel

Zoom 3
Pan mode

Disable Chrl+D
Properties Crr+Enter

Figure 1-22. Menu Edigao

Menu Visualizacao
 Visualizar ou ocultar a barra de Estado e outras vistas;
» Mostrar a visualizacdo dos Filtros;

* Organizar, visualizar ou ocultar dados tanto na vista
Tabular ou na vista Mapa ou ainda na vista Ocupacéo
(Occupation View);

* Abrir a tabela com os codigos da obra ativa.
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* Personalizar a barra de ferramentas segundo as
preferéncias do usuério.

« Definir a visualizacdo das opcdes Map e Occupation

v Status Bar
Filters...

v Tabular view Chrl+T
w Map Yiew Chrl+m
Occupation Yiew
Codes

Custonize. ..

Map Yiew Cptions
Dccupation Yiew Cplions

Figure 1-23. Menu Visualizagéo

Menu Selecé&o

O menu Selecéo seleciona os pontos e as ocupacdes
segundo o critério definido por usuario.

Select Al Chrl+a

Select None Shift4+Crl4+M
Invert Selection Shift+Ctrl+1
Select Points... Shift+Ctrl+P

Seleck TS Occupations..,  Shift+C+T
Select GPS Cccupations...  Shift+CH+G
Select T3 Obs... Shift+Ctrl4+M
Select GPS Obs... Shift+Ctrl+C

Figure 1-24. Menu Selegéo

Menu Processamento

 Processamento das observacGes GPS;

» Ajustamento das observagoes;

Caélculo dos parametros de Localiza¢do;

Processa fechamento de circuitos;

« Define as propriedades de processamento.

1-17
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Process

3P3+ PostProcessing F7
Adjustment Fa
Localization Shift+Fa
Loop Closures

Process Properties

Figure 1-25. Menu Processamento

Menu Relatério

» Mostra o relatério de dados em janelas separadas,
incluindo os resultados de ajustamento, os detalhes dos
pontos e observacdes e 0s resultados do teste de
controle de qualidade.

* Personaliza os relatérios existentes e cria padrao de

relatorio definido por usuario.

Adjustment

GPS Observations

Paints

GQuality Contral

TS5 Observations

Report Configuration F9

Figure 1-26. Menu Relatério

Menu Janela
 Organiza as janelas abertas em cascata ou quadros;

« Organiza icones;

» Mostra a vista atual.

Window

Cascade

Tile

Arrange Icons
1 Map Wiew

v 2 Occupation Yiew

Figure 1-27. Menu Janela
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Menu Ajuda

 Adiciona ponto de interrogacéo ao cursor para obter
ajuda de certos itens;

» Mostra a caixa de dialogo da ajuda online;

« Mostra a versdo/data do Topcon Tools.

Context Help
Help Topics

About Topcon Toals, .

Figure 1-28. Menu Ajuda

Barra de Ferramentas

A barra de ferramentas do Topcon Tools contém os botfes para
as funcdes freqlientemente usadas.

gEE %S5 &l SEBB| AR’ H EHE S S B kR

Figure 1-29. Barra de Ferramentas

Uma vez iniciado, a Barra de Ferramentas aparece sob a Barra
de Menu.

 Para mostrar ou ocultar a barra de ferramentas, clique
View » Customize e selecione os ferramentas desejadas. A
marca indica a ferramenta visivel.

» Para mover a barra, posicione o cursor do mouse sobre a
barra de ferramentas, (atras dos botdes) arraste-a para a
nova posicéo e solte o botdo do mouse.

A tabela 1-1 e descreve os botbes disponiveis na barra de
ferramentas.
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Table 1-1. Fung6es da Barra de Ferramentas

Botao

Descrigcao

Nova Obra — Criar nova obra.

1. Pressione o botdo para mostrar a caixa Create a new job.

2. Digite 0 nome da obra e selecione a pasta destino, ou a rede ou
midia de gravacéo.

3. Digite 0 nome do usuario no campo Created by e comentarios na
caixa Comments box, caso seja necessario.

Abrir Obra — Abre uma obra existente.

1. Pressione o bot&o para mostrar a caixa Open.

2. Selecione 0 nome da obra existente e/ou selecione a pasta origem,
rede, ou a midia de gravagdo.

3. Pressione Open.

Salvar — Salva uma obra no destino definido durante a cria¢do da
obra.

Importar Arquivos — Importa arquivos de observagdes para a obra do

HD, da rede local, ou da midia de gravagao.

1. Pressione o bot&o para mostrar a caixa Import from files.

2. Selecione a pasta origem, o tipo de formato e marque 0s nomes
dos arquivos de observacgdo. Depois pressione Open.

Importar arquivos do instrumento — Importa os arquivos de
observacdo dos receptores TPS GPS+, Controladores e Estacfes
Totais.

1. Pressione o bot&o para mostrar a caixa Import file from device.
2. Selecione o instrumento e pressione Next. Veja “Importar do
Instrumento” na pag 3-7 para maiores detalhes..

Exportar Arquivo — Exporta dados do arquivo de obras para HD,
rede local ou midia de gravacéo.

1. Pressione o botdo para mostrar a caixa Export to file.

2. Selecione a pasta destino, digite 0 nome do arquivo e pressione
Save.

&l

Imprimir — Imprime a janela ou a tabela ativa.
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Undo — Desfaz a Gltima acéo.

15

Redo — Refaz a tltima agdo.

2

Corta — Remove a area, 0s pontos, os vetores, as observacdes ou 0s
textos da pagina atual e coloca-os na prancheta do Windows®.

=

Copia — Copia a area, 0s pontos, os vetores, as observagdes ou 0s
textos da pagina atual e coloca-os na prancheta do Windows®.

i3

Colar - Coloca a area, 0s pontos, o0s vetores, as observagdes ou 0s
textos da prancheta Windows para a posicéo atual do cursor, para a
obra ou para outras copias do Topcon Tools.

[

Zoom In — Zooms + para a janela da vista ativa do mapa ou da
ocupacao.

il

Zoom Out — Zooms — para a janela da vista ativa do mapa ou da
ocupacdo.

K

Zoom bhack — Zooms anterior para vista mapa.

IE

Restabelecer tudo — Restabelecer as mudancas.

.

Pan — Muda o cursor para “mé&o”Changes the cursor to a “hand” para
agarrar e mover o mapa..

<]

Filtros — Aplica os filtros definidos por usuério para observacoes e
pontos.

1. Pressione o botdo para mostrar a caixa Filters.

2. Selecione o filtro e pressione Apply.

111
T

Vista Tabular — Abre e fecha a planilha/tabela de dados da obra.

i
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Fm
(gt |
oW

Vista Mapa — Abre e fecha a vista gréfica dos dados da rede de
pontos.

[iE]

Vista Ocupagdo — Mostra graficamente os dados de ocupacdo da
obra.

|

Cadigos — Abre a tabela com os cddigos da obra.

&

P6s-Processamento GPS+ — Us os dados do sistema GPS+ para
processar todas as observagfes GPS da obra.

&
RE

Ajustamento — Ajustamento de rede.

(0=

Configuracdo do Relatério — Abre a janela de configuracdo do
relatorio.

Ajuda Contextual — Mostra a caixa com as informacdes sobre a
vista selecionada, botdes, informacdes, etc.

1. Pressione o botdo. A flecha do mouse passa a ser o Ponto de
Interrogacao.

2. “Clique” no objeto que deseja obter informac@es adicionais.
Aparecerd a janela de ajuda com as informacdes adicionais.

3. “Clique” fora da janela de ajuda para sair.

Veja “Personalizar Barra de Ferramentas” na pagina 4-32 para
criar a sua propria barra de ferramentas.

Barra de Estado

A barra de estado mostra varias mensagens informativas
referentes os dados e as atividades realizadas no Topcon Tools.

Com duplo “click” as caixas mostram a lista de opcGes para
proporcionar um acesso rapido as op¢des de mudanca de
configuracéo de trabalho comumente utilizadas, como:

 Unidades lineares e angulares

» Coordenadas e sistemas de projecéo
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No extremo direito da barra de status, aparece se o filtro esta
sendo usado no obra.
Dratum Lat, Lon, EILE =

Meter »

(Daturn Lat, Lon, Ell.H

'WES54 Lat, Lon, ELH
Datum Lat, Lon, Elevation

\

IReady Meters | Mis | Datumlat, Lon, ELH | wasa4 | 3= I

Figure 1-30. Barra de Estado e Lista de Op¢des

Sobre Topcon Tools

A janela About Topcon Tools mostra as informagdes de
versdo, direitos autorais, data de fabricacdo e os mddulos
comprados.

Para visualizar estas informacdes, clique Help » About
Topcon Tools.

&4 About Topcon Tools

# Topcon Taols Wer.
R

Copyright € 2003-2004

Topeon Positioning Systems, Inc

All rights reserved

Build date is: Thursday, June 10, 2004
Modules included: PP.RTE.TS.GIS

Figure 1-31. Sobre Topcon Tools
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Notas:
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Trabalhando com Obra

O arquivo de obras do Topcon Tools™ contém os dados
importados para fins de processamento, bem como as
configuragdes para a visualizagdo de dados e o seu
processamento. Somente uma obra pode ser aberta. Quando se
abre a segunda obra, a primeira sera salva automaticamente e
fechada.

Usando a Caixa de Dialogo de Inicio

Quando o Topcon Tools € aberto, a janela Startup
automaticamente mostra o local onde sera criada uma nova obra
ou o local da obra existente.

A tabela mostra a lista das obras recentemente abertas. Clique na
coluna de titulos para classificar as obras na ordem crescente ou
decrescente.

» Por nome de Obra (Job name)

« Por pasta de trabalho (Job location)
* Pela data da sua criacdo (Created)

« Pelo ultimo acesso (Last accessed)

Os botbes servem para criar obras, procurer obras ou fechar a
caixa de didlogo Startup.

4 Startup @g|

Job name | Job location | Created | Last accessed |
ﬁ RatcliffRd CHProgr... 142, 13:41:45 28 Apr 2004

ﬁ TPSjobsite CiDocu... 134, 13 Apr 2004
15:5... 5 Apr 2004 Open job I
Browse...
Close

Figure 2-1. Caixa de Dialogo de Inicio

Mew job

‘Westland CiProgr...

2-1
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Criar Nova Obra

Criando uma nova obra abrird um arquivo de obra vazia no
Topcon Tools, bem como salvara automaticamente o novo
arquivo dentro da Gltima pasta acessada.

1. Para criar uma nova obra, escolha um dos seguintes
procedimentos:

« cligue New job na janela Startup
* selecione Job » New Job

« cligue no botdo New da barra de ferramentas

:llf"- i~ Startup
Job name | Job location | Created | Last accessed |

ﬁ RatcliffRd CoProgr... 142, 13:41:45 28 Apr 2004
[41psiobsite | CriDocu... | 13:4 13 S Apr 2004

Open job

Open Job tg

Close Job

Mew job

[ omee ||
[ e |
[ = |

Browse...

‘ Cloze

Figure 2-2. Modo de Criar Obra

2. Entre com as seguintes informag6es na janela Create a new
job

* Informacéo de Job name, Created by, and Comment.

* Cligue no botéo browse (“...”) para selecionar a pasta na
qual sera salva a obra.

 Escolha uma configuracgdo da lista de Configurations ou
clique em Edit configuration para mostrar a caixa Job
configuration (veja “Configuracéo de Obra” na pag 2-7
para detalhes de como editar uma configuracéo).

2-2
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= Create a new job

Job name [\wiestland

Job location |E:\Program FilezTopconsTopconT ools 1.20
Created by [ ok . Public

D ate created | 442542004 3:54:28 PM

far demaonstration
Comment

Configurations: | GPS+ j Edit configuration

Figure 2-3. Criar uma nova Obra

3. Clique OK para criar uma nova obra. A nova obra seré salva
no computador e serd aberta no Topcon Tools.

Abrir uma Obra

E possivel abrir uma obra a partir de duplo clique nos arquivos
*.tpp ou “arrastando” e “soltando” o arquivo *.ttp na tela do
Topcon Tools.

1. Para abrir uma obra use as técnicas acima descritas ou
escolha uma das seguintes opgdes. (Modo de Abrir Obra):

 Duplo Clique sobre a obra desejada a partir da lista
constante da janela Startup

* Cligue na obra desejada constante da janela Startup e
clique Open Job

* Cligue Browse na janela Startup, procure a pasta e
seleciona a obra desejada

* Selecione Job » Open Job

2-3
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* Clique no botdo Open da barra de ferramentas

Job name | Job location | Created | Last accessed |

CiProgr...

13:41:45 25 Apr 2004

Close Job

Iz_"" | Startup
& pateliffrd
|4 1Psiobsite
Mew Job

Save Job tg

2. Na caixa Open, procure a pasta desejada, marque a obra

desejad

I | Cloze

Figure 2-4. Modo de Abrir Obra

a e clique Open (Janela Open Job). A obra

selecionada seré aberta no Topcon Tools.

2-4

Lok in: |l’f}Jobs j |‘j( Ed-

File name: |W’est|and.ttp
Files of type: |Topcon Tools Jobs [*.tp] j Cancel

Figure 2-5. Janela Abrir Obra
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Salvar uma Obra
Métodos para salvar uma obra:
 Pressione Job » Save Job

* Pressione o botdo Save da barra de ferramentas

o

Mew Job

Cpen Job

Close Job !

Figure 2-6. Modos de salvar uma obra

Ao abrir outra obra , Topcon Tools pede para salvar a obra atual.

Fechar uma Obra
Para fechar uma obra, pressione Job » Close Job.

Mew Job
Open Job
Save Job

Figure 2-7. Fechar Obra

Caso a obra seja modificada sem que esteja salva, a caixa de
dialogo pede que a obra seja salva. Pressione Yes para salvar a
obra na mesma pasta na qual a obra foi aberta.

Pressione Job » EXxit para abandoner o Topcon Tools ap6s salvar
e fechar a obra.
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Excluir uma Obra

Uma obra Topcon Tools é consiste de trés arquivos contendo a
Obra, Opgdes e informagdes de configuracdo. Todos os trés
arquivos devem ser apagados para a excluir a obra.

1. Paraexcluir a obra, abra um programa de gerenciamento de
arquivos, como Windows® Explorer.

2. Navegue até a pasta onde se localiza a obra e apague 0s

seguintes arquivos:

* <Nome da Obra>

ttp

» < Nome da Obra >.job_options.jff

e < Nome da Obra >.settings.jff

BN Configurations

File Edit ‘“iew Favoites Toolz Help ‘ﬁ

=[0l x|

D Download
(1 FCio

== 2 | & | @ i 3 S @
Back Formward Up Search | Folders  Histow | Move To CopyTo  Delete Undao Wiems
Address ID Configurations j @ED
Folders X || Mame | Size [ Tupe [ Modified
=1 Topeon ;I 1 Backup File: Folder 442242003 3¢
B0 TopoonTonks G5+ trofa ZKE  TTCFG File 325200354
1 Backup . 3KE  JFF File 442242003 34
=423 Configuiations 2KE JFF File 4/22/2003 34
i) Backup 561 KB Topcon Tools.. 4/22/20039:
] D Data
{2 Conwerted

(1 Formats
-3 HPe2on0
-0 HPCPraz 11
(1 PacketPC
D Reports -
4« G il [ e
|3 obigct(s] selected ‘584 KB |@. Py Computer 4

Figure 2-8. Selecionar Arquivos de Obra a serem Excluidos
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Configuracéo de Obra

A caixa de dialogo Job configuration define as configuracdes de
Topcon Tools para a visualizagdo e processamento de dados.

Para acessar estas configurages, pressione Job » Job
configuration (ou Edit configuration na caixa de didlogo
Create a new job). A caixa de didlogo Job configuration mostra
0S seguintes:

2 Job configuration E]g‘
Precisions \ Points | Angles | Strings | GPsobs | Tsobs |
Coardinate Systems Digits after decimal
Units q -
o Distances B =
Quality Contral Coordinates(M E) E =|
Process Heights g
|Angles (seconds] I
lAngles (Dec.degrees) 5
Lat Lon [sscands] B =
Lot Lon (Dec.degrees)  [4 =
Save configuration| List configurations ‘ oK | Cancel |

Figure 2-9. Configuracéo da Obra

O painel esquerdo da janela mostra os seis itens usados na
configuragdo da obra: Display, Coordinate Systems, Units,
Save, Quality Control, and Process. As seguintes secbes
descrevem os referidos itens.

O painel direito da janela mostra os parametros selecionados
de cada itens.

» T O botéo Save Configuration abre a janela Enter
configuration name na qual se define 0 nome da
configuragéq

%3 Enter configuration name E]@

Configuration name  [RTK

(] 8 h | Cancel ‘

Figure 2-10. Informar o Nome da Configuragéo
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* O botéo List configurations mostra a janela
Configurations list. Utilize esta janela para renomear ou
excluir uma configuragéo

&4 Co nfigurations list

aPS+

RTK Rename

Delete

I

Figure 2-11. Lista de Configuragao

* O botdo Cancel cancela as defini¢des de configuracdo ou
cancela as modificagdes realizadas no painel direito da janela
de Job configuration.

Opcéo Display

O item Display tem seis tabs contidos no painel direito do
Job Configuration:

* O tab Precisions define a visualiza¢do da quantidade de
digitos apds o ponto decimal para as diversas medicdes.

P2 Job configuration EWZ‘
Pracisions | Points | angles | Strings | GPsobs | Tsobs |
Coordinate Systems Digits after decimal
=] units =
— Distances I3 =]|
Quality Contral CoordinatesM E] I3 B
Process Heights [ =
|Angles [seconds] [+ ]|
Angles [Decdegees) |5 =|
Lat,Lon [secands) E] =l
LatLon [Dec.degrees] 4 =
Save configuriation| List configurations Ok Cancel

Figure 2-12. Conf. Obra — Precises
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» Otab Points define o tipo de coordenadas e a ordem de

apresentacao.

2 Job configuration

Coordinate type

Coordinate order

Precisions  Points | Angles | Strings | GRS obs | 75 0bs |

R

|Datum Lat, Lon, ELH

|North|ng,East|ng,He|ght j

Save configuration| List configurations

=

Cancel

Figure 2-13. Config. Obra — Pontos

» O tab Angles define o formato de visualizacao dos
valores angulares.

2 Job configuration |E|E|
[-EREE

Precisions ] Points  Angles 1 Strings 1 GPS Obs ] TS Obs I

Angles

Latlon

Process

[datmmtss. <

L] L]

| ddmm'ss. "

Save configuration| List configurations

=

Cancel

Figure 2-14. Config. Obra - Angulos
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* A aba Strings adiciona as colunas String e
Control Code na tabela de dados (quando tais parametros
estdo disponiveis). Veja “Points Tab” na pag 4-3 para
maiores informaces da vista tabela.

22 Job configuration El
Joicriay ] Precisions | Peints | Angles Strings | crs obs | T3 obs |

oordinate Systems I Display String and Control Code:

| Ok | Cancel

Save configuration| List configurations

Figure 2-15. Config. Obra — Strings

» O tab GPS Obs define a visualizagdo dos vetores GPS e
inclui a coluna offset na tabela de dados, quando o
parametro Show Offsets esta habilitado. Veja “GPS
Observations Tab” na pag. 4-21 para maiores
informacGes de tabular view.

2 Job configuration Elgl
Precisions ] Paints ] Angles I Strings  GPS Obs I TS Obs ]
Coordinate Systems GFS Observations
— & dn, de, du
Save I )
Gty Contrl " paimuth, Elevation Angle, Distance
Process
I~ Show Offsets
Save configuration| List configurations Ok Cancel

Figure 2-16. Config. Obra — Observagtes GPS

» O tab TS Obs define a visualizacdo das observactes
2-10
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realizadas com Estacéo Total e inclui a coluna offset na
tabela de dados, quando o parametro Show Offsets est&
habilitado. Veja “TS Observations Tab” na pag. 4-6 para
maiores informac6es de tabular view.

2 Job configuration El@

Precisions ] Paints ] Angles I Strings 1 GPSObs TS Ohsw
Coordinate Systems Total station observations

Units.
Save
Quality Conkrol

Process

& Horizantal circle, Zenith angle, Slope distance
" Horizontal circle, Horizontal distance, Vertical distance
" Harizantal circle, Vertical angle. Slope distance

I~ Show offsets

Save configuration| List configurations

oK Cancel

Figure 2-17. Config. Obra — Observagdes TS

Definigcdo do Sistema de Coordenadas

O item Coordinate Systems define a projegdo, o datum, os
parametros de transformacédo Projecdo — Topografica (grid to
ground) e o modelo geoidal para a obra.

« A lista Projection mostra as projec@es pré-definidas para
a obra. Veja mais detalhes em Adicionar Projecdo para a
obra.

Para o sistema de coordenadas locais, selecione
Localization da lista de Projection.

* A lista de Datum define o datum (como, WGS84) a ser
usado na visualizacao e ajustamento de dados. Veja
Adicionar Datum para detalhes de como adicionar um
datum na obra.

* Os parametros de Grid->Ground, disponiveis quando
uma projecdo tenha sido selecionada, e mostra a caixa de
didlogo para definir os parametros de transformacéao de

2-11
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Projecdo->Terreno. Veja pagina 2-15 para
aplicar os paramentros grid to ground para a obra.

« A lista Geoid define 0 modelo geoidal para a obra.
Selecione 0 modelo geoidal adequado da lista. Veja
pagina 2-16 para adicionar o geoide a obra.

2 Job configuration E]@
Frojection | Lacalizatian j Custom,
Datum |W5584 j Custom...
Quality Cantrol I
Grid-»Ground
Process 7R
Geoid | j Geoids List...
Save configuration| List configurations Ok Cancel

Figure 2-18. Config. Obra — Sistema de Coordenadas

Adicionar uma Projecao Personalizada
1. Pressione o botdo Projection Custom.

2. Em Custom Projections List:

* Pressione Add para definir uma projecéo
personalizada e continue no proximo passo.

* Pressione Remove para excluir a projecéo
selecionada.

%A Custom Projections List

Marne | R.egion Datumn Mote

< >

Add | Remove | Close

Figure 2-19. Lista de Projecdes Personalizadas

3. Na caixa de didlogo New Custom Projection, entre

2-12
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com as seguintes informacdes e pressione OK:

« Name — nome da projecao

* Projection Type — selecione o tipo de projegéo,
como Transverse-Mercator ou Lambert

 Region — informe a descri¢do para a regido

* Notes — informe as observagdes

» Datum — selecione o datum usado na proje¢édo

A projecéo personalizada seré adicionada a lista de

projecdes.

4. Quando terminada a definicdo ou remogéo de
projecao personalizada, pressione Close em Custom
Projection List. As novas projecdes podem ser
selecionadas da lista de Projection do painel de

Sistema de Coordenadas.

%4 New Custom Projection

General |

PIX

Name

Projection Type

[Perell County

|Transverse—Mel:atol

=]

Mame

| Walue

Central meridian
Scale

Lato

Eastd

HNorthd

<

Region

Mote

Datum

0°00'00.000
1
0°00'00.000
)

o

[weisas

oK % | Cancel

Apply

Figure 2-20. Nova Projec&o Personalizada

Adicionar um Datum

1. Pressione o botdo Datum Custom.
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2-14

2. Em Custom Datums List:

* Pressione Add para definir o datum
personalizado e continue no préximo passo.

* Pressione Remove para excluir o datum
selecionado.

&A Custom Datums List

Mame | mote Ellpsoid Dx

Add Remave ‘ Close

Figure 2-21. Lista de Datum Personalizado

3. Na caixo de dialogo New Custom Datum, entre com
as seguintes informacdes e pressione OK:

* Name — nome do datum

« Ellipsoid — selecione o elips6ide usado para criar
0 datum

* DX, DY, DZ — informe os parametros de
deslocamento do elipsoide

* RX, RY, RZ - informe os parametros do angulo
de rotacédo do elipsoide

* Scale — informe a escala
» Notes — informe as observacdes

O datum personalizado sera adicionado a lista.

4. Quando terminada ou removida a definicdo de datum
personalizado, pressione Close em Custom Datums
List. Os novos datum(s) poderéo ser selecionados da
lista de Datum do painel do Sistema de
Coordenadas.

Topcon

Topcon Tools Manual de Referencia



Capitulo 2

New Custom Datum

General l
Mame  |Ca Ry 15

Ellipzoid |W’GSB4 jHZ [15
DX 3 Scale |2
[ig 3

&3 Custom Datums List

Dz |3 Name [ mote Elipsoid ]
® ca WG4 3.000C
R 15 L
QK h | Cancel < >
| Add | Remave ‘ Close:

Figure 2-22. Novo Datum Personalizado

Definir Parametros Grid to Ground

Na caixa de didlogo Grid->Ground Parameters, informe
a translacdo em Norte e Este, 0 Azimute de Rotacdo e a
Altitude Méadia ou Fator de Escala.

# Grid->Ground @

" Ground Origin (v Parameters

Scale Factor

Avg Job Height

AvgJob Height |D

Scale Factor 1

Mapping Scale |‘I

Morthing Offsst |0
Easting Offzst |0
Agzimuth Frotation | 0°0000.0000

(] 8 Cancel ‘

Figure 2-23. Parametros Grid->Ground

Ou digite Norte, Este, Azimute e Diorecdo para 0s
pontos. Para estes parametros, a obra deve conter pontos.
Neste modo, os pardmetros Grid-> Ground parameters
serdo automaticamente calculados em fungédo dos dados
informados pelo usuario.
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%A Geoids List

# Grid->Ground

" Parameters

I =

Origin Point

Maorthing [m) |D

Easting [m) |D

Azimuth | 0°00t00. 0000

In direction of | j

]

Figure 2-24. Parametros Grid->Ground — Origem Terreno

Cancel

Adicionar um Geodide

Caso a lista de geoide esteja vazia

1. Pressione 0 botdo Geoids List para importar um
modelo geoidal ao Topcon Tools. Aparecera a caixa
de didlogo Geoids List . Clique Add para abrir um
geoide.

Fx
j Custom..
=l cosom

22 Job configuration

isplay | Mone
aordinate Systems

ks

Projection

Datum [wisas

Tuame

MinimUm Latitude | Minimum Langt...

I

El

| Geoids List.

T add |
Remove

Close

*

Cancel

Figure 2-25. Adicionar Lista de Geoides
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2. Na caixa de dialogo Open, naveguq até a pasta
desejada e clique Open para adicionar o0 novo
modelo geoidal a lista de gedides do Topcon Tools.

|~ Open El@l

Look i [EaopconTools 1.20 | «|E]eH

S)Data

f
settings.jff

[ED)

File rame: [aeoids it

Format name: (£ Geaid Fie (g"bin geo;"ff i gle, 02003 bin;s”.dat % ram = |

Open h Cancel ‘

Figure 2-26. Abrir e Adicionar Lista de Geoides

3. Pressione o botéo direito do mouse em Geoids List
para mostrar a janela menu e entdo clique em
Properties para mostrar a caixa Properties.

kA Geoids List

Minimum Latituds | Minimum Longtt...
S0P0000.0005  180°0000, 000%W

Mame | path

9! geoids cut ey

[

Copy QrhC 3 Properties : Global Geoid model geoids
Delete Del =
[General |
[ Poperties | Name [ooe
Path |C\Program Files\TopconiTopconT ook 1.20%

Minimum Latitude  [90°0000, 0005
Minimum Longitude [130°00'00.000w/
aimum Latitude  [90°00'00 000N
Maximum Longituds [180°00'00.0008

aK [k Cancel ‘ Apply
< > I

Figure 2-27. Lista Geoides e Propriedades

Os itens Name e Path nas caixas de didlogo Geoids
List e Properties mostram o nome da lista de geoide
e 0 caminho da rede local ou do computador.
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4. Para remover um modelo geoidal da lista de
Topcon Tools, selecione o respectivo arquivo
arquivo da caixa de didlogo Geoids list e pressione
Remove.

Unidades

O item Units, define as unidades lineares e angulares das
medicOes da obra.

b config
Display Linear Unit et
Coordinate Systems "
Angular Unit D!
Save

Quality Control
Process [Meters

|Feet

I3

13

Ml |

LISFeet

oK Cancel

Figure 2-28. Config. Obra — Unidades

Savs configuration| List configurations:

Opcbes Salvar para Configuracdes

O item Save define a pasta de arquivos backup files, como
fazer arquivos back up importados de instrumentos e o
intervalo de back up para salvar automaticamente.

12 Job configuration 7=
= Fokdes Fox Backup [*Bacduph
5 Cerdnite Sysens Bockup fles bom drvices [ Ovearide rssting =
= Backup Intesval min] (i =
=] Quslty Control
E2] Process

Sawn nmﬂql.\liﬂn| |i«m.um| | o I Careel

Figure 2-29. Config. Obra — Savar
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Definicdo do Controle de Qualidade

O item Controle de Qualidade tem dois tabs no painel direito
da caixa de dialogo Job Configuration que ajuda a assegurar
a qualidade da obra :

« O tab Precisions define os pardmetros de precisao para
as observagdes com erros. As Observagoes que estdo
fora dos pardmetros serdo destacadas em vermelho nas
vistas Tabela e Mapa, bem como nos Relatdrios.

2| Job configuration, EJE‘

Gisplay Precisions | automatic Tests |

ConinateSvetens TS Distance Frecision 003

Units

TS VA Precision (sec.] o
TS HA Precision fsec.) [fo—
RATK Horizontal Precision ooz
RTK Verical Precision [oos
PP Static Horizontal Precision ooz
PP Static Vertical Precision foos—
PP Kinematic Harizontal Precision ooz
PP Kinemalic Vertical Precision [oos

| 0K | Cancel

—rguTe = g T T T O T OIS Cr et Tererer

Save configuration| List configurations

» O tab Automatic Tests seleciona os testes de retaguarda
para o procedimeto automatico e continuo, sinalizando as
entidades supeitas em vermelho.

2| Job configuration, EJE‘

| Display Precisions  Automatic Tests |
Coordinate Systems [+ wiam Float solutions

Ll W RTK Precisions

|w PP Static Precisions

¥ PP Kinematic Frecisions

[ Paint Standard Deviations

[V Identical Paints

¥ Misnamed GFS Dooupations

[ Misnamed Autatapo Rovers

| 0K | Cancel

Figure 2-31. Config. Obra — Tab Teste Automatico

Save configuration| List configurations
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Propriedade de Processamento

O item Processamento tem trés tabs no painel direito da
caixa de dialogo Job Configuration (veja “Processamento,
Ajustamento e Localiza¢do” na pagina 6-1):

» O tab Adjustment define o nivel de confiabilidade para o
ajustamento. TO valor padrédo é de 95%.

Bx

3 Job configuration

Adjustment | T5-Computations | GPS+ PostProcess |
Confidence Level

Display
Coordinate Systems

Units
Save
ontrol

L4
+ 95%
" 99%

Cancel |

List configurations

I

Figure 2-32. Config. Obra — Ajustmento

Save configuration

» O tab TS-Computations define o coeficiente de refracéo
a ser aplicado no ajustamento das medicdes de estacbes
totais. O valor padrdo € de 0.14.

P

configuration

Adjustment TS-Cumputatiunsl GPS+ PostProcess |
Refraction Coefficient

Display
Coordinate Systems

Units ol
Save & 014
~ oz

Quality Contral

Cancel

Figure 2-33. JConfig. Obra — Calculo TS

Lo |

Save configuration| List configurations:
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» O tab GPS+ PostProcess define a mascara de elevacéo,
0 sistema de navegacao, a duragdo minima da ocupacao
(Auto or Tempo Fixo) e a fungdo habilita/desabilita do
cinematico continuo kinematic.

3 Job configuration E‘El

Display

Urits
Save
rocess

Save configuration

Coordinate Systems

List configurations:

Adjustment | TS-Computations

GP5+ PostProcess I

Elevalion Mask [i5

System |GPs+

HMinimum duration

[Fived Time

=

HMin. obs. time[sec] |ED

I™ Enable continuous kinematic

[

Cancel

Figure 2-34. Config. Obra — Processamento GPS+

Informacé&o da Obra

O menu Job information mostra as informacdes basicas
referentes & configuracéo e definigdes da obra.

Para acessar estas informagdes, clique Job » Job info. A caixa

de didlogo Properties mostraa obra ativa (Propriedades da

Obra). Informe Created by e Comments caso queira. Cliqgue OK
para salvar as informacoes.

& Properties : Topcon Tools Job C:\P... @

General l

Mame |E:\Program FilezTopcontTopconT ools
Date created |4/28/2004 3:54:28 PM
Created by [John &, Public
far demanstration
Comment

Cancel

0K Ql

Figure 2-35. Propriedades da Obra
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Notas:
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Importacao de Dados

Antes de importar um arquivo de computador ou um
instrumento, abra uma obra no Topcon Tools. Os dados
recentemente importados serdo selecionados em todas as vistas.

Importar de um Arquivo

Topcon Tools importa os seguintes formatos:

* Arquivo de Coordenadass
ASCII/ TSV files (*.txt)
CR-5 Files (*.CR5)
Custom Text Format files (*.*)
FC-5 Points (*.xyz; *.fc5)
GTS-210/310-10 Points (*.xyz;
*.pnt)
GTS-210/310-12 Points (*.xyz;
*.pnt)
GTS-7 Points (*.xyz; *.pnt)
Name,E,N,Z,Code (*.csv)
Name,Lat,Lon,Ht,Code (*.csv)
Name,N,E,Z,Code (*.csv)

NGS,CORS Data File (*.htm;
*.html; *.txt)

« Atributos Topcon (*.tdd)
 Arquivos GIS (*.xml)

» Dados Brutos GPS+

RINEX files (*.270; *.27G;
*77N)

SP3 files (*.sp3)

TPD files (*.tpd)

TPS / JPS files (*.tps; *.jps)
Arq. Localizagdo (*.gc3)
Arg. Brutos TDS (*.rw5; *.raw)
Obras Topcon Tools (*.ttp)
Arg. Topcon XML (*.xml)
Arg. TopSURYV Database (*.tlsv)

Dados Brutos TS
FC-5 Raw (*.raw; *.fc5)
GTS-210/310 Raw (*.raw; *.dat;
*.gts)
GTS-6 Raw (*.raw; *.dat; *.gts;
*.gts6)
GTS-7 Raw (*.raw; *.gts; *.gts7)
GTS-7+ Raw (*.raw; *.gts;
*.gts7)
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Ao importar arquivos, € possivel selecionar multiplos arquivos
de mesmo formato, pressionando a tecla Shift e com as teclas de
flecha Up e Down para marcar 0s arquivos seqilenciais ou
pressionando a tecla Ctrl para marcar 0s arquivos ndo
sequenciais.

Topcon Tools também suporta a técnica de “arrastar e soltar”
para importar dados a uma obra abarta.

1. Abra o Topcon Tools. E possivel importar dados através de
“arrastar e soltar” para obra existente ou uma nova obra.

2. Carregue 0 Windows Explorer e navegue até a pasta onde se
encontram os arquivos desejados.

3. Clique para destacar a pasta ou arquivos a serem importados.

4. Clique e segure os dados selecionados para “arrastar e soltar”
0s arquivos dentro do Topcon Tools (tanto para vistas Mapa
ou Tabela (Importar Dados para Obra Existente Usando
“Arraste e Solte”).

» Quando se utiliza este procedimento com o botéo
esquerdo do mouse, Topcon Tools tenta,
automaticamente detectar o tipo de arquivo e o seu
formato (todos os arquivos selecionados e/ou todos 0s
arquivos da pasta selecionada).

f‘.?' i oy Topga T kg View) A0
1)
* o " e o massanzxBr=s &9

Lt

als

= \Piogsom fiies\Topeont TageonTosts 1. 20u... [ IS

B ®

R7

LV ¥
» Be DR Yo Fpote ok s

i ==
i e el T Qs re—

COUGODE

Figure 3-1. Importar Dados para Obra Existente Usando “Arraste e Solte”
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* Quando se usa este procedimento com o botéo direito do
mouse, a caixa de didlogo da opgdo “Soltar”aparecera na
tela para maior controle na importagéo (igura 3-2).

—Use a lista Format name para selecionar o tipo de
formato.

—Habilite Recurse folders para importar dados de
todas as sub-pastas da pasta selecionada.
:%Drup options @

Formeat name: £

[V Recurse folders
Y'ou are tving to impart 23 files

0k L} Cancel

Figure 3-2. Opcéo Soltar para Importagéo “Arraste e Solte”

Caso nenhum formato esteja especificado (usando “Arraste e
Solte” ou Técnica de Importar Arquivo), Topcon Tools tentara,
independentemente, determinar o formato do arquivo baseado na
extensdo e conteudo do arquivo importado.

Repare que esta funcéo é conveniente mas ndo é 100% segura.
Este método funciona bem para os arquivos de formato binario,
como Dados Brutos GPS, Arquivos TopSURYV e para a maioria
dos arquivos Brutos TS, porém as vezes ocorre entrada incorreta
de arquivos texto, especialmente de arquivos de coordenadas
delimitados com virgula.

Importar Arquivos de Coordenadas

Arquivos de Coordenadas sdo usados para introduzir e
intercambiar pontos com as conhecidas coordenadas e
cédigos.

“Nome,N,E,Z,Cédigo”, “Nome,E,N,Z,Cddigo”,
“Nome,Lat,Lon,Ht,Cddigo” sdo os arquivos de coordenadas
mais simples e mais usados; estes sdo arquivos de texto
delimitados por virgulas. Qualquer editor de texto pode ser
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3-4

usado para criar tais arquivos para introduzir os pontos de
coordenadas conhecidas para o Topcon Tools. Os pontos
também podem ser exportados de TopSURYV, de Topcon
Link, da maioria dos controladores e programas de
topografia e de GIS.

Para o formato “Nome,Lat,Lon,Ht,C6digo”, varios formatos
podem ser usados para digitar a latitude e longitude,
incluindo “[-]dd[d] mm sshhhh[NSEW]” e “[-
]dd[d].mmsshhhh[NSEW]”, onde ‘d’ significa Graus, ‘m’
para Minutos, ‘s’ para Segundos, e ‘h’ para os Décimos de
Segundo; o sinal negativo na frente de uma das letras
N,S,E,W que indicam norte, sul, este, oeste e sdo opcionais.
Este formato usa 2 ou 3 digitos para os Graus, 2 digitos para
0s Minutos e Segundos e um=ma quantidade arbitraria para
os Décimos de Segundo.

* Caso use arquivos de textos delimitados, mas requere
formatos diferentes, utilize ‘Custom Text Format’ para
descrever o formato texto personalizado (veja Importar
e Criar Formato de Arquivos Personalizados).

» Arquivos “ASCII/TSV” séo coordenadas delimitadas por
virgulas que podem ser exportados de TopSURYV. Eles
podem conter informacéo de atributos juntamente com as
coordenadas e c6digos.

* Arquivos “CR-5" sdo arquivos de coordenadas geradas
no software do controlador TDS.

* “Pontos FC-5”, “Pontos GTS 210/310-10”, “Pontos GTS
210/310-12” e “Pontos GTS-7” séo formatos no qual as
Estages Totais Topcon guardam as coordenadas. Estas
coordenadas podem ser usadas para introduzir as
coordenadas de Estagdo Total Topcon.

* “Arquivo de Dados NGS,CORS” séo arquivos de
coordenadas que podem ser obtidos da pagina web NGS
e CORS.

Topcon Topcon Tools Manual de Referencia



Capitulo 3

1. Paraimportar arquivo de coordenadas ao Topcon Tools
com uma obra aberta, clique Job » Import, pressione
F3, ou clique no botéo Import da barra de ferramentas.

2. Na caixa de dialogo Import, selecione o nome do
formato, como Coordinate File, ou clique no sinal + do
arquivo de coordenadas e selecione um tipo de arquivo
(Selecdo do Tipo de Arquivo e Arguivo).

3. Navegue até o local do arquivo e selecione o arquivo
desejado (Figura 3-3). ST A

Coorainate Fie 1%, Ext;™, CF

ASCIL TSV fles (*.tst)

CRS files (*.CRS)

Custom Text Format (*.%)

FC-S Paints [*.xyz;* Fe8)

GT5-210/310-10 Points (*.xy2; . prt)
leuga\ GT5-210/310-12 Points (*.xyz; . prt)
— GT5-7 Paints (*.pnt;*.xyz)
= cumozza.jps Mare,E,,7,Code (*,c5v)
11027h.jps Hame,Lat,Lon,Ht, Cade (*.csv)
11027c.0ps Mame,M,E,Z,Code (*,csv)
MCE-1027.1p5 1G5, CORS Data File {*.htm;*.html;* txt)
MCE-1027hps Feature Fie (*,ted)

GIS Flle (*.xm)
) GPSH Raw Data Fil (*.kpd;¥. 770;.726;*.72M;* 5p3; ¥.tps; *.jps)
a MAGP-102705 Localization Files (*.GC3)
; TOS R Daka File (* 1S3 ™. raw)

@ Topeon Tosls Job (*tt)

Tapcon XML File (*.xml)

TopSURY Database File (,tisv)

TS Raw Data File (*,raw;* fc5;* dat;* gts;* ats; *.atsT)

Fie name: [u_Calat
Fomatname: |1 Coordinate Flle 6% CRE= osv ez [c5 % k2= him b o
¥ #dvanced options

Figure 3-3. Selegao do Tipo de Arquivo e Arquivo
4. Defina a opcdo Advanced desejada (Figura 3-4):

* Defina o tipo de projecédo, datum, parametros de
transformacdo grid->ground e a unidade.

« Habilite Orthometric Height para marcar as altitudes
de todos os pontos do arquivo importado como sendo
ortométricas; caso contrario, os pontos terdo altitudes
elipsoidais.

« Habilite Control para marcar as coordenadas de
todos os pontos do arquivo importado como fixos,
caso contrério, as coordenadas nédo terdo nenhum tipo
de controle.
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@ AVISO

Sem selecéo, as altitudes serdo ortométricas (para
grid/groud) ou elipsoidais (para latitude/longitude) e

pontos importados serdo de controle.

5. Cligue Open para importar o arquivo.

File: hame:

Format name:

Fiojection

Datum

Linear Linit

¥ Cortrol

IPMCE-10273.105
= tPmcE-1027b. jps
[ tPMcE-1027¢ jps
[ tPL-10274.ps
(=) magp-10275.1ps
[E] tt_cal.bxt:

Look in |3 10cal E ﬂ@
=] cuIti0z7a.jps
=] cuntiozzb.jps
= cumt0z7e jps

[t_Caltst

(£ Conrdinate File i~ CRS:w vz oStz s hmshiml
¥ {Byanced options

[ Hone

=l cosom

|wiGsed

[ Grid-»Ground Parameters

=l cusom

[ ]

El

[UsFest

™ Onthometric Height

Open k

Cancel ‘

5|

Figure 3-4. Opgdes Avancadas e Abrir Arquivo

Importar e Criar Formato de Arquivos
Personalizados

Além dos fomatos normalmente utilizados, o Topcon Tools
aceita formato ASCII definidos por usuérios.

1. Paraimportar um arquivo de coordenadas ao Topcon
Tools, com uma obra aberta, clique Job » Import,
pressione F3, ou clique no botdo Import da barra de
ferramentas.

2. Na caixa de dialogo de importacéo, clique no sinal + de
Coordinate File e selecione Custom Text Format (Figura

3-5).
3-6
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3. Navegue até o local do arquivo e selecione o arquivo
desejado (Figura 3-5).

Al s (7.7}
Coordnste Pl (* bt ® CRS;*.chv, ooz * oS ® oo *. %% em;* heml)
HECTE TSN Fless (* 1)
;3 Import
Look i ) Tape 2 st}
|—] & GISZI0MIN0-12 Poirts (*. vz * ok}
[=ler_topo, GTS-T Peinks (* ok
Ftape‘tlsv
Festure Pl (* tdd)
GIS Pl {* ol
¥ @5+ Rawr Dot File (".bod,®.170; % 106 %.17H; " 503" tos: ™. iow)
Locakzation Filkes (*.GCY)
TS Feaww Duatia Filer (*.roeS;* ren)
Topcon Tooks Job (*
Tepcon 1L e (*. o)
TepSURY Diakobarse Fls (* tisv)
¥ TS Rawr Dot Fie ("o " Jc5; " dot; * s " chsd* . ghsT)
File name: PP_topo_Mow20.TXT 4

Format name: Custom Text Format [%.) j

I~ Advanced options

Figure 3-5. Selegéo do Tipo de Arquivo e do Arquivo

4. Defina as opgdes Advanced (Figura 3-6):

* Defina o tipo de projecédo, o datum, os pardmetros de
transformacdo grid->ground e a unidade.

 Habilite Orthometric Height para marcar as altitudes
de todos os pontos do arquivo importado como
ortométricas, caso contrario, os pontos terdo altitudes
elipsoidais.

 Habilite Control para marcar as coordenadas de
todos os pontos do arquivo importado como fixos,
caso contrario, as coordenadas ndo terdo nenhum tipo
de controle.

@ AVISO

Ao menos selecionado, as altitudes seréo
ortométricas (para grid/groud) ou elipsoidais (para
latitude/longitude) e pontos importados serdo de
controle.
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5. Clique Open para definir as propriedades do formato

Look in =1 | «| @k
V&) pe_topo_novzn.ar

B tape.tisy

File name [FP_topa_Mow20.T<T

Fomatneme: |17 Custam Test Fomat ] |
W Bdvanced optiors

Projection ] =i None L] Custom..
Datum [wsas =l cusom.

™ Girick>Giound Parameters

Linear Uit [usFeet -
I Orthometric: Height

¥ Cortrol

Open I% Cancel ‘

Figure 3-6. Op¢des Avancadas e Abrir Arquivo

6. Na caixa de didlogo Custom format properties,
selecione Delimiters e Coordinate system da lista the
(Figura 3-7).

Cods PaintMumt

Note Northing
Essting

2 Height

[ Ignore first line:

Format name [Tps Test

File extension  [**

Ok Cangel

Figure 3-7. Selecéo de Delimitadores e Sistema de Coordenadas
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7. Selecione os elementos da esquerda para incluir no
formato e clique no botdo (>>) para adicionar na coluna
da direita (Figura 3-8). Use o0 bot&o (<<) para remover 0s
elementos do formato.

2 Custom format properties E]@
Ddimiters |E0mma j
Coordinate system |Grid j

Faintt{umt
Morthing

5 h | Mave Up |

<< | Move Down

[ lgnore first line

Format name |

File: extension I:

Figure 3-8. Adicionar os Elemento ao Tipo de Arquivo Personalizado

8. Para ordenar os elementos incluidos, selecione um
elemento da coluna da direita e use os botdes Move
Up/Move Down para reorganizar conforme a
necessidade.

9. Habilite Ignore first line para que Topcon Tools descarte
a primeira linha do arquivo.

10. Nomeie o formato e defina uma extensdo para inncluir
na lista File name (Informar Nome do Formato e
Extensdo do Arquivo).

* Caso ndo seja dado nenhum nome ou extensao,
Topcon Tools assignard um nome e extensao
aleatorios ao formato personalizado para ser usado
até sair do programa.

» Dando um nome ao formato personalizado, tal
3-9
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formato sera salvo e estara na lista de novos formatos
para sua utilizag&o no futuro.

11. Clique OK para importar o arquivo selecionado de
acordo com as propriedades do formato indicado.

2 Custom format properties E]@
Delimiters |E0mma j
Coordinate system |Grid ﬂ
Code PaintMumk
Mote Nnrlhing

>3 | Ezlsgtlﬂtg Mave Up |

<< | ove Down

[ lgrore first line

Faormat name [Tps Test

File extenzion |~

Figure 3-9. Informar Nome do Formato e Extensédo do Arquivo

Importar Dicionério de Dados

Topcon Feature Files (*.tdd) sdo usados para intercambiar as
bibliotecas de codigos entre Topcon Tools e TopSURV.

1. Paraimportar um dicionario de dados ao Topcon Tools,
com uma obra aberta, clique Job » Import, pressione
F3, ou cligue no botdo Import da barra de ferramentas.

2. Na caixa de didlogo Import , selecione o0 nome do
formato Feature File (Figura 3-10).

3. Navegue até a pasta origem e selecione o arquivo
desejado (Figura 3-10).

4. Cligue Open para importar o arquivo.
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= Allfles (%)

4

Look in: _] Arizona_LBJ

ﬂ_@ arizona_LB.kdd
+-27 GPS+ Raw Data File (*.tpd;® 7905, 72G;% 770, % 5p3;* kps;®.jps)

Localization Files {*.GC3)
TOS Raw Data File (* raS;* raw)
Topcon Tools Job (%.ttp)
Tapcon XML File (* xml)
TopSURY Database Files (*,tsy)
# T4 Raw Data File (* raw® Fo5;* dat;*.gts;* gts6, *.gts7)

File name: Aieona LB idd N

Format name: Feature File [ tdd) X ‘

™ dvanced opton

Figure 3-10. Select File Type and File

i@

Importar Arquivos GIS XML

Atualmente para GIS, somente os arquivos LandXML sdo
compativeis para a importacao. Estes arquivos podem ser
usados apra introduzir coordenadas desde softwares
tercerizados de Topografia e de GIS.

1. Paraimportar um arquivo XML ao Topcon Tools, com
uma obra aberta, clique Job » Import, pressione F3, ou
clique no botdo Import da barra de ferramentas.

2. Na caixa de dialogo Import, selecione 0 nome do
formato Topcon XML File ou GIS File (Figura 3-11).

3. Navegue até a pasta origem e selecione 0 arquivo
desejado (Figura 3-11).
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4.

5.

3-12

I e
i = =i Alfiles (%4
Lok in: J&rizona_LBJ ok

£ Coordinate File (* ket CRI;* % ¥ covy . nyzy* foSi oty iy *, el
&7 Festure Flle (¥ kad)

27 Localization Fles (*.GC3)
=7 TOS Raw Data File (¥, rws;* raw)
&7 Topcon Toaks Job (* ttp)
=7 Topoon SML Fle (* sml)
7 TopSURY Database File (* tsv)
# =7 T5Raw Data Fle (* raw* fos;* dat;* gts;*, gts6 ¥, gts7)

File name: XMines.xm\
Farmat name: -+ GIS File (*.aml) | j

[ Advanced opfom

Figure 3-11. Seleg&o do Tipo de Arquivo e do Arquivo

Selecione a opgdo Advanced desejada (Figura 3-12);
defina o tipo de coordenadas, o datum, os parametros de
transformacao grid->ground , e as unidades angular e
linear.

Clique Open para importar 0 arquivo.

Lock in: [ 8vi0ma e -~ H \ 5

| ElecLines.xml

File name: [Elecines.ami

Fomatname: [ GIS Fie ) =
¥ dvanced options

Coordinate twpe [ ~|
Prcjection = None vl Custom
Datum [wBsea El

[ Grid> Ground Parameters

Linear Lnit [UsFest |

[~ Oithometiic Height

Open Cancel ‘

Figure 3-12. Op¢6es Avancadas e Abrir Arquivo
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Importar Dados Brutos GPS+

RINEX ¢é o formato padréo de intercambio de Dados Brutos
GPS. Para cada sessao de observacao (ocupacao) sdo criados
2 ou 3 arquivos. O primeiro, normalmente tem a sua
extensdo que inicia com a letra ‘O’ e guarda as observacdes;
0 segundo, normalmente tem a extensdo comecando com a
letra ‘N’ ou “‘G’, dependendo da capacidade de rastrear
GPS/GLONASS e guardam dados de navegacdo GPS e
GLONASS (6rbitas). Caso as convencgdes padrbes para
nomear os arquivos RINEX forem seguidas e os arquivos de
navegacao estejam presentes na mesma pasta onde estéo
sendo importados os arquivos de observacao, Topcon Tools
ird automaticamente tomar os arquivos de navegacao
apropriados. No entanto, caso esteja usando convengdes
diferentes para estes arquivos RINEX, ou os arquivos de
navegacdo estejam guardados em outra pasta, lembre-se de
importar tais arquivos também. A falta de dados de
navegacao ird inibir a disponibilidade de processar as
observagoes.

« Arquivos SP3 sdo formatos normalmente utilizados para
guardar érbitas precisas e podem ser utilizados para
importar tais 6rbitas para uma obra do Topcon Tools.

 Arquivos TPS/JPS sdo dados brutos gerados pelos
receptores Topcon.

 Arquivos TPD sdo formatos de propriedade da Topcon
para guardar Dados Brutos GPS e podem ser usados para
copia de segurancga ou para intercambiar dados brutos
entre diferentes obras.

1. Para importar um Dado Bruto GPS ao Topcon Tools,
com uma obra aberta, clique Job » Import, pressione
F3, ou clique no botdo Import da barra de ferramentas.

2. Na caixa de dialogo Import , selecione 0 nome do
formato GPS Raw Data File ou clique no sinal + do
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GPS raw data e selecione o tipo de arquivo (Figura 3-

13).

3. Navegue até a pasta origem e selecione o arquivo

desejado (Figura 3-13).

4. Clique Open para importar o0 arquivo.

No exemplo abaixo, varios arquivos foram selecionados para
a importacao.

= Allfiles (5.7
-7 Coordinate File (* kxt;* CRE;* csvi® vz Fosy® pnky ™, 5%, kg * ki)
"7l Feature File (*.tdd)
“F GIS File (*.xml)
El GPS+ Raw Data File (* kp 2G;
2 RINEX files (*,.220;%.77G;% 77M)

(C3ACSMorg
= BL432103a.tps

| BLsaz103a,tps
[Eeszz10mb.tes B
[ eLe31603a.tps
[=|BL231603a.ps ] BL6G2103a.tps
=] BLza1ansh.tps =] BLAGZ103. tps

[}

“7l Localization Files (* GC3)

SP3 Flles (*.sp3)
TPD files {* tpd)
TPS [IPS/ files (*.tps; *.jps)

= BL331703a,tps
[ BL331603b.tps
= BL3321030.tps
= BL431603a.tps

EEEDE)

£

“Fl TDS Raw Data File {*.rwS;™ raw)

[51 75 Raw Data File (*.raw;* F5;* daty*, gbs; *.gtsé*.gtsT)

Topcon Tools Job (*.ktp)
Topcon XML File (*,xml)
TopSURY Database File (¥, tlsw)

File name:

["BEL131803b.tps" "BL132103b.tps" "BL231703a tp{'"’ﬂ'ﬁ%tmg

Fomatrsme: || 6PS+ Raw Data Fie [~tpd - 7707796, 74, sp3 " tps " I

™ Advanced optighe,

Canesl

Figure 3-13. Selegéo do Tipo de Arquivo e do Arquivo

Importar Arquivos de Localizacéo

O formato *.GC3 é de propriedade da Topcon e serve para
intercambiar coordenadas e os parametros para o calculo de
localizagdo entre TopSURYV, Topcon Tools e Topcon
machine control software (Pocket-3D, 3D-Office, etc.).

1. Paraimportar um arquivo de Localizacdo para 0 Topcon
Tools, com a obra aberta, clique Job » Import,
pressione F3, ou clique no botdo Import da barra de

ferramentas.

2. Na caixa de dialogo Import , selecione o0 nome do
formato Localization Files (Figura 3-14).
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3. Navegue até a pasta origem e selecione o0 arquivo
desejado (Figura 3-14).

4. Cligue Open para importar o arquivo.

=27 Al files (*.*)
¥ Coordinate File (* bxk;* CRE;™, cavi™* ey FoSy ¥ pnky® %% bty ®, html)
Feature File {*,tdd)
IS File (*,xml)
+ GPS+ Raw Data File (*.bpd;*.220,%. 272G, * 72N ¥ .5p3; ¥ .tps;*.jps)
Localization Files (*.GC3)
TS Raw Data File (*.rwS;*.raw)
Topcon Tools Job (*,tep)
Topcon XML File {*,xml)
TopsURY Database File (*,tsv)
+ T5 Raw Data File (*.rav;* FcS;*.dat;*. gbs; * .gts6; *.gts7)

(Z)iizona_LBJ

File name: laizona LELoC

Fomiatriame: | [ 5 Lacalizatin Fies 1 5C3] ~| |
I clvanced options

Figure 3-14. Selegéo do Tipo de Arquivo e do Arquivo

Importar Dados Brutos TDS

Dados Brutos TDS (*.rw5) séo arquivos de dados de RTK ou
Estacdo Total coletados por software de controlador TDS.

1. Paraimportar um arquivo de dados brutos TDS para o
Topcon Tools, com uma obra aberta, clique
Job » Import, pressione F3, ou clique no botdo Import
da barra de ferramentas.

2. Na caixa de didlogo Import, selecione o nome do
formato TDS Raw Data File (Figura 3-15).

3. Navegue até a pasta origem e selecione o arquivo
desejado (Figura 3-15).
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3-16

ﬂEoppel

nEs

Er Al files (*%)

! Coordinate File {*.bxk* CRE;* cawy* sopz;® foS;* pnty*, %% him; * . heml)
= Feature File (*.tdd)

£ GIS File (*.xmi)

£ GPS+ Raw Data File {(*.tpd;* 770;% 77G;*. 72N * sp3;* tps; *.jps)

£ Localization Files (*,GC3)

[ERE 105 Raw Data
7 Topcon Tools Job
£+ Topoon $ML File (* xml)

=7 TopSURY Database File [* tsv)

== TS Raw Data File {*.raw;*, fc5y*.dat;* ghs;*. gtse;*.gts7)

ttp)

File name Conne et

Farmat name: | -7 TDS Raw Data File [* nd: rav)

[ Advanced options

Cancel

Figure 3-15. Seleg&o do Tipo de Arquivo e do Arquivo

Defina a opcdo Advanced desejada (Figura 3-16): defina
0 tipo de projecdo, o tipo de datum, e os parametros de
transformacao grid->ground.

Cligque Open para importar o arquivo.

Lock i [3cappe | «|&let
r@ Copper.rws
File name [Copper i
Formatnams: [ TDS aw Dala File [ w5 1aw) -
v fidvanced options
Projection 1 Hone j Custorm.
Distum 1WESE4 Lj Customn.
I Grid-»Ground Parameters %

Cancel

Figure 3-16. Op¢6es Avancadas e Abrir Arquivo
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Importar Obras Topcon Tools

Uma obra Topcon Toolspode ser importada a outra obra. Por
exemplo, concatenar varias obras Topcon Tools em ima s6

obra.

1. Paraimportar uma obra Topcon Tools para 0 Topcon
Tools, com uma obra aberta, clique Job » Import,
pressione F3, ou clique o botdo Import da barra de
ferramentas.

2. Na caixa de dialogo Import, selecione o0 nome do
formato Topcon Tools Job (Figura 3-17).

3. Navegue até a pasta origem e selecione 0 arquivo
desejado (Figura 3-17).

4. Clique Open para importar o0 arquivo.

= Allfiles (* %
Coordinate File (¥ bxt;* CRS;*,csw; * ocya;*, FoS; . poby . % htmy* ikl

¥
) Backuy
QA;; tptt Feature File (*.kdd)
stitp :
H] PrOWNTRS tp GIS File (*.xmi)
] ; ¥ 2F) GRS+ Raw Data Flle (¥.tpd; *,770;% 276 77M; %, spi3; . tps;* jps)

Rosic Par tp

& i e
@ Westand.ttp Localization Files (*.GC3)

TDS Raw Data Fil

Topcon i
TapSURY Database File (*.tsv)
T5 Raw Data File (* raw;* Fc5;*,dat; * gts;* gtsé; * qgts?)

iI=1 =T

File hamne:

Fomat name: | [ Topean Toals Job [ tip]

[~ Advanced options
Open o Cancel |

Figure 3-17. Selegéo do Tipo de Arquivo e do Arquivo
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Importar Arquivos Topcon XML

Arquivos Topcon XML Files sdo arquivos no formato XML
gue podem ser usados para exportar coordenadas e
observag6es do Topcon Tools. Este formato também pode
ser utilizado para intercambiar coordenadas e medicoes de
Estagdes Totais entre diferentes obras.

1. Paraimportar arquivo XML para o Topcon Tools, com
uma obra aberta, clique Job » Import, pressione F3,
cligue no botdo Import da barra de ferramentas.

2. Na caixa de didlogo Import, selecione o nome do
formato Topcon XML File (Figura 3-18).

3. Navegue até a pasta origem e selecione o arquivo (Figura
3-18).

= 27 Allfiles (*.%)
e Coordinate Fila .kt * CRS ™, cavy ™ evzy® Foy®, prty®, # hiem; * ikl
Feature File (*.tdd)
GIS File (*.xml)
+ GPS+ Raw Data File (*.tpd;* 770;%,72G;% 27N, % 5p3;* tpsi™.ips)
Localization Files i*. GC3)
TOS Raw Data File (*.rwS;* raw)
Topcon Toals Job (*.kkp)
Topcan XML File £*,xml)
TopSURY Database File (*.tksy)
| T5 Raw Data File (*.raw;* fc5;* . dat; ¥ grs;* gbst *.gts7)

|;] | Arizang_LBJ

File: name: | et grol N
1

Formiat name: || Topeon <ML Fie [.sm] 1/
™ Advanced options

Figure 3-18. Select File Type and File

4. Selecione a opcdo Advanced (Figura 3-19): defina o tipo
de coordenadas, o tipo de projecdo, datum, os
parametros de transformacéao grid->ground, e as
unidades angular e linear.

5. Clique Open para importar o arquivo.
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Bl 7R

Lock i iizers LB | || |

| pipescek el

Fiba riame [empmvcth. sl

Fosmat namec [ Topoon XML Fies (] T

Cowdnals lype [

Paoiection None i Cuptom., |

D [WES84 Tl Cumem, |

I GridGround Parsmeters |

Lineae Lini [UsFent =]

Angulss Urit [oms =]
[ 0w o] et _|

Figure 3-19. Opgdes Avancgadas e Abrir Arquivo

Importar Obras TopSURV

Arquivo de dados TopSURYV séo arquivos de obras coletados

no TopSURV.

1. Para importar uma obra TopSURYV para o Topcon Tools,
com uma obra aberta, clique Job » Import, pressione
F3, ou clique no botdo Import da barra de ferramentas.

2. Na caixa de dialogo Import, selecione o0 nome do
formato como TopSURV Database File (Figura 3-20).

3. Navegue até o local do arquivo e selecione o arquivo

desejado (Figura

4. Cligue Open para abrir o arquivo.

3-20).
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o122 Al files (*.%)
Look i |_] Afizona_LBJ & Coordinabe File (*,txt;™, CRE;® csv;™.xyz;*. FeS; ™, prky . %5, hkmg® bl
Feature File (*,tdd)
? arizona_LEL.Hsy GIS File (* i)

-2 GRS+ Raw Data Flle (% tpd;™ 770;" 797G, 720, 5p3; ¥ bps; " jps)
Localization Files (*.GC3)
TDS Raw Data File (¥ .rwS; *.raw)
Tapean Toals Job (*.ttp)

5% dat;*, s+, gts6;* ots7)

File name: | arizona_LBJ.thw \
Format narme: | TopSURY Database File [* Hav] _ﬂ
[ Advanced opthemT

Figure 3-20. Sele¢éo do Tipo de Arquivo e do Arquivo

Importar Dados Brutos TS (Estacao Total)

Arquivos Brutos TS sdo arquivos usados para guardar as
medicos na Estacdo Total.

1. Paraimportar um arquivo de Dados Brutos TS para o
Topcon Tools, com uma obra aberta, clique
Job » Import, pressione F3, ou clique no botdo Import
da barra de ferramentas.

2. Na caixa de dialogo Import, selecione 0 nome do
formato como um TS Raw Data File, ou clique no sinal
+ do arquivo TS raw data fé selecione o tipo de arquivo
(Figura 3-21).

3. Navegue até o local do arquivo e selecione o arquivo
desejado (Figura 3-21).
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" Localizakion Flles (*.GC3)

FC-5 Raw (*.r:
GT5-210/310 Raw
GTS-6 Raw (* raw;
GT5-7 Raw (¥ raw;
i i

7 i)
#1- GPS+ Raw Data File (*.tpd; . 770; . 77G; *.77M;*. 503, tps; * jps)

<

File name:
Format name:
[ Advanced

NS

~
|
[ 75 Fiaw Daaa File frane fefi et e gts ot 7). Rl

cptians

Open Cancel J

Figure 3-21. Sele¢éo do Tipo de Arquivo e do Arquivo

4. Defina as opgdes Advanced (Figura 3-22): defina o tipo

de projecdo, os pardmetros de transformacao grid-

>ground e a ordem das coordenadas.

5. Clique Open para abrir o arquivo.

Lok in: |j Copper L] @J ‘ cf
r@l Copper.gts?

File name [Eopper ats?

Format name: | =7 TS Raw Data File (" raw= 5% dat” gts" ats6i". ots7?) j
W idvanead oplions

Projsction ] 7 Mone ;] Custom

™ Grid-»Ground Parameters

Coordinate arder ‘North\ng,Eastmg,H eight ﬂ

Figure 3-22. Opgdes Avancgadas e Abrir Arquivo
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Importar de Instrumento

Topcon Tools importa dados de instrumento ao PC para o pds-
processamento de dados oriundos de receptores, controladores,
estacOes totais convencionais e robdticas e estacdes totais com
Windows CE.

%DICA

Uma vez que os arquivos foram importados
diretamente a obra ativa, faca uma copia de seguranca
do arquivo importado para ter o risco de perder dados.
Veja “Opc¢des Salvar de Configuracdes” na pag 2-18.

Importar do Receptor

1.

3-22

Consulte o manual do Receptor Topcon para saber 0
procedimento necessario para conectar o receptor ao
PC.

 Conecte o receptor ao PC usando os cabos RS232
ou USB e ligue o receptor.

 Caso o receptor e 0 PC tenha o Bluetooth®,
habilitado, conecte-os usando o Bluetooth.

Inicie o Topcon Tools e abra uma obra, entdo clique
Job » Import from Device, pressione Shift+F3, ou
clique no botdo Import from Device da barra de
ferramentas.

Na caixa de dialogo Import from Device, clique no
icone receptor localizado no painel superior (Figura 2-
24).

Para adicionar um instrumento ou modificar as
propriedades do instrumento:

Topcon
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Importar de Instrumento

* Pressione o bot&o direito do mouse na janela
superior ou cliqgue Add New Device, e depois TPS
Receiver.

* Pressione o botdo direito do mouse sobre o
instrumento e clique Properties.

Na caixa de dialogo Properties, entre com as seguintes
informac®es e clique OK (Figura 2-23):

» Name — digite 0 nome Unico para o instrumento

* Port — selecione a porta COM ou porta USB a ser
usado na conexdo. No caso de Auto Selected,
Topcon Tools procura por receptor conectado em
todas as portas disponiveis COM/USB.

 Notes — notas adicionais caso queira

g Properties : TPS Receiver TPS ... @E|

General }
Narme |TPS Receiver

Port |Aum j

Hote ‘

ok m Cancel | |

Figure 3-23. Propriedades do Instrumento

5. Verifique as mensagens de conexdo no painel inferior
da caixa de dialogo Import from Device (Figura 3-24).

(=}
§ & & & ¢

CEBased  Conventional FRobotic Total TPS contraller
TotalStation  Tokal Station  Station

Instruction

Make sure that pour TRPS Receiver is switched on and connected to any COM
or ISE port

‘ Next »> Close |

Figure 3-24. Importar de Receptor

Add New Device
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6. Com o receptor selecionado no painel superior, clique
Next.

Aparecerd uma mensagem de erro se 0 instrumento
estiver desligado ou se a porta COM estiver
selecionada incorretamente.

Selecione OK para continuar. Verifique as conexdes do
instrumento e suas propriedades e clique Next na caixa
de dialogo Import From Device.

7. Na caixa de dialogo device files, selecione o arquivo a
ser importado e clique Next (Figura 3-25). Os arquivos
selecionados serdo importados para a obra.

* 2 Import from Device E]E|

Device
TPS Receiver

| Size | Modified |
(i) 1951696 28.01.2003 12: 36

Refresh | << Back ‘ Mext »> [} | Close |

Figure 3-25. Selegéo de Arquivos do Instrumento para Importar

Clique no botéo Refresh para atualizar a caixa de
didlogo Import from Device caso a conexao seja
substituida no PC por uma outra conexao.

Importar do Controlador ou Estacao Total CE

1. Siga as orientacGes do fabricante para conectar o
controlador ao PC.

2. Inicie o Topcon Tools e abra uma obra. Clique
Job » Import from Device, pressione Shift+F3,

3-24

Topcon Topcon Tools Manual de Referencia
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cligue no botdo Import from Device da barra de
ferramentas.

3. Na caixa de didlogo Import from Device, clique no
icone do controlador localizado no painel superior
(Importar de Controlador).

4. Para adicionar um novo instrumento ou modificar as
suas propriedades:

« Botdo direito do mouse na janela superior ou clique
Add New Device e depois TPS controller ou CE
Based Total Station.

» Botdo direito sobre o instrumento e clique
Properties.

Na caixa de didlogo Properties, entre com as seguintes
informacGes e clique OK (Figura 3-26):

» Name — digite 0 nome Unico para o instrumento
» Notes — Notas adicionais caso queira

* use Microsoft ActiveSync® para definir as
propriedades da porta ou LAN (Rede Local)

F= 3 Properties : CE Based Total Sta... EJ@|

General 1
Name |CE Based TotalStation

& Properties : TPS controller TPS... @@
Mo
o General 1

Mame |TPS controlles

oK m Cancel |

Note ‘

oK h Cancel | |

Figure 3-26. Propriedades do Instrumento

5. Verifique as mensagens de conex&o no painel inferior
da caixa de didlogo Import from Device (Figura 3-27).
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*2 Import from Device

& & & & 1

CEBased  Conwentional Robotic Tokal  TPS Receiver
Tatalstation  Total Station Skation

Instruction

Make sure you have installed ActiveSync and connected to mabile device wia
ActiveSync.

Add Mew Device

| Mext »> Clase I

Figure 3-27. Importar de Controlador

6. Com o controlador desejado ou Estagédo Total CE
selecionado no painel superior, clique Next.

Aparecerd uma mensagem de erro se 0 instrumento
estiver desligado ou se a porta COM estiver
selecionada incorretamente.

Selecione OK para continuar. Verifique as conexdes do
instrumento e suas propriedades e clique Next na caixa
de dialogo Import From Device.

7. Na caixa de dialogo device files, selecione o arquivo a
ser importado e clique Next (Figura 3-28). Os arquivos
selecionados serdo importados para a obra.

* Import from Device

Madfied |
14.03.2004 12:36

Refresh <¢ Back | Nest >> Close:

Figure 3-28. Seleg&o de Arquivos do Instrumento para Importar
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Clique no botéo Refresh para atualizar a caixa de
didlogo Import from Device caso a conexao seja
substituida no PC por uma outra conexao.

Importar de Estacédo Total Convencional ou
Robdtica

Quando importa arquivos de Estacdo Total Convencional
ou Robdtica, a transferéncia de arquivo sera iniciada da
Estacdo Total apos conectar ao PC.

1.

Siga as instrucdes constantes do manual de Estacéo
Total Topcon para conectar o instrumento ao PC.

Inicie Topcon Tools e abra uma obra. Clique
Job » Import from Device, pressione Shift+F3,
clique no botdo Import from Device da barra de
ferramentas.

Na caixa de dialogo Import from Device, clique na
estacdo total convencional localizado no painel
superior(Figura 3-28).

Para adicionar um novo instrumento ou modificar as
suas propriedades:

 Bot&o direito no painel superior ou clique Add
New Device, depois cliqgue Conventional Total
Station ou Robotic Total Station.

« Botdo direito sobre o instrumento e clique
Properties.

Na caixa de dialogo Properties, entre com as seguintes
informacdes e clique OK (Figura 2-29):

» Name — digite 0 nome Unico para o instrumento
» Notes — Notas adicionais, caso queira

* Port — selecione a porta COM a ser utilizado
3-27
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* Model and Software — modelo de estacdo total e 0
tipo de software usado na estagéo total

» Advanced tab — baud rate, paridade, data bits, stop
bits e protocolo usado na comunicagdo com a
estacdo total

B Properties : Conventional Total... Elgl

General 1 Advanced |

Name Carwentional Total Station
Mate &} Properties : Robotic Total Stati... Ewg|
General  Advanced ]

Port COk1 Baud Rate 9600 h

Model GPT-2000 Parity None R

Software Japan Data Bits g -
ok [y Cancel | s ! Bl

Pratacol ACKAMNACK, hd

Cancel | |

Figure 3-29. Propriedades do Instrumento

5. Conecte a estacdo total e o PC de acordo com as
instrugdes do fabricante.

6. Verifique as mensagens de conexdo no painel inferior
da caixa de dialogo Import from Device (Importar de
Estacdo Total Convencional ).

- Import from Device

. ik

- -
CE Based Conventional
TokalStation  Tokal Station

Instruction

For impart frorm Topcon TotalStations GTS-600, GPTEI00, GTS-200, and ~
GPT-8000 series please follow instruction below:

Turn on the Total Station by pressing the POWER button,

Use the four armows keys F2 [Right], F3(left], F4 [down)], and F5 [up] to

navigate the 555 main menu and highlight the =<FER" selection for transfer.

Arrow down and the uzer will zee the menu options 'Send' 'Receive’, 'Print' and
‘Part'.

Highlight ‘Send’ and press the ‘Enter’ key. The left menu choices appear ‘Raw',
‘Paints', 'DHF', 'CUTS', and <-Sect’.

Add New Device ‘ Mext »> | Cloze

Figure 3-30. Importar de Estagcdo Total Convencional

v
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7. Com a Estacdo Total selecionada no painel superior,
clique Next.

Aparecerd uma mensagem de erro se 0 instrumento
estiver desligado ou se a porta COM estiver
selecionada incorretamente.

Selecione OK para continuar. Verifique as conexdes do
instrumento e suas propriedades e clique Next na caixa
de dialogo Import From Device.

8. Siga o manual de instrucdes da Estacdo Total para
selecionar o arquivo armazenado na Estacdo Total e
inicie a transmissdo de dados a partir da Estacdo Total.

@AVlSO

Observe que em alguns protocolos de
comunicacéao ("ONEWAY”) necessita pressionar
Next na caixa de didlogo Import from Device,
antes de iniciar a transmisséo. Para outros
protocolos, siga os passos acima. Em qualquer
caso, siga exatamente as instrucdes de conexao.
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Notas:
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Visualizar, Selecionar e Filtrar Dados

Quando abre uma obra no Topcon Tools, varias formas de
visualizagdo de dados estdo disponiveis. Desde um mapa de
pontos, vetores, malha de ocupacdes a tabele de dados, cada
vista fornece as informacdes necessarias para editar e pds
processar dados de forma eficiente e eficaz. A impressao de
diferentes vistas permite estudar os dados offline.

As vistas no Topcon Tools sdo interativas, isto ¢, um dado
selecionado em uma determinada vista, também é selecionado
em todas as vistas abertas. A selecdo de dados permite o acesso a
outras fungdes, como propriedade ou pardmetro dos dados. Os
dados também podem ser filtrados baseados no tipo, tempo ou
codigos.

A barra de menus (commandos) e a barra de ferramentas
permitem 0 acesso as vistas e fungdes disponiveis no Topcon
Tools, as quais podem ser modificadas para ter acesso
personalizado para visualizar e selecionar dados.

Visualizar Dados

Topcon Tools oferece varias formas de visualizag¢do para editar,
gerenciar e processar dados.

* A vista Tabela contém abas com tabelas de informacdes dos
pontos, ocupacOes, observacdes e medicGes a trena usadas na
obra.

* A vista Mapa mostra a representacdo grafica dos pontos e
vetores usados na obra.

A vista Ocupacdo é uma escala de tempo de ocupacao usada
na obra.

* A vista Cddigos lista todos os codigos e seus atributos
4-1
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usados na obra. Esta vista é também usada para adicionar
codigos a obra.

Os pontos, vetores, ocupagdes e observagdes mostradas em
varias vistas utilizam simbolos e cores para designar as
informacdes. A janela de legendas nas vistas Mapa e OcupacOes
descreve estas designacdes.

Vista Tabela

Por configuragdo padréo, vista Tabela é mostrada na tela
principal. Para ver ou ocultar a vista Tabela, clique

View » Tabular View, pressione Ctrl+T, ou cligue no botdo
Tabular View da barra de ferramentas.

A vista Tabela contém até cinco abas que representam
diferentes tipos de informacéo:

 Pontos — mostra 0 nome do ponto, as coordenadas e
outras informacdes relevantes do ponto.

» Ocupacdes GPS — mostra 0 home do ponto e as
informac6es da antena, bem como o tempo de ocupacao,
métodos, local do arquivo e a identificacdo do receptor.

» ObservacBes TS — mostra 0s nomes dos pontos “de” e
“para”, alturas do instrumento e do prisma, valores
medidos, residuos do ajustamento e outras informacdes
relevantes das medicoes.

» ObservacBes GPS — mostra 0s nomes dos pontos “de”
“para”, tempo de observacdo, componentes da solugdo
dos vetores computados e outras informacdes referentes
as solucBes, como residuo do ajustamento e informacdes
relevantes.

» Tape Dimensions — mostra as informacdes dos pontos de
inicio e fim para o perimetro, nome dos pontos para as
medidos a trena, distancias medidas e a data da medicéo.

4-2
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Aba Pontos

Clique no tab Points par aver as informac6es do ponto.
O tab Points mostra uma tabela contendo as seguintes
informacgdes (Aba Pontos):

Name — mostra 0 nome do ponto.

Point coordinates — dependendo do tipo de
coordenadas selecionadas na configuragéo da obra,
mostra um dos seguintes dados para o ponto:
latitude, longitude, altura elipsoidal; latitude,
longitude, altitude; latitude WGS84, longitude
WGS84, altura elipsoidal WGS84; norte projecao,
este projecdo, altitude, norte terreno, este terreno,
cota terreno.

Note — mostra 0os comentarios do usuario.
Code — mostra o cadigo principal do ponto.

Control — coordenadas fixas para o ajustamento do
ponto (None, Height, Plane, or Both).

Standard Deviations — 0 desvio padrdo para 0s
pontos, nas unidades selecionadas, ap6s o
ajustamento (Std Dev N, Std Dev E, e Std Dev U).

String and Control Code — quando Display String
And Control Code esta habilitado na configuracéo da
obra, mostra as extensdes do cddigo do arquivo de
obra.

o7 Points | o2 eesoctupations | ¢, 150bs | o8 Grsobs | @, Tape Omensions |

Name

@ Bz
@ BL3
@ Bl4
@ BIS
@ Bls
& BL7

Latitude | Longtude | EllHeight (m} | Code [ cantrol Hote StdD A

ST orosewssen 12203319479 15,945 reba Hone

4795433,73IN  122°33'18.542W 22,828 punch Hone
4795HI0EEEN  122°33'15.599W 20,152 pk Hone
47954285300 122°33'19.005W 41,317 rebar Hone
4795427.460N  122°33'31.181W 20882 rebar Hone
4795430948 122°33'22.890W 19.162  rebar Hone
47°5434.543N  122°33'23.707W 34316 bolt Hone G

Figure 4-1. Aba Pontos

Cligue no cabecalho da coluna para classificar as
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informac6es do tab Point em ordem alfabética (nome
dos pontos) ou ascendente ou decrescente (coordenadas
dos pontos).

Para editar as informac0es da tabela Pontos, veja “Editar
na Vista Tabela” na pag 5-1 (os desvios padrdo ndo sao
editaveis).

Aba GPS Occupations

Clique no tab GPS Occupations par ver as informacdes
de ocupagbes GPS (Tab Ocupagdes GPS ).

O tab GPS Occupations mostra uma tabela com as
seguintes informacdes:

« Point Name — mostra o nome do ponto ocupado.

* Original Name — mostra 0 nome original do ponto
ocupado.

» Antenna Type — o tipo de antena usado na ocupacao.
» Antenna Height — a altura da antena.

» Antenna Height Method — 0 método usado para
medir a altura da antena, vertical ou inclinada.

« Start Time — mostra a data de inicio (dia/més/ano) e
hora de inicio da época da ocupacao.

 Stop Time — mostra a data final (dia/més/ano) e hora
de término da época da ocupacao.

 Duration — a duracdo da ocupacéo (Duracdo = hora
inicio — hota término).

» Method — 0 método de medicdo usado na ocupacao;
sendo Estatico, Stop-and-Go, Kinematic, ou RTK
(RTK base, RTK Topo e RTK Autotopo).

» Note — mostra os comentarios do usuario.
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Source — mostra o caminho para os dados guardados
no PC, na rede local ou media de armazenamento.

Receiver — mostra o numero de série do receptor
TPS usado na ocupacao.

Offset Azimuth — quando Show Offsets esta
habilitado na configuracdo da obra, o deslocamento
do azimute define a direcdo desde a ocupacéo e
outros deslocamentos (longitudinal e transversal).

Offset Dist — quando Show Offsets esta habilitado na
configuragdo da obra, mostra o deslocamento da
ocupacéo.

Offset dHt — quando Show Offsets esta habilitado na
configuracdo da obra, mostra o deslocamento
vertical da ocupacdo.

Offset Across — quando Show Offsets esta habilitado
na configuracdo da obra. Mostra o deslocamento
transversal da ocupacéo.

%DICA

Para ver os deslocamentos rapidamente, clique no
botédo direito dentro da tabela e clique nas Options
do menu. Habilite Show Offsets e clique OK.

«° Foirts &7 GPS Occupations | < T506s | of? Gr30bs | @, TapeDimersions |

Paint Mame

| orignalmame | Antenna Type | Antenna Height,.. | Ank Height Met... | Start Time [ stop Time Duration #

@ BL1
®, BL1
&, BL1
@ B2
@ B2
® B2
® B3
<

BL1 Legart 2,000 Vertical 3{16/2003 1:01.., F18/2003 2:47... 1:46:00

BL1 Legark 2,000 Vertical 3{19/2003 1;36.,, 319/2003 L:44.., 0:06:15

BL1 Legart 2,000 Vertical 3j21/2003 8:50..,  F21/20039:00... 0:09:30

BLZ Legart 2,000 Vertical 3{18/2003 1:07... 318/2003 1:18... D:10:15

BLZ Legart 2,000 Vertical 3{19/2003 12:1.,, F19/2003 1:19... 1:02:00

BLZ Legart 2,000 Vertical 3{19/2003 1:21.,,  F19/2003 1:25.. :04:15

EL3 Legart 2,000 Vertical 3{18/2003 1:22,,, 318/2003 1:32... 0:10:00 ~
>

Figure 4-2. Tab Ocupac8es GPS

Clique no cabecalho da coluna para classificar as
informag6es GPS Occupations na ordem alfabética
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(nome do ponto, tipo de antena, ID do receptor) e ordem
crescente ou decrescente (hora, duracéo).

Para editar os dados na aba GPS Occupation
(Inicio/Fim, Duracao, Método, Fonte e Receptor ndo sdo
editaveis)., veja “Editar na Vista Tabela” na pag 5-1.

Aba TS Obs

Clique na aba TS Obs para ver as informacg6es das
medicgdes de Estacdo Total (Figura 4-3).

A aba TS Obs mostra uma tabela com dois painéis. O da
esquerda mostra as ocupacOes de TS e da direita as
observagdes. A aba TS Obs tem as seguintes
informacoes:

# — namero do ponto

Point Name — mostra o nome do ponto.
Instrument Height — a altura do instrumento.
Instrument Type — o tipo de instrumento usado.
Point From — a origem das observacdes

Point To — a direcdo das observagdes.
Reflector height — a altura do prisma.

Azimuth — caso informado, mostra o azimute
observado.

Measured values — dependendo dos pardmetros
selecionados na aba TS Obs durante a configuracdo
da obra, mostra trés dos seguintes valores medidos:
Circulo Horizontal, Angulo Zenital, Angulo Vertical,
Distéancia Inclinada, Distancia Horizontal ou
Distancia Vertical.

Date — mostra a data das observacoes.
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» Note — mostra informacGes adicionais das
observac@es, como comentarios.

» Code — mostra o cadigo principal do ponto.

» Type — mostra o tipo de observacéo (BS, SS, FS, ou
BKB).

» AutoReject — permitir ou ndo permitir a rejeicdo das
observacgdes no ajustamento.

 Adjustment status — indica se as observagdes foram
ou ndo foram ajustadas, auto rejeitadas ou
desabilitadas.

* Azimuth Residual — mostra o valor residual do
azimute do deslocamento.

* Residuals — dependendo dos parametros

selecionados na aba TS Obs durante a configuracdo
da obra, os seguintes valores residuais serdo
mostrados para as observagdes: Residuo do Circulo
Horizontal, Residuo do Angulo Zenital, Residuo do
Angulo Vertical, Residuo da Distancia Inclinada,
Residuo da Distancia Horizontal, ou Residuo da
Distancia Vertical.

«° Foirts | o GrSOccupations € 15 Obs |of? Grsbs | @, TapeDimensions |

| PaintMame___ & | Point From | ot To | Reflector Heigh. . | iszimith | Horizonte

#*
1 o1 1 ) 0°00'00,0000 0°00'0
&z 1 z 1.829 B7°37'2

AOL00000 |

¥ £ ba

Figure 4-3. Aba TS Obs

Cligue no cabecalho da coluna da aba TS Obs para
classificar as informagdes em ordem alfabética (do
ponto, ao ponto, etc.), crescente ou decrescente.

Para editar as informac6es na aba TS Obs (Do Ponto,
todos os valores medidos, Data, Tipo, Estado do
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Ajustamento e os Residuos ndo sdo editaveis), veja
“Editar na Vista Tabela” na pag 5-1.

Aba GPS Obs

Cligue na aba GPS Obs para ver as informac6es de
Observacdes GPS (Figura 4-4).

A aba GPS Obs mostra uma tabela com as seguintes
informacdes de Observagdes GPS (vetores):

Point From — o inicio do vetor.
Point To — o final do vetor.

Start Time — a primeira época de intervalo comum
para o vetor.

Duration — duracdo da observacdo no intervalo de
tempo comum.

Note — mostra informacéo adicional do vetor, como
comentarios, épocas, etc.

Horizontal Precisions, Vertical Precisions — mostra
as precis@es horizontal e vertical da solugdo estimada
do vetor.

GPS observations solution components — mostra 0s
incrementos do vetor na opcao de visualizacao
selecionado na configuracdo da obra; sendo
north/east/up, x/y/z, ou azimuth/elevation/distance.
NOTA: Solucdes das observagdes PP inclui altura da
antena e o centro de fase, enquanto que no RTK néo
séo considerados.

Method — mostra 0 método de observacgdes das
medigdes.

Solution type — mostra o tipo de solucdo usado para
0s vetores, sendo Fixed (todas as ambiguidades fixas
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integralmente) ou Float (todas as ambiguidades
estimadas sdo numeros flutuantes).

« Orbit — caso as observac¢des ainda nao tenha sido
processadas, mostra o tipo de dados orbitais
(Broadcast, Precise, ou None) diponivel para
processar estas informacdes. Se as observagoes ja
estdo processadas, mostra o tipo de dados orbitais
usados no processamento — nao se aplica as
observagbes RTK.

» AutoReject — permite ou ndo permite a rejeicdo das
observacfes no ajustamento.

» Adjustment status — indica se as observacdes foram
ajustadas ou ndo, auto rejeitadas, desabilitadas ou
ndo ajustadas.

* Residuals — mostra os residuos do ajustamento para
0 vetor, dependendo dos pardmetros selecionados no
tab GPS Obs durante a configuracéo da obra, sendo
Res n/Res e/Res u, or Res x/Res y/Res z, ou Res
Az/Res El/Res Dist.

Note que para observacdes PP, a solucéo dos
componentes, as precisdes e tipo de solucdes serdo
mostrados apds o pos-processamento das observacgdes.

o© Points | off GPsOccupations | <, T50bs @ @PS Obs | B, Tape Dimensions |

Point From _| Paint To [ start Time | puration | hats | Horizantal Preci.,. | vertical Precisia.. |

&, BLS LG 3212003 8:09,.. 0:10:30
&, BLS BLT 3212003 7:08,..  0:12:00
&, BLS LG 3212003 7:24...  Di11:15
&, B4 ELS 3212003 6:14,., Di11:1S
@, BL4 LG 3212003 5:49,.,  0:07:45
& BL3 BL4 319/20032:09,..  0:05:00
#, EL3 ELE 319/2003 1:43,..  0:08:15
<

Figure 4-4. Aba GPS Obs

Cligue no cabecalho da coluna para classificar as
informagbes GPS Obs em ordem alfabética (do ponto, ao
ponto, método, tipo de solugdo), ordem crescente ou
decrescente (hora, duragdo).
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Para editar as informacg6es na aba GPS Obs (Do Ponto,
Ao Ponto—exceto para observacdes autotopo RTK,
Hora Inicio, Duragdo, Precisdo, Observacbes GPS,
Método, Tipo de Solucéo, Orbita, Estado de
Ajustamento e Residuos ndo séo editaveis), veja “Editar
na Vista Tabela” na pag 5-1.

Aba Tape Dimensions
A aba Tape Dimensions mostra os dados somente
quando a obra contém medicos a trena.

Clique na aba Tape Dimensions para ver as informacdes
de medicdo a trena (Aba Tape Dimensions).

A aba Tape Dimensions mostra uma tabela com dois
painéis. O da esquerda mostra o ponto inicial e final e o
da direita, todas as medi¢OesA aba Tape Dimensions tem
as seguintes informacoes:

« Start Point — o inicio da medicdo a trena no ponto
conhecido.

» End Point — o final da medicg&o a trena no ponto
conhecido.

* #—numero do ponto.
 Point To — o final do vetor.

* Distance — a distancia medida, onde cada distancia é
ortogonal (90°) em relacdo a distancia anterior.
Distancia negativa é para esquerda e a positiva para
direita.

 Date — mostra a data das medicGes a trena.

» Note — mostra quaisquer comentarios do usuério.
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o© Points | off GPsOccupations | <, T50bs | @2 GPscbs B, Tape Dimensions |

re

Skart Point End Point
£ ET— :

| Point To | Distance () | Dats Hote
1 -10.000 3/30/2004 9:20...

z 20,000 3(30j2004 9:20. .

3 20,000 3/30j2004 9:20...

4 20,000 3/30j2004 9:20. .

a

=R -1 - D

Figure 4-5. Aba Tape Dimensions

Clique no cabegalho da coluna para classificar as
informacdes do Tape Dimensions em ordem alfabética
(nota), ordem descendente/ascendente (ponto inicial,
ponto final, #, ao pponto), ou ordem
crescente/decrescente (distancia, data).

Para editar as informac6es da aba Tape Dimensions
(Data ndo ¢ editavel), veja “Editar na Vista Tabela” na
pag 5-1.

Selecionar Dados Vista Mapa

Para ver ou ocultar a vista Mapa, clique View » Map View,
pressione Ctrl+M, ou clique no botdo Map View da barra
de ferramentas.

A Vista Mapa é uma representacdo grafica dos pontos
(latitude/longitude ou norte/este) e das observacdes (Figura
4-6).

« Trajetdrias Cinematicas (seqiiéncia de RTK autotopo ou

Cinematico PP dos pontos observados em uma sessao)
mostra as linhas com pontos negros para mostrar a
trajetdria do receptor. Tais trajetérias ndo podem ser
editadas.

Linhas em negrito indicam observaces repetidas; linhas
com cores mescladas indicam que as observagoes tém
deferentes estados.

Use 0 menu ou botdo de rolagem do mouse para
aproximar ou afastar (zoom in e zoom out).
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* Pressione a tecla de rolagem para baixo ou selecione o
modo Pan no menu pop-up para “agarrar” e mover
dinamicamente a vista.

Latitude

°54'35,0N —

°54'30,0"N —|

&ELE//———"”

D L L L
122°33'50.0"W 122°3390.0"W 122°33'30.0"W 122°3320.0"W 122°3310.0" Longitude

Figure 4-6. Map View

Para editar a Vista Mapa, clique com o botdo direito sobre o
ponto ou vetor e depois cliqgue em Properties do menu pop-
up. Ver “Editar Propriedade de Dados” na pag 5-25 para
detalhes de como editar na caixa de didlogo Properties.

Vista Ocupacéo

Para visualizar ou ocultar a Vista Ocupacdo, clique
View » Occupation View ou clique no botdo Occupation
View da barra de ferramentas.

A Vista Ocupacédo é uma representacgdo grafica dos pontos e
seus tempos GPS (Figura 4-7).

» Use 0 pop-up menu ou botéo de rolagem do mouse para
aproximar ou afastar.

* Pressione a tecla de rolagem para baixo ou selecione o
modo Pan no menu pop-up para “agarrar” e mover
dinamicamente a vista.
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= Occupation View. El@fgl

Paints

®, 67

®, B

® B3 + &

@, BL1 =]

‘ 3(18/2003 12:00:00 A 3(19/2003 12:00:00 AM  3/20{2003 12:00:00 AN 3(21/2003 12:00:00 AM GPS Time

Figure 4-7. Vista Ocupacéo

Para editar na Vista Ocupacdo, botdo-direito sobre a
ocupacdo e clique Properties no menu pop-up. Veja “Editar
Propriedade de Dados” na pag 5-25 para detalhes de como
editar na caixa de dialogo Properties .

Selecionar Dados Vista CAodigos

Se a Vista Cddigo foi mostrado quando a obra foi fechada,
ele sera mostrada ao abrir a obra. Para visualizar ou ocultar a
vista Cadigos, clique View » Codes ou clique no botdo
Codes List da barra de ferramentas.

A Vista Cdédigos lista todos os codigos e seus atributos
usados na obra (Figura 4-8).

i) Codes : C:\Program Files\Topcon\TopconTools 1.20 1.20\Jobs\Rosic Par.ttp

Default Yalue Requied

& rebar

Figure 4-8. Vista Codigos

Para editar na vista Codigos, veja “Editar Cédigos na Vista
Caodigos” na pag 5-14 para mais detalhes .
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Definir Opc¢bes de Vista

As opcdes de vista tém pardmetros para mostrar os dados em
diferentes formatos, ou para mostrar informagdes adicionais. As
vistas Mapa e Ocupac0es e algumas abas da vista Tabela tém
opcOes de selecdes.

Opcdes Vista Mapa

Opcdes de vista para a Vista Mapa inclui a visualizacdo das
malhas de coordenadas e legenda, bem como etiquetas
selecionaveis para 0s pontos.

1. Clique View » Map View Options ou click-direito na
porcao vazia do mapa e cligue Options no menu pop-up.

2. Naaba Show, marque os itens desejados (Figura 4-9).
Clique Apply para salvar.

 Show grid — mostra as quadriculas

» Show legend — mostra uma janela com a descricéo
dos simbolos usados nas vistas Tabela e Mapa.

%A Map View Options

Show | Labels ]

¥ Show legend

(] 8 | Cancel

Figure 4-9. Opcdes de Vista Mapa
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3. Naaba Labels, marque os itens desejados
(Figura 4-10). Clique Apply para salvar.

* Name — permite mostrar 0 nome do ponto no mapa
selecionado, o cursor e a posicdo da barra de estado

 Code — permite mostrar o codigo do ponto no mapa
selecionado, o cursor e a posi¢do da barra de estado

 Height — permite mostrar a altitude do ponto no
mapa selecionado, o cursor e a posic¢ao da barra de

estado
%A Map View Options EJ@
Show  Labels l
Static points Kinematic points
Show on map Show on map
W Hame I Name
™ Code ™ Code
™ Height ™ Height
Show on cursor Show on cursor
W Mame W Mame
¥ Caode ¥ Caode
™ Height ™ Height
Show on status bar Show on status bar
W Mame W Mame
¥ Caode ¥ Caode
I¥ Height [v¥ Height
(] 8 | Cancel ‘ ‘

Figure 4-10. Opgéo Labels Vista Mapa

4. Clique OK para salvar e fechar a caixa de dilogo.

Opcodes Vista Ocupacgéo

As opcdes da Vista Ocupacdo incluem a visualizacéo da
escala de tempo e a legenda, bem como selecionar a fonte da
ocupacao a ser mostrada.

1. Clique View » Occupation View Options ou clique-
direito na porc¢éo vazia da vista Ocupacao e clique
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Options no menu pop-up.

2. Na aba Show tab, marque os itens desejados (Figura 4-
11). Clique Apply para salvar e faga modificacGes
adicionais.

 Show grid — mostra a quadricula na escala de tempo
GPS na vista Ocupacéo

» Show legend — mostra uma janela com a descricao
dos simbolos usados na vista Ocupacao

&d Occupation View Options @@

Show l Occupation Yiew ]

Cancel ‘ ‘

Figure 4-11. Opc¢des de Vista Ocupacéo

3. Naaba Occupation View, selecione a opcao de vista
desejada (Figura 4-12). Clique Apply para salvar.

» Show occupations by receivers — mostra as
ocupacBes baseadas nos receptores utilizados

» Show occupations by points — mostra as ocupacgdes
baseadas nos pontos registrados

&d Occupation View Options @E|

Show  Occupation Yiew l
Dizplay Mode

Cancel ‘ ‘

Figure 4-12. Opc¢des Vista Ocupagdes

4. Clique OK para salvar e fechar a caixa de dialogo.
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Opcdes de Aba na Vista Tabela

As abas Ocupacdo GPS, Observacfes ET e Observacdes
GPS possuem a caixa de diadlogo Options para varios
parametros e para mostrar informac@es adicionais.

1. Paraver a caixa Options das abas da Vista Tabela:

« Click-direito na aba Ocupacdo GPS e clique Options
no menu pop-up.

* Click-direito no painel direito da aba Obs ET e
clique Options no menu pop-up.

* Click-direito na aba Obs GPS e clique Options no
menu pop-up.

2. Na caixa de dialogo Option, defina os parametros
desejados e clique OK.

* GPS Occupations Options — mostra ou oculta a aba
Offsets na caixa Properties (Figura 4-13).

a4 Options E]@

Display
[~ Ehow Dffsets |

QK | Cancel ‘ Apply ‘

Figure 4-13. Opc¢des de Display GPS Occupations

» TS Observation Options — define os incrementos e
0s residuos na aba TS Obs (Figura 4-14).

Display ]
Total station observations

(¥ Horizontal circle, Zenith angle, Slope distance
" Horizontal circle, Horizontal distance, Yertical distance
" Haorizontal circle, Yertical angle. Slope distance

I Show offsets

il | Caniel

Figure 4-14. Opcéo Display Observagdes TS
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» GPS Observation Options — seleciona o tipo de
observacéo a ser mostrado no tab GPS Obs
(Figura 4-15).

| Options E]@

Display I
GPS Observations

" dX, dY, d&2
" Azimuth, Elevation Angle, Distance

(] 8 | Cancel

Figure 4-15. Opc¢ao Display Observagao GPS

Selecionar Dados

Os dados podem ser selecionados no Topcon Tools, tanto
visualmente usando o mouse do PC, como por pardmetros
selecionados usando 0 menu Selecionar. Selecionar Dados
fornece a forma de ver e de editar informac&o de determinados
pontos ou vetores. Também é possivel selecionar determinados
dados a serem processados ou exportados, ao invés de processar
ou exportar todos os dados. Os dados selecionados em uma vista
terdo efeito em todas as vistas.

A caixa de dialogo Select suporta os simbolos (* e ?) para
selecionar dados que possuem elementos similares. Por exemplo,
para selecionar todos os pontos cujo nome do ponto comega com
TS, digite TS* no campo Name da caixa Select Points. Deixe
todos os outros campos com suas configuracfes padrfes e clique
OK. Todos os pontos que comecam com TS serdo selecionados
em todas as vistas abertas. Também é possivel combinar critérios
para selecionar somente aqueles dados que encontram em todos
0s campos selecionados.
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Selecionar no Mapa e vista Ocupacgéo
Para selecionar dados no Mapa ou na Vista Ocupacéo:

* Clique sobre o ponto, o vetor, ou a ocupacdo desejada.
Para selecionar varios pontos, vetores, ou ocupagoes,
segure a tecla Shift enquanto marca os dados desejados.
Use a tecla Ctrl para selecionar de desmarcar 0s
elementos.

* Clique e abra uma janela ao redor dos pontos, vetores ou
ocupacdes desejadas. Arrastando de direita para
esquerda, seleciona todos os elementos que toca a janela.
Arrastando da esquerda para direita, somente 0s
elementos que estdo completamente dentro da janela
serdo selecionados. Segura a tecla Shift para selecionar
grupos de elementos ndo-adjacentes. Use a tecla Ctrl
para selecionar e desmarcar os elementos.

Veja “Editar Propriedade de Dados” na pag 5-25 para
detalhes de edicdo de dados selecionados.

Selecao nas Vistas Tabela e Cddigos
Para selecionar dados nas vistas Tabela e Codigos:
* Cligue nos dados desejado.

* Para selecionar um intervalo de dados, segure a tecla
Shift enquanto marca os dados desejados. Use a tecla
Ctrl para marcar/desmarcar os elementos ndo adjacentes.

Na vista Tabela e Cddigos, algumas células contém listas,
um campo para digitar uma nova informacéo ou atualizar
informacdo ou caixa de rolagem. Os campos editaveis
diferem com cada aba e painel e nem todas as células podem
ser editadas.

« Para acessar a lista, editar campos e caixa de rolagem,
selecione uma célula e pressione F2 ou click-pause-click
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. Clique fora da célula ou pressione Enter.

« Para fazer as mesmas modificagdes em varias linhas da
mesma coluna, segure a tecla Shift para selecionar as
células adjacentes ou segure a tecla Ctrl para selecionar
as células isoladas. Pressione F2 ou clique uma vez em
uma das células destacadas e faca a modificacéo
desejada. Somente as células destacadas serdo
atualizadas. Clique for a da célula ou pressione Enter.

Pressione Esc para cancelar a modificagéo.

Veja “Editar na Vista Tabela” da pag 5-1 e “Editar Codigos
na Vista Codigos” na pag 5-14 para mais detalhes.
Selecionar Pontos

Para selecionar pontos usando a regra definida por usuério,
cligue Select » Select Points ou pressione Ctrl+Shift+P.

Na caixa Select Points, entre com as seguintes informacdes e
clique OK (Figura 4-16).

» Name / Note / Code — informe um nome/nota/cddigo, ou
parte do nome/ nota/codigo e um asterisco para
selecionar todos os pontos com os elementos indicados.

« Std Dev Horizontal / Std Dev Vertical — selecione Menor
que, Maior que ou N&o Usar. Se estiver usando desvio,
informe em metros.

« Point type — selecione o tipo de ponto da lista de rolagem
para marcar todos os pontos daquele tipo.

« Enable for adjustment — selecione Habilitado,
Desabilitado ou Ndo Usar para selecionar os pontos
baseados neste parametro.

* Clear current selection — Todos os itens atualmente
selecionados serdo desmarcados. Caso ndo esteja
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habilitado, os pontos atualmente selecionados continuam
selecionados.

Clique Set default para aplicar os padrdes mostrados na
Selecionar Po.

;3 Select Points @@

Hame [*

Mote: B

Code [*

Std Dev Harizontal |Dn ot Lse j ] m

Std Dev Vertical |Dn ot Lse ﬂ [0 m
~

Paint type: E&Sﬂ;pm_j

Enabled for adjustment [Do ot use ~|

I™ Clear current selection

oK Cancel | Set default |

Figure 4-16. Selecionar Pontos

Selecionar Ocupagdes ET

Para selecionar ocupagdes ET, usando regra definida por
usuario, clique Select » Select TS Occupations ou pressione
Ctrl+Shift+T.

Na caixa Select TS Occupations, entre com as seguintes
informac0es e clique OK (Figura 4-17).

* Point name — entre com 0 nome ou parte do nome e
asterisco para selecionar todos as ocupagdes ET com o
referido nome.

« Instrument height — selecione Menos que, Maior que,
Igual a ou Nao Usar. Se estiver usando uma altura de
instrumento, entre com a altura em metros.

* Related point — Se habilitado, os pontos para as
ocupacBes ET selecionados por este critério, também
serdo selecionados.

* Related obs — Se habilitado, as observacfes ET
selecionadas por este critério, também serdo

4-21

P/N 7010-0612 www.topconpositioning.com



Capitulo 4

selecionados.

* Clear current selection — Todos os itens atualmente
selecionados serdo desmarcados. Caso ndo esteja
habilitado, os pontos atualmente selecionados continuam
selecionados.

Clique Set default para aplicar os padrdes mostrados na
Figura 4-17.

& select T§ Occupations

Paint name B

Instiument height | Do not use «| |0 m
[ PRelated point
I™ Related obs

I™ Clear cunent selection

Ok Cancel Set default

Figure 4-17. Seleciona Ocupagdes ET

Selecionar Ocupacbes GPS

Para selecionar ocupac6es GPS usando regras definidas por
usuario, clique Select » Select GPS Occupations ou
pressione Ctrl+Shift+G.

Na caixa Select GPS Occupations, entre com as seguintes
informac0es e clique OK (Selecionar Ocupagfes GPS ).

* Point name / Original name / Point code / Source — entre
com um nome/codigo/fonte ou parte do
nome/codigo/fonte e um asterisco para selecionar todas
as ocupagdes GPS com o elemento indicado.

» Method - selecione o tipo de método da lista de rolagem
para marcar todas as ocupagdes GPS que usa 0 método
selecionado.

» Antenna height — selecione Menor que, Maior que, Igual
a ou Nao Usar. Se estiver usando uma altura de antena,
informe em metros.
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* Start time / End time — selecione Menor que, Maior que
ou N&o Usar. Se estiver usando hora de inicio/fim, entre
com a data e a hora de inicio/fim da medicéo de
ocupacao.

« Durations — selecione Menor que, Maior que, Igual a ou
Né&o Usar. No caso de duracdo, informe o nimero de
dias, horas, minutos e segundos do tempo decorrido da
ocupacao.

* Related point — se habilitado, os pontos de ocupacdes
GPS selecionados por este critério, também seréo
selecionados.

« Related obs - se habilitado, as observacgdes das
ocupacBes GPS selecionados por este critério também
serdo selecionados.

 Clear current selection — Todos os itens atualmente
selecionados serdo desmarcados. Caso ndo esteja
habilitado, os pontos atualmente selecionados continuam
selecionados.

Clique Set default para aplicar os padrdes mostrados na
Figura 4-18.

& select GPS Occupations Eg]
Pairtt name B
Original name B
Paint code |
Source [
Method ps 2
Antenna hsight [Donotuse  ~| [0 m
Start fime [Do ot use | 5o -] [113212PM =
End time [Danat use | [Msnnrzo0a =] [113212P0 =
Duration rDmTIJLI.lSIE—L| days h m s
™ Related pont
™ Related obs
I™ Clear cument selection

Cancel | Set default ‘

Figure 4-18. Selecionar Ocupac¢fes GPS
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Selecionar Observacdes ET

Para selecionar observag6es ET, usando regras definidas por
usuario, clique Select » Select TS Obs ou pressione
Shift+Ctrl+M.

Na caixa Select TS Obs, entre com as seguintes informacdes
e clique OK (Selecionar Observagdes ET).

* From point / To point — entre com o0 nome do ponto

4-24

de/para ou parte do nome de/para seguido de asterisco
para selecionar todas as observagdes ET com tais nomes.

Enabled — selecione Habilitado, Desabilitado ou N&do
Usar para selecionar os pontos baseados neste parametro
para 0 ajustamento.

H residual / V residual — selecione Menor que, Maior
gue ou Nao Usar. Se estiver usando residuos, informe em
metros.

Reflector height — selecione Menor que, Maior que ou
N&o Usar. Se estiver usando uma altura de prisma,
informe em metros.

H angle / V angle / Z angle — selecione Menor que,
Maior que ou N&o Usar. Se estiver usando angulo,
informe em graus.

H dist / V dist / Slope dist — selecione Menor que, Maior
gue ou N&o Usar. Se estiver usando distancia, informe
em metros.

Related point — se habilitado, os pontos para as
observac@es ET selecionados por este critério, também
seréo selecionados.

Clear current selection — Todos os itens atualmente
selecionados serdo desmarcados. Caso nao esteja
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habilitado, os pontos atualmente selecionados continuam
selecionados.

Clique Set default para aplicar os padrdes mostrados na
Figura 4-19.

From point B

Ta point \‘

L+

Enabled |Dﬂ ot use

Hz residual D not use: hd B [1]

W residual [Dorotuse =] [0

2 2 2

Reflector height |Dn hot use j o

Hz angle [Dorotuse | [0O0D0.0000
Y angle [Dorotuse | [0O0DT.0000
Z angle [Dorotuse | [0D0D0.0000
Hz dist [Dorotuze =[O m
Y dist [Dorotuze =] [0 m
Slope dist |DU not use j o m

[ Related point
[ Clear ourrent selection

0K Cancel | Set default

Figure 4-19. Selecionar Observacdes ET

Selecionar Observacdes GPS

Para selecionar observacGes GPS usando regras definidas
por usuario, clique Select » Select GPS Obs ou pressione
Shift+Ctrl+O.

Na caixa Select GPS Obs, eentre com as seguintes
informac6es e clique OK (Figura 4-20).

» From point / To point —entre com 0 nome do ponto
de/para ou parte do nome de/para seguido de asterisco
para selecionar todas as observacdes GPS com tais
nomes.

» Type — selecione o tipo de método da lista de rolagem
para marcar todas as observacdes GPS que usa 0 método
selecionado.
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« Start time — selecione Menor que, Maior que ou N&o
Usar. Se estiver usando hora de inicio/fim, entre com a
data e a hora de inicio/fim da medigdo de observacéo.

 Duration — selecione Menor que, Maior que, Igual a ou
N&o Usar. No caso de duracdo, informe o nimero de
dias, horas, minutos e segundos do tempo decorrido da
observacéo.

« Solution type — selecione o tipo solu¢édo da observacéo
da lista de rolagem para marcar as observacges desta
solucdo.

» H precision / V precision — selecione Menor que, Maior
gue ou Nao Usar. Se estiver usando uma precisao,
informe em metros.

 Hresidual / V residual — selecione Menor que, Maior
gue ou Nao Usar. Se estiver usando residual, informe em
metros.

* Length — selecione Menor que, Maior que ou N&o Usar.
Se estiver usando comprimento, informe em metros.

* Enabled — selecione Habilitado, Desabilitado ou Ndo
Usar para selecionar os pontos baseados neste pardmetro
para 0 ajustamento.

 Clear current selection — Todos os itens atualmente
selecionados serdo desmarcados. Caso ndo esteja
habilitado, os pontos atualmente selecionados continuam
selecionados.

Clique Set default para aplicar os padrées mostrados na
Figura 4-20.
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& Select GPS Obs
From point B
To paint [
Type RTK Topo v
Statt time [Do rot use = [5norzona =] [11:37.49PM —
Duration Do not use hd days h m s
Solution type g 3
Hz precision [Da not use =~ m
i precision [Da not use = m
Hz residual [Do not use =l m
 residual |Do not use ~[o m
Length [Da ot use =~ m
Enabled [Da ot use =l
[~ Clear current sslection

oK Cancel ‘ Set defaul |

Figure 4-20. Selecionar Observagdes GPS

Inverter Selecdes

Para selecionar rapidamente as ocupagdes e observacdes
desmarcadas e desmarcar as ocupacdes e observacoes
selecionadas, use a ferramenta Inverter Sele¢6es do Topcon
Tools.

Para inverter selecdo, clique Select » Invert Selection ou
pressione Ctrl+Shift+l.

As ocupac0es e observacdes selecionadas serdo desmarcadas
e vice-versa. (Figura 4-21).

/Q_SBGE
21_4 >s1_41

2 BHDSs0_BOW0———

Figure 4-21. Antes e Depois de Inverter Selecdo

master_8BGG

s2_8HDSs0_80W0
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Filtrar Dados

Filtros oferecem a maneira de mostrar ou ocultar pontos,
ocupacdes e observacdes baseados no tipo, tempo e/ou codigo
usando as sele¢des na caixa Filters (Figura 4-22). Pontos,
ocupacdes e observacdes ocultas serdo excluidas do
processamento, ajustamento, exportacdo e relatdrios.

Filters @@

By Type l By Time ] By Code ]
4 Backsights ~
<» Disabled

5!-' Tape Dimensions

=] EE* Faints

& Control points
¥ COGO points
4 Design paints

+  Unknown points
¢ Manual points
& Stakeout paints
4 Adjusted points
4 Disabled points

Apply ‘ Cloze |

Figure 4-22. Filtros

%DlCA

Quando se usam multiplos filtros (tipo, tempo e/ou
cbdigo) os filtros selecionados serdo combinados
logicamente.

Topcon Tools mostra o estado do filtro na Barra de Estado (veja
“Barra de Estado” na pag 1-22).
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Filtrar por Tipo

1. Para ocultar/mostrar dados baseados no tipo, clique
View » Filters ou clique o botéo Filter na barra de
ferramentas.

2. Naaba By Type, marque as opc¢oes desejadas para filtrar
dados e tipo de dados (Figura 4-23).

* Tipo de dados marcados em vermelho sera oculto e
tipo de dados marcados em verde sera mostrado

* Pontos pertencentes a diferentes tipos de dados
simultaneamente (por exemplo, pontos GPS e ET ou
ponto de controle GPS, etc.) serdo ocultos somente
se todos os tipos de dados nos quais 0s pontos
pertencem sejam ocultos.

By Type l By Time ] By Code ]
|- [#] 3+ GPS PostProcessed Py

o
@, Occupitions
=]

& Potential
& Processed
#, Disabled
= EE* Stop
@ Points
@, Occupations
= 3 Obs

[

Apply ‘ Cloze |

Figure 4-23. Selecionar por Tipo de Filtro

v

3. Clique Apply para salvar a definigdo do filtro. Clique
Close quando terminar de aplicar os filtros desejados.

Filtrar por Tempo

1. Paraocultar dados observados por um determinado
intervalo de tempo, clique View » Filters ou cligue no
botdo Filter da barra de ferramentas.
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2. Naaba By Time, selecione o filtro From e To para
interval 1 e interval 2 para aplicar a obra (Figura 4-24).

NOTA: Somente as ocupacdes e observacdes que estdo
dentro do intervalo serdo ocultas. Um ponto € oculto se é
um ponto observado, assim como todas as observagdes
que estdo dentro do intervalo de tempo selecionado.

By Type By Time l By Code ]
Interval 1-From: | B 172004 | | 328:09PM —
Interval 1-Tar | B/ 172004 | | 328:09PM ——
Interval 2 - From: | g/ 1/2004.=] | 2.28:09PM —
Interval 2-Tar | B/ 172004 | | 328:09PM —

Reset

Figure 4-24. Selecionar por Filtro de Tempo

3. Clique Reset para reajustar o intervalo.

4. Clique Apply para salvar a definicdo do filtro. Clique
Close guando terminar de aplicar os filtros desejados.

Filtrar por Codigo (Caracteristica)

1. Para definir um filtro de cddigo, clique View » Filters
ou cligue no botéo Filter da barra de ferramentas.

2. Naaba By Code, digite 0 nome do cddigo a ser filtrado
(Figura 4-25).

&b pica

Use (* or ?) para aplicar filtros usando qualquer
parte do codigo. Use virgulas para separar varios
cédigos.
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i Filters E]@

By Tvpe ] By Time By Code ]
Codestofiter  [punch

Apply | Close

Figure 4-25. Selecionar por Filtro Cédigo

3. Cligue Apply para salvar as definicdes do filtro. Clique
Close quando terminar de aplicar os filtros desejados.

Ver Propriedades por Dados Selecionados

Cada tipo de dados tem a caixa de didlogo Properties que mostra
as informacGes dos dado selecionado.

Quando se seleciona varios itens do mesmo tipo de dados, todos
0s itens sdo representados em (nica caixa de didlogo. Quando se
seleciona varios itens de diferentes tipos de dados, cada item é
representado em sua propria caixa.

Para ver a caixa de Properties para dados selecionados, simples
ou mdltiplos, na vista Tabela, Mapa os Vista Ocupac¢éo
(Figura 4-16):

« Click-direito sobre ponto, observagdo ou ocupacdo e clique
Properties no menu pop-up

« Selecione ponto, observacdo ou ocupacdo e clique
Edit » Properties
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g.:lit
«” Points 0? GPS Occupations l
Paoint MName | Original Mame |
@ BL1 EL1
Cut P N e —r
= EER
Copy Ctrl+C oy Export...
A Lz
Baste Crrk+y LA EL2 Cuk Chrl4%
Delete el & BL3 Copy Chrl+C
Zoom 3 ® BL3 Delete Del
& BL3 Disable
£
pee a0 | I
Properties. .. NZtrI+Er|tEer = Options.. B

Figure 4-26. Caixa de Didlogo Propriedades

A caixa Properties varia ligeiramente dependendo do nimero de
itens selecionados e do tipo de dado selecionado.

« Para propriedades do ponto, o campo Name e a aba CAD
ndo estardo disponiveis quando se visualiza as propriedades
de pontos multiplos.

« Para propriedades de ocupacdo GPS, o tipo de ocupacao (PP
ou RTK) determina os campos disponiveis.

« Para propriedades de observacdo GPS, o tipo de observagéo
(static or kinematic) determina os campos disponiveis.

 Para a aba Obs ET e aba Tape Dimensions, o painel na qual
o0 dado € selecionado determina as propriedades a serem
mostrados.

Para detalhes sobre a caixa de didlogo Properties , veja “Editar
Propriedades de Dados” na pag 5-25.
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Personalizar Barra de Ferramentas

A barra de ferramentas padrdo contém as fungdes
freqlientemente usadas, no entanto, esta barra pode ser
personalizada para mostrar as funcdes freqiientemente usadas
nas determinadas obras. A barra de ferramentas pode ser
mostrada ou oculta conforme a necessidade.

1. Para personalizar as opgOes da barra de ferramentas, clique
View » Customize. A aba Toolbars da caixa Customize
toolbars mostra todas as barras disponiveis para serem
ativadas ou desativadas e adicionadas ou excluidas. (Figura
2-27).

v Status Bar & Customize toolbars
Filters... Toolbars I Commands 1
[l Standard Hew
v Tabular view Chrl+T

v Map Yiew Chrl4+M Delete

T Fesetdl

Occupation Yiew
Codes

To add a command ta a toolbar, drag the command item from commands list onta a toolhar

" . ! Close
Map View Cptions

Qccupation Yiew Options

Figure 4-27. Personalizar Barra de Ferramentas

2. Cligue New para adicionar uma nova barra de ferramentas
na janela principal. Nomeie a barra de ferramentas e clique
OK (Figura 4-28).

& Customize toolbars

Toolbars l Commands ]

(v Standard

To add a command to a toolbar, drag th

Figure 4-28. Adicionar Nova Barra de Ferramentas

4-33

P/N 7010-0612 www.topconpositioning.com



Capitulo 4

A barra de ferramentas personalizada sera adicionada na aba
Toolbars e aparecera como barra vazia na tela principal
(Figura 4-29).

sic Par - Topcon Tools - [Map View]

b Edt Yew Zelect Process Report Window Help
=]

{Paints
® RTK Base
& RTK Static (Topo) & Autonomor | = =
& RTK Kinematic (AutoTopo) oolbars | Commands |

@ GPS PP Static EEET

& GPS PP Stop [wGIs

@ GPS PP Kinematic Delste
< T5 Occupation
4 T5 Backsight
il

Reset &l

To add & command to a toolhar, drag the command item from commands list onto 5 toolbar

Close ‘

R T : T =TT
122°3350.0"W 122°3340.0"W 122°3330,0"W 122°3320.0"W 122°33'10.0"W Longitude

Figure 4-29. Nova Barra de Ferramentas

3. Clique na aba Commands. O painel esquerdo desta aba
mostra uma lista de menus e o da direita mostra 0s comandos
disponiveis para o menu selecionado (Figura 3-40).

a4 Customize toolbars

Toolbars Commands

| Commands »~
dﬂ Clase Job

EWE.

l%aExport. "

&%Import from Device. ..
3.

) v

To add a command bo a toolbar, drag the command itern from commands list onto a toolbar.

Cloze

Figure 4-30. Comandos da Barra de Ferramentas

4. Paraadicionar um comando, selecione o menu aplicavel e
clique e arraste o comando desejado para a barra de
ferramentas vazia (ou para qualquer barra de ferramentas) da
tela principal e solte o botdo do mouse (Figura 4-31).
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T T T T L B
YIS0 L0 V0w NEET.OW 1T L0.0W Longiude

Figure 4-31. Adicionar Comandos na Barra de ferramentas

5. Quando todos os comandos desejados forem adicionados a
barra de ferramentas, organize os botdes da barra conforme a
necessidade: Clique e arraste o botdo para o local desejado
da barra (Figura 4-32). Ao editar a barra de ferramentas, a
caixa de dialogo Customize toolbars deve estar aberta.

A Rosic Par - Topcon Tools - [Map Visw] [
AF kb B Wew Selet Process Beporl Window Heb =
(%% &

&R ]%j;"jd -@{ﬁ &3

Lattuds Foems]
=S Tookurs  Commands |
iews o || commands [
Select
o ‘?;nbw\ Tepcon Tocks.
Ragon L? contest Hel
ko | ek Tegic
sz 0 -
Tosdd tockar, drag the ot & ook,
Closs
T | ! 1 ! I ]
122TE0.0W 122°340.0°W 1AW 1AW 1AW Longluds

Figure 4-32. Editar Localiza¢&o do Botdo da Barra de Ferramentas

Veja Editar 6 e Dicas de Personaliza¢édo da Barra de
Ferramentas? para maiores detalhes.

6. Ao terminar, clique Close na caixa Customize toolbars para
salvar a barra de ferramentas.
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Editar Barra de Ferramentas

A caixa de dialogo Customize toolbars deve ser aberta
(View » Customize) antes da edi¢éo.

Click-direito no barra de ferramentas para mostrar o0 menu
pop-up para edicdes necessarias (Menu Pop-up e ).

« Delete Button — exclui os botdes selecionados da barra

de ferramentas.

Copy Button Image — copia as imagens dos botGes para
aplicar a outro botdo.

Paste Button Image — cola os botdes copiados em outro
botéo.

Set Default Image — definer imagem original (default)
para os botdes selecionados.

Begin a Group — inserta uma barra de espacgo antes de
definir o grupo dos botdes selecionados. Uma marca
indica o inicio do grupo. Clique no menu de opcdes outra
vez para remover a marca e os botdes agrupados.

Command Properties — mostra a caixa de dialogo
Command Properties para selecionar a pasta e
propriedades do filtro para importar/exportar os botdes
da barra de ferramentas. Veja Dicas de Personalizacéo
da Barra de Ferramentas para mais detalhes.

Button Settings — mostra a caixa de dialogo Button
Settings para informar o nome do botéo Button Name
(para poder visualizar o nome do botdo quando o cursor
para sobre este botdo) e as propriedades do botdo
(descritos abaixo). Veja Dicas de Personalizacao da
Barra de Ferramentas para mais detalhes.

» Show Bitmap — mostra uma imagem para o botéo.

» Show Text — mostra o botdo como texto.
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» Show Bitmap and Text — mostra tanto a imagem como o
texto para o botéo.
&0 3 H[NE AT w3

Copy Button Image
Paste Butkon Image
Set Default Image

Begin a Group

Button Settings

v Show Bitmap
Show Text
Show Bitmap And Text

Figure 4-33. Menu Pop-up e Caixa de Dialogo

Veja “Dicas de Personalizacdo da Barra de Ferramentas”
para mais detalhes.

Dicas de Personalizacdo da Barra de
Ferramentas

As caracteristicas de personalizacdo da barra de ferramentas
no Topcon Tools séo inteiramente interativas. Muitos botdes
de propriedades de visualizacdo podem ser personalizados
para obras, tipo de dados ou preferéncia do usuério.

Propriedades de Comando

A caixa de dialogo Command Properties seleciona a
pasta e as propriedades do filtro para importar/exportar
0s botdes da barra de ferramentas.

Por exemplo, utilize maltiplos botdes de
importacdo/exportacdo para realizar a funcéo
importacao/exportacdo de/para determinadas pastas, ou
sempre conectar a um determinado instrumento.

Isto é especialmente Util para guardar diferentes tipos de
fonte de dados em diferentes pastas, ou saltar o primeiro
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passo quando se importa de instrumento.

Para tanto, arraste e solte dois ou mais botdes de
importacdo/exportacdo na barra de ferramentas. Defina
as propriedades de cada botéo para poder carregar certas
pastas ou tipo de dados usando a caixa de didlogo
Command Propertie. D& um Gnico nome ao botdo da
barra de ferramentas e 0 nome do texto do botdo usando
a caixa de dialogo Button Settings.

1. Click-direito o botdo import/export e clique
Command Properties do menu pop-up
(Figura 4-34).

1 0
& &

e e
Delete Button

C o b b (F

Copy Button Image

Set Default Image

Eegin a Group

Command Properties,
Button Settings k

v Show Bitmap
Show Text
Show Bitrmap And Text

Figure 4-34. Mostra Propriedades de Comando

2. Na caixa de dialogo Command Properties, clique no
botdo browse para selecioanr a pasta padréo de
importagdo/exportacéo. (Figura 4-35).

3. Clique na lista Filter para selecionar o formato
padrdo de importacdo/exportacao (Figura 4-35).

4. Cligue OK para salvar e feche a caixa de diélogo.

%A Command Properties

General l

Falder |C:\Program FileshTopeontTopc

Filter

oK h | Cancel ‘ Apply ‘

Figure 4-35. Aplica Propriedades de Comando
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5. Click-direito the same toolbar button e clique no
menu pop-up do Button Settings. Estabeleca um
Unico nome para o botéo e defina as propriedades da
visualizagéo do texto conforme descrito na
Defini¢do do Bot&o9.

Definicdo do Botéo

A caixa de didlogo Button Settings define o0 nome e as
propriedades da visualizagéo do texto.

1. Click-direito no toolbar button e clique Button
Settings no menu pop-up (Figura 4-36).

=%
=g

Delete Butkon

Copy Butkon Inage

Set Default Image
Begin a Group

Command Properties

v Show Bitmap
Shiow Text
Show Bitmap And Text

Figure 4-36. Mostra Propriedades de Comando Display

2. Na caixa de dialogo Button Settings, digite 0 nome
do botéo (ou use o0 nome padréo) (Figura 4-37).

3. Selecione Button appearance (Figura 4-37):
« Show Bitmap — mostra os botdes como imagem.
» Show Text — mostra 0s textos.

« Show Bitmap and Text — mostra a imagem e 0
texto do botdo.

4. Clique OK para salvar as definigoes e feche a caixa
de dialogo.

4-39

P/N 7010-0612 www.topconpositioning.com



Capitulo 4

%4 Buiton Settings

Buttan name |Export Coord
Button appearance

" Show Bitmap
(* Show Text
" Show Bitmap And Text

oK [} | Cancel

Figure 4-37. Aplica Defini¢cdes do Botao

Figura 4-38 mostra as diferentes aparéncias do botéo.

Figure 4-38. Op¢ao Aparéncia do Botéo

Imprimir Vista Selecionada

Todas as vistas podem ser impressas para a visualizacao offline.

&g pich

Muitas vistas tém a melhor impressédo no formato
paisagem. Use a pocado Job » Print para aplicar
esta configuracdo. Utilize Job » Print Preview para
poder ver o resultado da impresséao.
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Para imprimir Vistas Mapa e Ocupacdo:

Para imprimir vistas Mapa e Ocupacao, clique uma vez
dentro da vista e clique Job » Print.

Para imprimir Vista Codigos:

Para imprimir codigos desde a Vista Codigos, clique dentro
do painel esquerdo e clique Job » Print.

Para imprimir atributos desde a vista Codigos, selecione os
cddigos com os atributos no painel esquerdo e clique sobre
um dos atributos do painel direito. Clique Job » Print. Para
imprimir atributos de multiplos c6digos, pressione Shift
enquanto seleciona os codigos com os atributos. Clique
dentro do painel direito antes de imprimir..

Para imprimir Vista Tabela:

Para imprimir as abas Points, GPS Occupations e GPS Obs,
clique na aba desejada e clique Job » Print.

Para imprimir o painel esquerdo das abas TS Obs ou Tape
Dimension, clique dentro do painel esquerdo da aba desejada
e clique Job » Print.

Para imprimir o painel direito das abas TS Obs ou Tape
Dimension, clique dentro do painel direito da aba desejada e
clique Job » Print. Para imprimir dados de mdltipla selecdo
do painel esquerdo, pressione Shift enquanto seleciona os
pontos e clique dentro do painel direito antes de imprimir.
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Notas:
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Editar Dados

Topcon Tools oferece numerosas formas de editar caracteristicas
para modificar, consolidar e atualizar dados como preparativos
para 0 pos-processamento ou ajustamento.

Editar na Vista Tabela

Muitas células na Vista Tabela podem ser diretamente editadas
usando a caixa de rolagem, lista e entrada de textos.

Para editar informagdes em células individuais, click-pausa-click
uma célula, clique na célula ja destacada ou destaque a célula e
pressione F2 para mostrar o dado a ser selecionado ou editado.

Para entrar com valores iguais em Vvarias linhas, pressione Shift
enquanto seleciona as linhas desejadas. Clique sobre uma das
selecdes e pressione Enter (Figura 5-1). Pressione Esc para
cancelar a edicéo.

» Para caixa de rolagem, clique nas flechas superior/inferior
para procurar a selecdo desejada ou digite a informacé&o.

« Para lista, clique na selecdo desejada. Se necessario, clique
More para mostrar mais seleces.

« Para entrada de textos, digite a nova informacéo, apagando a
informac&o anterior conforme necessario.

# ‘ Poirt Ta | ‘ Antenna Height... |
o1 1 0.000
o2
1.987
4 4 ‘ 1,907
P 5 1.987
&6 2,000
L 7 0.000
<

Figure 5-1. Campos para Editar Dados
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Campos Editaveis da Vista Tabela Lista de campos editaveis e
ndo editaveis na Vista Tabela .

Table 5-1. Campos Editaveis da Vista Tabela

Campos Editaveis Campos N&o Editaveis
Name Standard deviations
Coordinates String!
Code Control Code?
Aba Point Control
Note
String
Control Code
Point Name Start Time
Original Name Stop Time
Aba GPS Occupations Antenna Type Duration
Antenna Height Method
Antenna Height Source
Method Receiver
Note
Aba TS Obs, Painel #
Esquerdo Point Name
Instrument Height
Instrument Type
# Point From
Point To Horizontal Circle
Reflector Height Slope Distance
Aba TS Obs, Painel Azimuth Zenith Angle
Direito Note Vertical Angle
Code Horizontal Distance
AutoReject Vertical Distance
Offsets Date
Type
Adjustment Status
Residuals
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Note Point From
AutoReject Point To
Point To (RTK Start Time
autotopo observations Duration
only) Precisions
Aba GPS Obs Solutions
Method
Solution Type
Orbit
Adjustment Status
Residuals
Start Point Date
End Point
Aba Tape Dimensions #
Point To
Distance
Note

para Control Code, A coluna String deve conter dados a ser
editado

%Para String, a coluna Code deve conter dados a ser editado.

Editar Parametros da Antena

Os pardmetros da antena sdo um dos campos mais comuns de
edicdo de dados. Veja Campos Editaveis da Vista Tabela para a
lista das células editaveis.

A lista Custom Antenna permite adicionar o tipo de antena
definido por usuério na lista de antenas.
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Opcéo 1: Editar na Vista Tabela

1. Nacoluna de propriedades, vocé quer modificar e
selecionar a ocupacao desejada.

Para selecionar a ocupagdo GPS com certos parametros,
use a caixa de dialogo Select GPS Occupations (veja
“Selecionar Ocupagdo GPS” na pag 4-22 para detalhes).

2. Clique na célula destacada (ou pressione F2) e edite a
informacédo desejada. (Células Editaveis da Antena na Vista
Tabela )

 Para Antenna Type, selecione uma antenna deferente
da lista.

 Para Antenna Height, digite a nova altura para a
antena.

 Para Antenna Height Method, selecione o méatodo a
partir da lista.

Antenna Type
Legant
- Ank Height Method

Yertical

Antenna Height...

2,000

=" Topcon
&

& Leg

&' Top CR4

%" Top CR4 Cone
4" Mare...

Figure 5-2. Células Editaveis da Antena na Vista Tabela

3. Apobs editar as informagdes na coluna, clique for a da
coluna ou pressione Enter para salvar a nova
informacéo.

4. Repita 0s passos 2 e 3 para cada coluna
(Figura 5-3).
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4 ponts o GPS Occupations | ¢, T50bs | o GPsObs | B, Tape Dimensions |

Paint Hams | original Mame [ Antenna Typs | Antenna Hsight... | Ant Height Mathed | Start Time | Stop Time Duratic &
®, Bl BLI Lagant 2000 vertical 30212003 8:50...  3(21/2003 3:00... 1:09:3
o FB BL2 HPer 1700 Slant 3/16{2003 107, I18/2003 118, BIDiL
= B BL2 HPer 1700 Slant 3/19(2003 12:1... 132003 113, Lip2id
LY e BLz HiPer 1700 Slant 3/19/2003 1:21,.. 312003 125... DiO4:
® B3 BL3 Legant 2000 Wertical 3/18(2003 1:22...  18/2003 132

@ B3 BL3 Legant 2.000  Wertical 31192003 1:12...  I1/2003 2:15

@ B3 BL3 Legant 2000 ertical 3/21f2003 825, I21j2003 B2,

<

Figure 5-3. Parametros de Antena Editados

Opcéo 2: Editar em Propriedades
1. Selecione a ocupagdo desejada.

Para selecionar certas ocupacdes GPS, use a caixa de
didlogo Select GPS Occupations (veja “Selecionar
Ocupagdes GPS” na pag 4-22 para detalhes).

2. Click-direito na ocupacdo selecionada e clique
Properties no menu pop-up, ou clique
Edit » Properties (Figura 5-4).

g.:lit
+” Foints O? GPS 0ccupationsl
Poinf Mame | Original hlame | Redo Antenna Type Chri+Y
® ELl BL1
.................................................. CUL CtrH_x
Export... Copy Chrl+C
cu e Paste Chrl+y
Copy Ctrlec Delete Del
Delete Del Zoom 3
Disable Pan mode
ady [_Prop=rtes )y _| Disable Ctr4p
— ;
Cptions. .. B Properties Chrl+Enter

Figure 5-4. Abrir Propriedades

3. Na aba Antenna modifique Antenna Type, Antenna
Height, e Ant Height Method conforme necessario
(Figura 5-5).
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O Properties : GPS Occupation BL2; BL?" 52 E " Legart <
] = 4" Topcan
General  Antenna ] Guality co o
Antenna Type J& Legant Custorn.... ‘ %" Legant
— 4" Top CR4
Antenna Height [m] {12 ' Top CR4 Cone
3 " ! More...
Ant Height Method !"’ beal \ _4’ il

Vertical j

“Vertical

ak | Cancel ‘ ‘

Figure 5-5. Informar Novos Parametros

4. Clique OK para salvar as informagdes editadas, as quais
podem ser vistas na aba GPS Occupations (Figura 5-6).

¥ o ports off GPS Occupations | ¢, Tsobs | o Grsobs | @, Tape Dimensions |

Point Name | original Wame [ Antenna Type | Antenna Height... | Ant Height Method | Start Time: | Stop Time Duratic
® Bl BL1 Legant 2.000  Wertical 3/21/20038:50... 3212003 00...  0:09:3
@A BLz BLZ HiPer 1700 Slant 3/18/2003 1:07... 3/18/2003 1:18... 0:10:1
®.’. BL2 BLZ HiPer 1,700 Slant 3/19/2003 12:1...  3(19/2003 1:19... 1:02:0
@A BLZ BLZ HiPer 1,700 Slant 3/19/2003 1:21...  3{19/2003 1:25, R HE
@.’. BL3 BL3 Legant 2,000 wertical 3/18/2003 1:22... 3(18/2003 1:32. 0:10:0
®, B3 BL3 Lagant 2000 vertical 31192003 112, 3132003 2:15... LGt
®, B3 BL3 Legant 2000 vertical 30212003 8:25,..  3j21/2003 B:32... D:0F0 M

Figure 5-6. Parametros Editados da Antena

Editar Offsets da Antena

1. Para editar offsets, click-direito em qualquer lugar
dentro da tabela e clique Options no menu pop-up
(Figura 5-7).

2. Na caixa de dialogo Options, clique e habilite Show
Offsets (Figura 5-7). Clique OK.
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o Puints 0? GPS Occupations l

Paint Mame Criginal Mame
L) 5LL [—
@, EL2
® BL2 cut el
& EBLZ Copy Ctrl+C
& BL3 Delete Del
&, EBL3 Disable
@, EL3
F3
Properties =

v -

Figure 5-7. Ver Opc¢des

Display l

¥ Show Offsets

N

Cancel ‘ Apply ‘

3. Click-direito sobre a tabela GPS Occupationse clique
Properties no menu pop-up. Clique a aba Offsets para
editar offset da antena para a ocupacao selecionada

(Figura 5-8).

Properties : GPS Occupation BL1

2)X)

General ] Antenna

l GQuality control ]

|0°00'00.0000

Offset Azimuth

Offzet Digt [m) |D
Offzet dHE (m) [
Offset Across [m) |0

[ ]

Cancel ‘

Figure 5-8. Propriedades Ocupac8es GPS — Aba Offset

4. Clique Apply para definir as informac@es, ou OK para
definir as informacdes e fechar a caixa de dialogo.
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5-8

Adicionar Antenas Usando a Lista de Antenas
Personalizadas

Cada tipo de antena tem um Unico parametro de centro de
fase obtido através de calibracdo e armazenado no arquivo
ANTENNA.XML. Este pardmetros ndo é visivel ou editavel.
No entanto, a fungdo Custom Antennas List adiciona os
tipos de antenas definidos por usuério na lista de antenas,
permitindo editar e remover da lista.

1. Para adicionar um novo tipo de antena a lista de antenas,
ou editar a antena atual, click-direito sobre uma
ocupacdo GPS e clique Properties no menu pop-up
(Figura 5-9).

«° Points @2 GPS Occupations }

Paint Narne Criginal Mame

@, BL1 B2 A

% Export...

& BLZ cug Chrhx
® BL3 Capy ChrHC
@, BL3 Delete Del
®, B3 Disabls

2ady

— Cptions... -

Figure 5-9. Abrir Propriedades

2. Naaba Antenna, clique Custom (Figura 5-10) para
mostrar a Custom Antenna List.

© Properties : GPS Occupation BL2; BL2; BL2 E]

General Antennal Quality contral ] /

Antenna Type |“)‘Y HiFer ﬂ Custarn

Antenna Height fm] [1.7
Ant Height Method |5Iamt Li

Figure 5-10. Lista de Antenas Personalizadas
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3. Clique Add para mostrar a caixa de dialogo New
Custom Antenna (Figura 5-11).

A Custom Antennas List

NGS Name ] Name Radius () 1 L1 Base offseti...

e 3
Add m ‘ Remove I Clase:

Figure 5-11. Nova Antena Personalizada

Para remover uma antena, clique na linha da antena e
cliqgue Remove.

4. Na aba General, edite os campos NGS Name, Name,
Manufacturer e Note (Figura 5-12). Depois clique Apply
para salvar as informacdes.

5. Cligue na aba Parameters e informe o Radius, offsets, e
Measured Height Method da antena (Figura 5-12).

@ HMew Custom Antenna

General1 Patameters ]

MGS Mame |Besu-\nd
Mame |The Best Antenna
M anutacturer |&npwhere, Inc.

Note ‘ % New Custom Antenna

General  Parameters 1

Fiadius (m) [135
L1 Base offsetisd] (m) [0

L2 Base offsetid2) (m] |61

L1 Plane offset[C1) [m] \ 25

L2 Plane offseliC2) (m] |33
—J L1 Easting offset(E1) ) [.016

L2 Easting offset(E2] (] [.007

L1 Northing offsetiM1] fm] |-.009

L2 Northing offset(NZ] (m] |- 006

Measured Height Method |Vertica\ L]

(n]: Cancel Apply |

Figure 5-12. Nova Antena Personalizada— Abas Geral e ParAmetros

6. Clique OK na caixa de dialogo Properties.
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Editar Nome dos Pontos

Editando em uma das vistas (Mapa ou Tabela) ou na caixa de
didlogo (Properties) seré aplicada a mesma modificacdo para
todas as vistas, abas e caixas de dialogos. Veja Tabela 5-1 para a
lista de células editaveis.

Opcéo 1: Editar na Vista Tabela

Os nomes dos pontos podem ser editados nas abas Point
Points, GPS Occupations, and TS Obs. No entanto, hé
diferencas significativas quando se edita 0s nomes dos
pontos nas diferentes abas:

» Quando se edita nome dos pontos na aba Points, somente
o0 nome é editado e o novo nome sera refletido em todas
as vistas.

» Quando se edita 0 nome do ponto nas abas Observacéo
ou Ocupacdo, um ponto diferente sera designado para
esta Ocupacao.

» Quando modifica 0 nome do ponto para a Ocupacao ou
Observacao, uma cépia do ponto existente (mas com
outro nome) é criada, porém caso nao haja ocupacdes no
ponto original, ele serd removido.

1. Clique na célula do nome do ponto destacado (ou
pressione F2)(Figura 5-13).

Para selecionar dados com certos parametros, use a caixa
de didlogo apropriada (veja “Selecionar Dados” na
pag 4-18 para detalhes).

+7 paints |2 o +° Poirts o GPS Occupations | ? GPsoccupations <. TS Obs

Mame [ Paint Name | original Mame [ Point Mame [~ F3

® BLi ®_ BL1 BL1 1
®, BLz BLZ 3

7] Bz A =l
L5 oz T Ly
BL3 100
6L
BLS £

LHe

1
H
3

A

Figure 5-13. Selecionar Nome do Ponto para Editar
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2. Selecione ou digite o novo nome do ponto. Clique fora
da célula ou pressione Enter para salvar a nova
informacéo.

+° Points ].g? G

Marne
& BL1
Lz

® points ].g? at
e

EL1

i

fPovsoose

BL3
BL4
BLS
BLA
BL?

A\ 4

BL4
BLS
BLA
BL?

el N N NN

Figure 5-14. Editar Nome do Ponto

Opcéo 2: Editar nas Propriedades

Os nomes dos pontos podem ser editados na caixa de didlogo
Properties do Points, GPS Occupations e TS Occupations.

1. Click-direito no ponto ou ocupacdo GPS/TS e clique
Properties no menu pop-up. Ou selecione o dado e
clique Edit » Properties.

Para selecionar dados com certos parametros, use a caixa
de dialogo apropriada (veja “Selecionar Dados” na
pag 4-18 para detalhes).

2. Na caixa de didlogo Properties e na aba General, edite o
nome do ponto e clique OK para salvar as informagdes.

+ Properties : TS Occupation 2.1

General ] Instrument Type ]
Paint Mame + Properties : TS Occupation 2.1

Instrument Height [m) |3.048 Genera|1 Instrument Type I
t 1 — | PeintMame |1-Last |

¥ Enabled Instrument Height (m) [3.048

aK | Cancel | # “1

¥ Enabled

QK m | Cancel Apply

Figure 5-15. Editar Nome do Ponto
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Mesclar Pontos

Mesclando dois pontos provocaram o ajustamento, o
processamento, os testes de qualidade e funcdo que trata dois
pontos como um s6 ponto; porém com certas conseqléncias.

1. Naaba Points, selecione um dos pontos a serem
mesclados.

2. Pressione F2 e digite 0 nome do segundo ponto no
campo de entra de texto.

3. Pressione Enter para mesclar dois pontos.

Editar Nome dos Pontos das Obs GPS

Frequentemente, os programas de topografia usados durante
a medicdo RTK, a numeragdo do Autotopo se inicia com a
numeragdo padrdo. Quando importa duas obras diferentes
com observagBes Autotopo que usa a numeracao padréo,
dois pontos Autotopo, fisicamente diferentes, podem ter o
mesmo nome. Topcon Tools ndo permite que dois pontos
diferentes tenham o mesmo nome, assim, tais pontos serdo
mesclados depois de importados. Para solucionar este caso,
edite manualmente os nomes do “Point to” na aba GPS Obs.

1. Naaba GPS Obs, selecione “Point to” para editar.

2. Pressione F2 e digite 0 novo nome para a observacéo.
3. Pressione Enter.
4

Repita estes passos para cada observacao aplicaveis.

Editar Métodos de Ocupacéao GPS

Os métodos de ocupacdo GPS (estatica ou cinemaética) é um dos
campos mais comuns de edi¢do de dados GPS, quando este
campo foi marcado erroneamente com método incorreto. Veja
Tabela 1-5 para a lista de células editaveis.
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Para modificar de estatica a cinemaética, faca com que o campo
do nome do ponto fique vazio. (Figura 5-16).

1. Destaque 0 nome do ponto da ocupagdo GPS a ser editado e
pressione F2.

2. Pressione Delete para remover e pressione Enter.

A ocupacao estatica é agora uma ocupacgao cinematica (no
exemplo abaixo, também tera um icone de aviso préximo ao
nome do ponto).

«” Points g‘? GPS Occupations I «° Points @? GPS Occupations ‘ «” Paints d? GPS Occupations ‘
Point Narns Original Name Paink: Mame Origirial Mame Poink Name Original Name

® BL3 BL3 &, BL3 BL3 &, B3 BL3

@, BL3 BL3 ®, BL3 BL3 @, B3 BL3

« EET = M T ~lw o, I 0.2

®, B4 BL4 —_— | B4 —_— g A N

®, B4 BL4 , BLt Bl @, Bl BL4

&, BLS BLS #, BLS BLS ®, BLS BLS

®, BLS BLS @ B BLS ® _BLS BLS

< 3 <

Figure 5-16. Modificar Ocupagéo GPS de Estatica a Cinemética

Para modificar de Cinematica para Estatica, informe o nome no
campo nome do ponto desta ocupacéo (Figura 5-17).

1. Destaque o nome do ponto da ocupacdo GPS a ser editado e
pressione F2.

2. Selecione ou digite um nome e pressione Enter.

A ocupacédo Cinematica é agora uma ocupacdo Estatica (no
exemplo abaixo, também tera um icone de aviso proximo ao
nome do ponto).

o° Poits & 6Ps Occupations | +° Points @ GPS Occupations o° Foris 4 GPS Occupations |
Poiri: hlame Original Hame Fuint Name Otiginal Name: Paint Name Criginal Name

&, BL1 BL1 A @, BL1 EL1
qw Ki1¥D K11k o[ K11 KL

®, BL6 BLS ®_EBl6 k BLE ®, Bl [:13

®, Bl6 BLs —_— | s BLS —_— e, B BLS

&, BL6 BLE @ ELe BLG @ BL6 BL&

& BL7 BL7 ® EL7 BL7 & BL7 BL7

5 BL7 EL7 ® BL7 BL7 ® BL7 BL7

(‘ < <

Figure 5-17. Modificar Ocupagdo GPS de Cinematica para Estatica
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Observe que Topcon Tools determina, automaticamente, se uma
ocupacdo em particular é estatica/cinematica ou stop-and-go,
usando a seguinte regra: se uma cadeia de ocupacdes tem, no
minimo duas ocupagdes estaticas e duas ocupagdes cinematicas,
entdo todas as ocupacdes sdo stop-and-go.

Editar Codigos na Vista Codigos

Cadigos proporcionam uma descricdo abreviada da feicdo que
estd sendo medida. Atributos proporcionam detalhes adicionais
as fei¢des (codigos).

AVISO

Se usados na Obra, os codigos e atributos néo
podem ser editados.

Adicionar um Cdodigo

1. Com a Vista Cddigos aberta (View » Codes) e
selecionada, click-direito dentro do painel esquerdo e
clique New Code no menu pop-up (Figura 5-18).

2. Digite um nome na célula de entrada de texto e pressione

:
E
LI

Enter.

& tok § e

& hb 4 hb

& ok § o

& punch § purch

§ revs & rebs

& § robe

|

Figure 5-18. Adicionar Novo Cédigo
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Editar um Cddigo

Se usados na obra, os c6digos ndo podem ser editados. Para
remover um cddigo de uma obra em uso,veja “Editar
Cadigos Usados nos Pontos” na pag 5-19.

1.

Click-direito sobre o cédigo selecionado e clique

Properties no menu pop-up.

Mame |
& bok

4 hb

& pe

El punch

él reba

él rebar

4 sampl Exuur‘t..‘

él sampld
Mew Code

Mew Attribute 3
Cut Chri+x
Copy ChrHC
Delete Del

N —

Figure 5-19. Propriedades Vista Cédigos

Edite 0 nome do codigo e clique OK para
informacéo.

salvar a nova

i Properties : Code sample2 @@

General l

MName |posﬂ

oK k | Cancel ‘ Apply ‘

Figure 5-20. Editar Nome do Cédigo

Adicionar um Atributo

Se usado na obra, 0s atributos ndo podem ser adicionados ao
cddigo. Para remover um cddigo de uma obra em uso, veja
Editar Codigos Usados nos Pontos na pag 5-19.

1. Click-direito sobre o codigo a ser adicionado um atributo

e clique New Attribute entdo selecione o
atributo no menu pop-up (Figura 5-21).

tipo de
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Mame

& bol
& hub
& ok
él punch
él reba
él rebar
4

él post Export...
& sampled|  new Code

Mew Attribute m
Cut Chrl+3 Text

Copy Chrl+C List
Delete Del
Properties

Figure 5-21. Selecionar Atributo para Adicionar

2. Na caixa de dialogo Attribute Properties, selecione ou
informe os parametros desejados do atributo (Figura 5-
22).

* Para atributos Numéricos, edite o nome, valor
padrdo, valores maximo e minimo e quantidade de
digitos ap0ds o decimal.

* Para atributos Texto, edite 0 nome, o valor padrdo e
0 comprimento m&ximo e minimo para o atributo.

« Para atributos Lista (menu), edite 0 nome e o valor
padrdo do atributo. Clique Add para adicionar o
valor padréo a lista ou Remove para remover o valor
padréo selecionado da lista.
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ER Properties : Numeric Attribute test

Gensral |

MName

&2 Properties : Text Attribute hypot... @@

Default Yalue

I
e [ m— General I
i Wame [hypathesis
il | " Properties : Menu Attribute ex... [F2|BR)
: : Default Vale P PIX
Digits after decimal |2
I Requicd Type et | General | .
oK | ] | Masimun Length [10 ={ Name [ examination
= ¥ Required Drefault Y alue
= Add ‘ Remove |
ok Cancel |
=] Tupe [List
v Reguied
Ok Cancel ‘ ‘

Figure 5-22. Editar Atributo

3. Para qualquer atributo, habilite Required se o atributo
deve estar presente e tenha um valor.

4. Clique Apply para definir os dados sem fechar ou clique
OK para definir os dados e fechar a caixa de dialogo.

Editar um Atributo

Se usado na obra, 0s atributos ndo podem ser adicionados ao
cddigo. Para remover um cddigo de uma obra em uso, veja
“Editar Codigos Usados nos Pontos™ na pag 5-19.

1. Paraver ou editar as propriedades do atributo, click-
direito sobre o atributo no painel direito da Vista
Cadigos e clique Properties.

2. Edite as propriedades desejadas na caixa de didlogo
Attribute Properties (Figura 5-23).

« Para atributos Numeéricos, edite 0 nome, valor
padrdo, valores maximo e minimo e quantidade de
digitos ap6s o decimal

« Para atributos Texto, edite 0 nome, o valor padréo e
0 comprimento maximo e minimo para o atributo.

* Para atributos Lista (menu), edite 0 nome e o valor
5-17
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padréo do atributo. Clique Add para adicionar o
valor padréo a lista ou Remove para remover o valor
padréo selecionado da lista.

(e

ER Properties : Numeric Attribute test

General |

MName

Default Yalue

&2 Properties : Text Attribute hypot... @E]

I -
i General l
M
2 Marne [hypathesis . i
Masimum Properties : Menu Attribute ex... ‘ 4 |&|
z : Default Value —
Digits after decimal Hz
I~ Requied Type Teut S I =
A Requied Drefault Y alue
|IiE = Add ‘ Remave |
0K Cancel |
— Type |List
¥ Requied
oK Cancel ‘ ‘

Figure 5-23. Editar Atributo

3. Para qualquer atributo, habilite Required se o atributo é
requerido durante o processamento ou ajustamento.

4. Clique Apply para definir os dados sem fechar ou clique
OK para definir os dados e fechar a caixa de dialogo.
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Editar Codigos Usados nos Pontos

Use este procedimento para aplicar os codigos aos pontos ou
remover dos pontos para 0 processamento e ajustamento.

1. Click-direito sobre o ponto desejado e clique Properties no
menu pop-up (Figura 5-24).

«” Points ]g? GPS Occupations }<>,

Expott...

@ BLS
@® BL6
& BL7
& BLE

[aT'3 Chrl+s 1z
Copy Chi+C 1z
Delete  Del 1z
Disable 1z

[ oo [

Figure 5-24. Ver Propriedade dos Pontos

2. Clique na aba CAD para ver 0s cddigos usados atualmente,
para adicionar cédigos ao ponto ou excluir c6digo usado no
ponto. Qualquer atributo associado aos cddigos sera
mostrado no painel direito.

3. Para adicionar codigos ao ponto, click-direito no painel
esquerdo e cliqgue New Code. Selecione o codigo da lista e
clique for a da célula ou pressione Enter (Figura 5-25).

Nota: digitando um novo cddigo na caixa de entrada de
texto, este codigo sera adicionado no arquivo de obra e no
ponto. Use a Vista Codigo para aplicar os atributos.

© Properties : Point BL3 @@
Adjustment | qualty control [~ codes
Generdl | Coordinates c
Fod Name
ades
&k
Mame || attribute [val & reber
& /ol 5|
& rebar o
oK ; ‘ Appl

Figure 5-25. Adicionar Cédigo ao Ponto
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4. Para excluir um cédigo que esté sendo usado para o ponto,
click-direito no painel esquerdo e clique Delete (Figura 5-
26). Todos os atributos associados a este cddigo também
serdo excluidos do ponto.

Nota: Excluindo um cddigo da aba CAD, somente sera
excluido o codigo do ponto e ndo da obra.

© Properties : Point BL3 @@

Adjustment I Quality control 1
General 1 Coordinates CAD
Codes

Hame | [_attribure [vale |
& ok test 0

& rebar
4

Cut Chrl+X
Copy Chrl+C

oc | BEEETSEENE e
.

Figure 5-26. Excluir Cédigo do Ponto

5. Clique OK para salvar as definicdes.

Editar os Parametros de Estacao Total (ET)

Os pardmetros de Estacdo Total atribuem a altura e o tipo de
informac&o para o instrumento usado nos dados ET. Veja
Campos Editaveis da Vista Tabela para a lista das células
editaveis.

Os pardmetros de instrumento definem as precisdes apresentadas
pelas medicdes realizadas por um modelo de ET. Por padréo (se
nenhum instrumento é selecionado), Topcon Tools usa alguns
valores usuais. As precisdes das medicGes ET influenciam
levemente como as medi¢des sdo contadas durante o
ajustamento. Atribuindo um instrumento correto pode, melhorar
o resultado do ajustamento. Para muitos casos, no entanto, 0s
valores de precisdo padrdo aplicados séo suficientes.

A Custom TS-Instrument List permite adicionar tipos de
instrumentos definidos por usuario na lista de instrumentos.
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Opcéo 1: Editar na Vista Tabela

1. Nacoluna da propriedade que deseja modificar,
selecione a ocupacdo desejada.

Para selecionar ocupacdo TS com certos pardmetros, use
a caixa de dialogo Select TS Occupations (veja
“Selecionar Ocupagdes ET” na pag 4-21 para detalhes).

2. Clique uma célula destacada e edite a informagéo
desejada. (Figura 5-27).

* Para Instrument Height, digite a altura do
instrumento.

* Para Instrument Type, selecione o modelo da lista.

stions 9, TS Obs h <, T5 0Obs ‘g@,ﬁ GPS Cbs I O, Tape
Instrument Height {m) imenkt Height {m) ‘ Instrument Tvpe \ ~
3.048 3048
1.521 1.521 -
1.516 L.518 [GT5-712 -~
1.538 1,536 |GT3-G00
GT5-G00A
1332 L592 orsann
1.465 1465
1.503 1.503 |MPL-520
PC5-215
1388
o PC5-225
PCS-315
PC5-325
PT5-602 b

Figure 5-27. Células Editaveis na Vista Tabela

3. Apobs editar a informagao na coluna, clique for a da
célula ou pressione Enter para salvar a hova informacéao.

4. Repita os passos 2 e 3 para cada coluna. (Figura 2-28).

«” Points 10? &PS Gcupations %%, TS Obs IO@; GRS Obs ] B, Taps

| Paint Mame | Instrument Height {m) | Instrument Type | ~
1 3.048
1,450
1.518
1,536
1,532
1.465
1,503
1.388 L

I T

Figure 5-28. Parametros de Instrumento Editados
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Opcéo 2: Editar nas Propriedades
1. Selecione a ocupacdes desejadas.

Para selecionar ocupacGes ET com certos parametros,
use a caixa de dialogo Select TS Occupations (veja
“Selecionar Ocupagdes ET” na pag 4-21 para detalhes).

2. Click-direito sobre as ocupacGes desejadas e clique
Properties no menu pop-up, ou clique

Edit » Properties.
ations G, TS 0bs |2 ( . i
Inst et Qri+X
3,048 Copy ChrlC
TEgort.. || Paste ctriby
Cut Cirlei Cislsts Del
Copy Ttk C Zoom »
Delete  Del ;
Disable
- | pratle s

erties. .. N:I:r‘HEntEr

Figure 5-29. Abrir Propriedades

3. Na aba General, edite a altura do instrumento.

4. Na aba Instrument Type, edite o tipo de instrumento

+ Properties : TS Occupation 2.1 . |J
General 1 Instrument Type 1 \ 1
Paint Name 1 \ -
Instrument Height [m] §1.45) |
# [2 = ——
¥ Enabled + Properties : TS Occupation 2.1 E\E|
0K | Cancel General i
Instrument Ty e Custom, ‘
1
|GT5-8028 |

K. Cancel | Apply ‘

Figure 5-30. Informa Novos Parametros

5. Clique OK para salvar as informacdes editadas, que
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podem ser vistas no painel esquerdo painel da aba TS.

«” Paints ]o? GPS Occupations <% TS Obs IQ@; GP3 Obs ] B, Tape
# | Faint Mame | Instrument Height () | Instrument Type | -~
1 3,048

@2 1 1.450 [EE

O, 3 2 1.518

O, 4 3 1.536

O, 5 4 1.532

O, 6 5 1.465

<, 7 6 1.503

oA 7 1,578 b

Figure 5-31. Parametros Editados da ET

Adicionar Instrumento Usando a Lista
Personalizada de ET

Cada modelo de Estagdo Total (ET) tem as suas precisdes
conhecidas, as quais devem estar na documentagéo do
instrumento. Uma lista de instrumentos padrdes, ndo visiveis
ou editaveis, estd armazenada no arquivo

TSinstrument. XML.

1. Paraadicionar um novo tipo de instrumento a lista ou
editar o tipo de um instrumento existente, click-direito
sobre uma ocupagdo ET e clique Properties no menu

pop-up.

ations <% TS Obs IQ@; 4

| Instrument Height () | Insk

. Expork
Cut Chrl+x
Copy Chrl+C
Delete Del

Disable

[Popete:—y |

Figure 5-32. Abrir Propriedades

2. Naaba Instrument Type, clique Custom (Figura 5-33)
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para mostra a Custom TS Instrument List.

* Properties : TS Occupation 1.1

General
Instrument Type |GTS-6024F

oK Cancel Apply I

Figure 5-33. Abrir Lista de Instrumentos Personalizados

3. Clique Add para mostrar a caixa de dialogo New Cus
tom TS Instrument (Figura 5-34).

%A Custom TS-Instrument List

Marme | Manufacturer | EDM PRI

b >

Add m ‘ Remove ‘ Cloze |

Figure 5-34. Nova ET Personalizada

Para remover um instrumento, clique na linha do referido
instrumento e clique Remove.

4. Na aba General, edite os campos Name, Manufacturer e
Note (Figura 5-35). Clique Apply para salvar a
informacéo.

ﬁ Mew Custom TS-Instrument E|r5__(|

General I Parameters 1

MName | The Best Instrument

I anufacturer |Anywhela,\nc

Note |

oK Cancel | Apply |

Figure 5-35. Nova ET Personalizada — Geral

5. Clique na aba Parameters e informe o EDM, o PPM, as
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precisOes vertical e horizontal e a distdncia maxima.
(Figura 5-36).

:ﬂ MNew Custom T5-Instrument EJ@

General Parameters l

EDM |.39
FPM E3
Wetdcour |.005
Horz&ecur |.00d
ManDist [10000

QK | Cancel ‘ Apply ‘

Figure 5-36. Nova ET Personalizada — Parametros

6. Clique OK na caixa de didlogo Properties.

Editar Propriedade de Dados

Cada tipo de dado tem uma caixa de didlogo Properties
associadas em que mostra as informacdes visiveis e editaveis
para o dado selecionado.

Quando se seleciona varios itens de mesmo tipo de dado, todos
0s itens sdo representados em uma sé caixa de dialogo e
quaisquer mudangas feitas no campo editavel sdo aplicadas em
todos os itens selecionados.

Editar Propriedades do Ponto

A caixa de dialogo Properties varia ligeiramente
dependendo da quantidade de pontos selecionados: A aba
CAD ndo esta disponivel para visualizar as propriedades de
pontos maltiplos.

1. Paraver as propriedades de um ou varios pontos
selecionados:

* Click-direito sobre um ponto e clique Properties no
menu pop-up.
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« clique Edit » Properties

A caixa de dialogo Properties varia ligeiramente
dependendo da quantidade de pontos selecionados.

2. Ver ou editar os campos da aba General (Figura 5-37):

» Campos editadveis —Name (para ponto simples),
Notes, Codes e o tipo Control usado para o(s)
ponto(s).

» Campos selecionaveis — Enabled for Adjustment
inclui somente o ponto no processo de ajustamento;
desabilite este pardmetro para excluir o ponto do
ajustamento.

© Properties : Point BL3

Adjustment: | Guality contral |
General | coordnates | cap |
Name [BL3

Mate ‘

Code ~

Control |None 5

¥ Enabled for Adjustment

1]% Cahcel | Apply ‘

Figure 5-37. Propriedades Geral

3. Para selegdo de ponto simples, visualiza¢do ou edi¢do
dos campos da aba CAD. Estes campos codigos de lista
de pontos; click-direito no campo do nome a ser
adicionado um codigo, copiar/colar um cédigo ou
excluir um codigo do ponto (veja “Editar Codigos
Usados nos Pontos” na pag 5-19 para detalhes de editar
cadigos nesta aba).

4. Visualizar ou editar o campo da aba Coordinates
(Figura 5-38). Os campos disponiveis dependem do tipo
de coordenadas selecionadas na Configuragdo da obra.

5. Visualizar campos da aba Adjustment para desvios
padrbes dos pontos (Figura 5-38).
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o Properties : Point BL3

Adjustment | Qualty conty,
General Coordinates
Datum
|Latitude 47754730 BEAN ... Coudnates | General |
Adjustment ] Qualty control |

Longitude T223316.599W
Std Dev n [m)

ElHeight(m)  [20152
5td Dev & (m]

Std Dev ufm]

‘ oK | Cancel | Lpply |

Figure 5-38. Propriedades de Coordenadas e do Ajustamento

6. Se “Display String and Control Code” tem sido
habilitada na Configuragéo da obra, a aba Strings edita a
primeira figura e mostra o codigo de controle para o
ponto (Figura 5-39).

7. Ver aba Quality Control contém texto informativo nos
pontos selecionados (marcados em vermelho nas vistas)
que ndo passaram em alguns critérios do controle de
qualidade (Figura 5-39).

O Properties : Point BL3

General | Coordinates | CAD |
idjustment String |
Sting I
Cantrol Code @ Properties ; Point BL1

General | Coordinates | o |
Adistment Quality control
[Some GPS occupalions are mots tha 10m

aviap from point. They are probably
misnamed

oK Cancel |

‘ aK | Cancel ‘ Apply ‘

Figure 5-39. Propriedades de Figuras e do Controle de Qualidade

8. No final, cliqgue OK para aplicar as mudangas e fechar a
caixa de dialogo.
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Editar Propriedades de Ocupacdes GPS

A caixa de dialogo Properties varia ligeiramente
dependendo do tipo de ocupacdo selecionado. Para algumas
ocupacBes, campos adicionais disponibiliza mais
informacéo.

1. Paraver ou editar as propriedades de uma ou varias
ocupagcdes:

* Click-direito em uma ocupacéo e clique Properties
no menu pop-up

« clique Edit » Properties

2. Ver ou editar os campos da aba General (Figura 5-40).
Os campos variam dependendo do tipo de ocupagéo
selecionado.

» Campos editaveis — Nomes Original e Ponto e
qualquer Notes associados aos pontos.

» Campos selecionaveis — Enabled inclui todos 0s
vetores baseados nesta ocupagdo em processamento.
Desabilite este parametro para excluir a ocupagéo do
ajustamento.

« Para ocupacdo PP, o campo Orbit mostra o tipo de
dados de 6rbita disponivel para processar esta
ocupacao. Se aparece “None”, a ocupacao € marcada
em vermelho e a aba do controle de qualidade mostra
0 texto com a descricdo do problema. Nenhum
processamento pode ser realizado sem os dados de
Orbita.
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o Properties : GPS Occupation BL1 PIX
General | anterna | offset | Qualiy cantral |
Original Maarme [BLT
Poirt Harne [BL1 ]
Start Time [3/TB/2003 1:01:00 AM
T [3/18/2003 2 47.00 AM # Properties : GPS Occupation 123 E”g]
Duration [-45:00 General ] fntenna | Offset | Qualty contral |
Hethod [Static Driginal Name
o NEpoch=424 Faint Mame |
Start Time |1/24/2003 10:23:56 PM
Source |CAProgram FileshTopcon'TopconT ocls 1.20% Stop Time |1f24/2003 10:29:56 PM
Feceiver [BEGYLOVHTSD Byt [a60
el L ——— Method |Topa
Orbit [Broadcast
¥ Enabled . ‘
oK I Cancel ‘
Source |C:\Program Files\TopeonhT opeonT ools 1.20%
Receiver |
Iv Enabled
ak Cancel ‘ ‘

Figure 5-40. Propriedades - General

Ver ou editar o campo da aba Antenna. Veja Opcéo 2:
Editar em Propriedades para detalhes de edi¢do destes
campos.

Ver ou editar os campos da aba Offset. Veja “Editar
Offsets da Antena” na pag 5-6 detalhes.

A aba Quality Control contém texto informativo nas
ocupac0es selecionadas (marcadas em vermelho nas
vistas) que ndo passaram em alguns dos critérios do
controle de qualidade (Figura 5-41).

)

o Properties : GPS Occupation BL1

General I Antenna ] Offset :

Occupation is more than 10m away from paint.
It is probably misnamed

0K Cancel | : |

Figure 5-41. Propriedades de Controle de Qualidade

Ao terminar, clique, OK para aplicar as modificac6es e
fechar a caixa de dialogo.
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Editar Propriedades de Obs ET

A caixa de dialogo Properties varia ligeiramente
dependendo do painel em que o dado é selecionado.

Editar Propriedades de Ocupac¢des ET

A caixa de dialogo Properties do painel de ocupagGes
ET define 0 nome do ponto, o0 nimero do pponto, a
altura do instrumento e as informacdes do tipo de
instrumento.

1. Para ver as propriedades para uma ou varias
ocupac0es ET selecionadas, click-direito no painel
esquerdo da aba TS Obs e faga um dos seguintes:

« clique Properties no menu pop-up
« clique Edit » Properties
2. Ver ou editar o campo da aba General (Figura 5-42).

» Campos editaveis — nome do ponto, altura do
instrumento e nimero do ponto.

» Campos selecionaveis — Enabled inclui todos os
vetores baseados nesta ocupagdo em
processamento. Desabilite este pardmetro para
excluir a ocupacéo do ajustamento.

+ Properties : TS Occupation 1.1

General 1 Instrument Type ]
Foirkt Name |1 j
Instrumert Height ) [3.048
: [ |

W Enabled

Ok Cancel | |

Figure 5-42. Propriedades - Geral

3. Ver ou editar os campos da aba Instrument Type.
Veja”Opcao 2: Editar nas Propriedades” na pag 5-22
para detalhes de edigéo destes campos.
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4. Ao terminar, cliqgue OK para aplicar as modificacdes
e fechar a caixa de dialogo.

Editar Propriedades de Observacgdes ET

A caixa de dialogo Properties do painel das observacoes
ET, define o nome do ponto, a altura do instrumento e as
informaces do tipo de instrumento.

1. Para ver as propriedades de uma ou varias
observacOes ET selecionadas:

* Click-direito sobre a observacao no painel
direito da aba TS Obs e clique Properties no
menu pop-up

* Cligque uma observagéo no painel direito da aba
TS Obs e clique Edit » Properties

2. Ver ou editar os campos da aba General
» Campos editaveis — Point To, Notes, #, e Code.

» Campos selecionaveis — Enabled inclui o vetor
no processamento. Desabilite este pardmetro
para excluir o vetor do processamento.

& Properties : TS Obs 1.1-1.0 R

Adjustment | Quality Contral |
General | Obsarvation | offset

Point Fram [1
Faint To o |

Date [

o ‘

4 i =)
Code | ~|
Type [BS

¥ Enabled

| oK | Cancel | Apply |

Figure 5-43. Propriedades — Geral

3. Ver ou editar os campos da aba Observation. Editar
0s campos Reflector Height e Azimuth conforme a

5-31

P/N 7010-0612 www.topconpositioning.com



Capitulo 5

necessidade (Figura 5-44). Horizontal Circle sempre
sera mostrado, mas Zenith Angle e Slope Distance
(ou Vertical Angle e Slope Distance, ou Vertical e
Horzontal Distance) depende da opcdo selecionada
na Configuracdo da Obra.

Ver ou edita 0s campos da aba Offset para a edi¢cdo
de offsets e selecdo do tipo de offset (Figura 5-44).

| Quality Contral
General Observation | Offset

Reflector Height (m) [0

Adimuth 700100, 0000

adiustment | Qualty Contrel |

Harizontal Circle 0000, 0000 General | } Observation Offset

Zeriith Andle [ Offsetflong () [0

Slope Distance (m] | Difsst Across (m) [0
OifsetHtim) [0
Offset Type [From Observation Line ~|

0K Cancel Apply |

‘ oK | Cancel ‘ Apply

Figure 5-44. Observacao e Propriedades de Offset

Ver ou editar os campos da aba Adjustment para a
definicdo da opcdo AutoReject e visualizagao do
estado e residuo para a observacédo (Figura 5-45).

A aba Quality Control contém texto informativo
nas ocupacdes selecionadas (marcadas em
vermelho nas vistas) que nao passaram em
alguns dos critérios do controle de qualidade
(Figura 5-45).
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L Properties : TS Obs 1.1-1.0

General | Chservation

Adjustment

Quality Cantral |

| offeet |

AutoReject [ llowed

Adjustment Status  [Mot Adjusted

Zéngle Fesidual |

SDist Residud (m] |

]

Cancel |

Apply |

+ Properties : TS Obs 1.1-1.0

General

Adjustment

| Observation | Offset |
Quality Cantrol

ok

| Cancel Apply

Figure 5-45. Propriedades do Ajustamento

7. Ao terminar, clique OK para aplicar as modificagdes
e fechar a caixa de dialogo.

Editar Propriedades de Obs GPS

A caixa de dialogo Properties varia ligeiramente
dependendo do tipo de observacao selecionada. Para
algumas observacGes, “Adjustment status” and “Reject
mode” ndo sdo mostrados.O campo “Point to” para
observagfes Autotopo RTK pode ser editado

1. Para ver as propriedades para uma ou varias observacfes
GPS selecionadas:

* Click-direito sobre a observacdo no painel direito da
aba GPS Obs e clique Properties no menu pop-up

* Cligue uma observacdo no painel direito da aba GPS
Obs e clique Edit » Properties

2. Ver ou editar os campos da aba General (Figura 5-46).
Os campos disponiveis diferem dependendo do tipo de
observacdo selecionada.

» Campos editaveis — Notes para todas as observacos,
Point to para observacfes Autotopo RTK
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» Campos selecionaveis — Enabled inclui o vetor
durante o processamento. Dasabilite este parametro
para excluir o vetor do processamento.

e

#® Properties : GPS Obs Base /000001-123
“general | observation | djustment | Qualty contral |
|Base7000001

[122

[1/24/2003 10:29.56 PM

[0

Point From

Paint To @ Properties : Kinematic vector Base7000001 -Auto2 @@

Start Time General} Observation | Quality control | Adjustment |
|Base 7000001

|Aut92

B Pairt From

Paint To

Maote ‘ [1/24/2003 11:23.01 PM

[c:0o:00

Start Time

Duration

Method |RTK Topa
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oK |

¥ Enabled
Note

Cancel

Method
¥ Enabled

=

[RTK AutoTopa

Cancel

Figure 5-46. Propriedades — Geral

Note que as abas Observation e Adjustment estdo
trocadas dependendo do tipo de observacdo selecionada.

Ver ou editar os campos da aba Observation que contém
as precisdes horizontal/vertical, o tipo de solucdo do
vetor (dN,dE,dU ou dX,dY,dZ, ou Az,EI,D; defina com
a caixa Options), o Tipo de solucgéo e o tipo de dados de
Orbita se ainda ndo esta processado ou o dado da 6rbita
usado no processamento (para observagdes RTK, sempre
“Unknown”) (Figura 5-47).

Ver ou editar os campos da aba Adjustment que diferem
dependendo do tipo de observacao selecionada. Para
observac0es estéaticas, defina a opcdo AutoReject e
visualize o estado e 0s residuos para a observagdo. Para
observagOes cinematicas, mostra somente as
informacdes dos residuos. Selecione os parametros de
AutoReject conforme necessidade (Figura 5-47).

Topcon

Topcon Tools Manual de Referencia



Capitulo 5

# Properties : GPS Obs Base7000001-123

PIX

Wertical Precision (m]

® Properties : GPS Obs Base 7000001-123

)

dn fm] [f&2z | General | Observation {Adjustmenti quaitycontrol |
de [m) [agaz || AutoReject [ llowed ]
du fm) 481 | Adjustment Stalus [Hot Adjusted
Solutian Type W Resn (m] |
Ortit T |Reem [
Fies u(m] [

0K | Cancel | ) |

Figure 5-47. Observacgéo e Propriedades do Ajustamento

5. A aba Quality Control contém texto informativo nas
ocupac0es selecionadas (marcadas em vermelho nas
vistas) que ndo passaram em alguns dos critérios do
controle de qualidade (Figura 5-48).

® Properties ;: GPS Obs Base7000001-123 |E”E

General 1 Observation I Adjustment

ok | Cancel | A |

Figure 5-48. Propriedades de Controle de Qualidade

6. Ao terminar, clique OK para aplicar as modificacdes e
fechar a caixa de dialogo.
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Editar Propriedades de Medicdo a Trena

A caixa de dialogo Properties para a medicao a trena varia
ligeiramente dependendo do painel em que o dado é
selecionado.

Editar Propriedades de Medic&o a Trena

A caixa de dialogo do painel Properties define as
informac6es do ponto inicial e do ponto final.

1. Para ver as propriedades de uma ou varias medicdes
atrena:

* Click-direito sobre uma medicéo a trena na aba
Tape Dimension do painel esquerdo e clique
Properties no menu pop-up

 Clique sobre uma medicéo a trena na aba Tape
Dimension do painel esquerdo e clique
Edit » Properties

2. Ver ou editar os campos da aba General (Figura 5-
49). Edite os parametros do Start Point e End Point
conforme necessario.

Properties : Tape Dimension Re...

General ]

Stat Pain -

End Point & -l

(i]: Cancel ‘ ‘ |

Figure 5-49. Propriedades — Geral

3. Ao terminar, cliqgue OK para aplicar as
modificacBes e fechar a caixa de dialogo.
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Editar Propriedades do Ponto da Medicéo a
Trena

A caixa de dialogo do painel Properties define o ponto
para, distancia, notas e informacg6es do nimero do ponto.

1. Para ver as propriedades de um ou varios pontos das
medicdes a trena:

* Click-direito sobre um ponto da medicao a trena
na aba Tape Dimension do painel esquerdo e
clique Properties no menu pop-up

* Clique sobre um ponto da medicéo a trena na

aba Tape Dimension do painel esquerdo e

clique Edit » Properties

2. Ver ou editar oas campos da aba General
(Propriedades — Geral ). Edite 0s pardmetros de Point

To, Distance, Notes, e # conforme necessario.

- Properties : Tape Dimension 1

General l

Paint To 1

Distance [m) |-‘I o

Date |3/30/2004 5:20:06 AM

Mote ‘

(6].8 | Cancel ‘

Figure 5-50. Propriedades — Geral

3. Ao terminar, cligue OK para aplicar as modificacdes
e fechar a caixa de dialogo.
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Notas:
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Processamento, Ajustamento
e Localizacao

Quando trabalha com dados brutos GPS+ € possivel processar as
observacfes GPS com o GPS+ Post Processing. Caso processe as
observag6es no Mddulo GIS, as coordenadas dos pontos
observados serdo aproximadas. Para algumas aplicacdes, a
qualidade das coordenadas aproximadas é satisfatoria, porém
para aplicacOes de alta precisdo, é necessario fazer o ajustamento
das observac6es para melhorar a precisdo das coordenadas dos
pontos.

A funcéo de ajustamento também pode ser utilizada nas redes de
medi¢des com Estacdes Totais, rede combinada de Estacdo Total
e GPS e no recalculo das coordenadas das medigdes RTK. O
processo de ajustamento calcula a melhor posicao para todos os
pontos da obra. Para tanto, a obra ndo pode estar desabilitada ou
filtrada.

Para transformar as coordenadas entre sistema de GPS (WGS84)
e sistema local, utilize o processo de Localizacéo para calcular
0s parametros de transformacéo.

Definir Propriedades do Processamento e
do Ajustamento
As propriedades da caixa de didlogo para processamento e

ajustamento definem o calculo de dados de ET, p0s-
processamento dos dados GPS+ e ajustamentos.

1. Para definir os parametros de processamento e de
ajustamento, faca uma das seguintes opcdes:

* Cligue Process » Process Properties para mostrar a
caixa de didlogo Process properties (Figura 6-1).
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* Clique Job » Job Configuration, entdo clique Process
no painel esquerdo da caixa Job Configuration .

Process

GPS+ PostProcessing F7
Adjustment Fa
Localization Shift+Fa
Loop Closures

Figure 6-1. Open Process Properties

O painel Process nas caixas de dialogo Job Configuration e
Process properties mostram 0os mesmos parametros.

2. Na aba Adjustment, selecione o nivel de confianca para o
ajustamento, sendo 68%, 95% ou 99% (Figura 6-2). O
padrao é de 95%.

3. Naaba TS-Computations, selecione o coeficiente de
refracdo, sendo 0, 0.14 ou 0.2 (Figura 6-2). O padréo é de
0.14.

4. Naaba GPS+ PostProcess, selecione a mascara de elevacao,
combinacdo do sistema de navegacao e o tempo minimo de
observacdo para o0 processamento (Figura 6-2).

P2 Process properties szl

Adjustment | T5-Computations | GPs+ PostPracess |
Confidence Level

" BE%
{* 952
™ 93%

% Process properties E| Pz|

Adjustment TS—CDmputations} GPS+ PostProcess ]
Refraction Coefficient

(l: 3.14 % Process properties
Conz Adjustment ] TS-Computations GP5+ PostProcess 1
Elevation tazk ||15 = ‘
System |GPS+ j
Iinimurm duration
| Fized Time =l

Min. obs. time{sec) |&0 =

[~ Enable continuous kinematic

Figure 6-2. Propriedades de Processamento
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Habilitar e Desabilitar Dados

Nas vistas, Tabela, Mapa ou Ocupagfes, use 0 menu pop ou 0
menu de Edicdo para incluir/excluir dados no processamento ou
no ajustamento.

« Selecione dados simples ou mdaltiplos, click-direito e depois
cligue no menu pop up Enable ou Disable.

« Selecione dados simples ou maltiplos, clique Edit » Enable
ou Edit » Disable.

» Selecione dados simples ou maltiplos, abra a caixa de
didlogo Properties, habilite/desabilite o parametro Enabled
na aba General. A caixa de didlogo Properties para alguns
tipos de dados somente habilite este parametro para o
ajustamento ou para o processamento e ajustamento.

Os dados desabilitados terdo a cor cinza em todas as vistas.

Processamento

A fungdo de processamento processa 0s vetores (Observagdes)
de acordo com os pardmetros informados e selecionados nos
painéis de Controle de Qualidade e Processamento da
Configuracdo da Obra. Veja “Definir Parametros de
Processamento e Ajustamento” na pag 6-1 para as propriedades
de definicdo do processamento.
Processar Todas as Observagdes GPS
Para processar os vetores da obra:
« cligue Process » GPS+ PostProcessing,
* pressione F7 do teclado, ou
« cligue no botdo GPS+ PostProcessing da barra de
ferramentas (Figura 6-3).
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|

Figure 6-3. Botdo de P6s-processamento GPS+

Processar Observacdes GPS Selecionadas

1. Selecione as observacdes desejadas na vista Mapa ou na
aba GPS Obs na vista Tabela.

Para selecionar as observagdes GPS com certos
paradmetros, use a caixa de dialogo Select GPS Obs (veja
“Selecionar Observagdes GPS” na pag 4-24 para
detalhes).

2. Naaba GPS Obs, click-direito sobre as observacdes
selecionadas e cliqgue GPS+ PostProcessing no menu
pop-up (Figura 6-4).

o° Poirts | g GRS Occupations | <, T50bs &3 GPS Obs |

Paint From | Paint To | Start Time | Duration
%MExport... 07... 0:10:15
» EYINN 22... 0:AD:00
o EYHNIN  C: ch g, 06115
o EERIN < CrHC iz, e
o CENEN  Doc bel 2. oas
@ BL3 Disable 09... 0:05:00
&, BL4 4., mi:1s
s GPS+ PostP)

Properties

Options. ..

Figure 6-4. Processar Observagdes GPS Selecionadas

Entender os Resultados

A janela Legend mostra e descreve 0s icones e cores usadas
para cada item de dados.

Na vista Mapa, os dados p6s-processados serdo mostrados
em linhas com verde brilhante. Figura 6-5 mostra o exemplo
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da Vista Mapa, antes e depois do processamento das
observacdes selecionadas.

Figure 6-5. Exemplo P6s-processamento na Vista Mapa

Na Vista Tabela, as informacGes processadas e ajustadas
serdo mostradas nas seguintes colunas:

* Precisdes horizontal e vertical da solucéo do vetor.

* Os valores de Observacdo GPS mostram os incrementos
do vetor na opc¢do de mostrar dados selecionados.

« Tipo de solucéo usado para os vetores. Fix (todas as
ambiguidades foram fixadas como inteiras) ou Float
(todas as ambiguidades estimadas s&o nimeros
flutuantes)

Figura 6-6 mostra o exemplo da Vista Tabela de antes e
depois do processamento de dados selecionados.

«° Points | g GPsoccupations | ¢ TSobs o GPS Obs | M, Tape Dimensions |
[ Start Time [ Duration [ mote Harizontal Precision (m) | Vertical Precision (m) | dn (r~
31[2003 1:07... 0:10:15

3/18/2003 1:22...  0:10:00
3/19/2003 1:38...  0:06:15
3/19/2003 1:12...  0:06:45
3/19/2003 1:21... D:04:15 Antes
3[19/2003 2:09...  0:05:00
3/21/20035 6:14...  0:11:15 i

aaaaaaa (my | de (m) | du () | Methoc ~
107, G S ) 0,003 5l038 14865 ER T
1:22.. o000 0.013 -88.415 15.006 1011 PR
138, 00615 ! 0.018 -88.420 15.018 -1.023 PP
112, 00645 - o007 0.013 -88.381 0.138 -0.900 PP
209, oS00 [
Gil4.. O:1:15 [
< >

Figure 6-6. Exemplo P6s-Processamento na Vista Tabela
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Ajustamento

O processo de ajustamento usa as coordenadas 3D fixas para
ajustar os vetores medidos.

Este ajustamento fornece as coordenadas em 3D dos pontos
levantados baseados no datum constantes da informacéao do
ponto de controle.

Antes de ajustar, realize o Pds-processamento GPS+ conforme
escrito no “Processamento” na pag 6-3.

2.

Tenha a certeza que a obra tem pontos de coordenadas. Se
necessario, importe um arquivo de coordenadas antes de
ajustar a rede. Veja “Importar Arquivos de Coordenadas” na
pag 3-3 para detalhes.

Para ajustar todos 0s vetores ou 0s vetores selecionados:
* clique Process » Adjustment,
* pressione F8 do telcado,

* ou clique no botdo Adjust Network da barra de
ferramentas (Figura 6-7).

=t
e

Figure 6-7. Botdo Ajustamento de Rede

Entender os Resultados

A janela Legend mostra e descreve 0s icones e cores usadas
para cada item de dados.

» Vetores Auto-rejeitados (blunders) sdo detectados
usando o nivel de confianca e o erro padrdo posterior da
unidade de peso. Um vetor com erro grosseiro é rejeitado
e 0 ajustamento livre se repete até que todos 0s vetores
com erros sejam rejeitados. Os vetores rejeitados ndo
serdo usados no ajustamento final.
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Para selecionar o nivel de confianca para o ajustamento,
clique Process » Process Properties e selecione a novo
valor. Clique OK para reajustar a rede.

 Os desvios padréo posteriores da unidade de peso sdo
calculados separadamente para coordenadas planas e
Alturas.

Os desvios padrdo dos pontos da rede ajustada sdo
mostrados na aba Points da Vista Tabela.

* Os residuos do Vetor da rede ajustada sao mostrados na
aba GPS Obs da Vista Tabela.

Figura 6-8 da pag 6-7 mostra o exemplo de antes e depois do
ajustamento.

Na Vista Mapa, 0s pontos ajustados sdo mostrados como
icone de circulo com uma linha equatorial.

Na Vista Tabela, as informacGes sdo mostradas nas seguintes
colunas:

* Desvios padrdo — os desvios do ponto, na unidade
selecionada, apds o ajustamento.

 Residuos — mostra os residuos do ajustamento para as
abas Obs ET e/ou Obs GPS.

Figure 6-8. Exemplo de Ajustamento
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Visualizar o Relatorio de Ajustamento

Apds o ajustamento de dados, o seu relatério fornece um
resumo dos ajustes realizados nos vetores medidos.

Clique Report » Adjustment (Figura 6-9) para ver o
relatdrio de ajustamento,

GPS Observations !

Paints

Quality Control

T3 Observations

Report Configuration F9

Figure 6-9. Ver Relatorio de Ajustamento

O Relatério de Ajustamento é aberto em janela separada e
mostra as informac0es referentes ao ajustamento. Veja
“Relatdrio de Ajustamento” na pag 8-2 para detalhes.

» Para salvar o relatdrio como arquivo, clique no botéo
Save As. Informe o local e 0 nome do relatdrio e clique
Save.

« Para copiar o relatério no editor de texto como
Microsoft® Word ou Outlook Express, clique Select All
e depois no botdo Copy. Abra a aplicacdo desejada e
clique paste.

* Para imprimir o relatério, clique no botéo Print.

Desabilitar Auto-Rejeicao

Por default, o parametro AutoReject esta habilitado para o
pOs-processamento e ajustamento de dados.

1. Paradesabilitar o parametro AutoReject, selecione as
observacg0es desejadas e entéo:
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* Click-direito na aba GPS Obs e clique Properties no
menu pop-up para as observacdes GPS.

* Click-direito no painel direio da aba TS Obs e clique
Properties no menu pop-up para as observacdes ET.

Caso selecione as ambas observagoes, a caixa de didlogo
Properties para ou ambos tipos observagdes sera
mostrada.

2. Naaba Adjustment, selecione Not Allowed da lista de
AutoReject (Figura 6-20).

+ Properties : TS Obs 1.1-2.2

General | Observation | Offset |
Adjustment | Quality Control |
AutoReject [Mot allowed -

Adjustment Status Mot Adjusted
Zhngle Residual |
SDist Residual (m) |

Figure 6-10. Desabilitar AutoReject
3. Clique OK para salvar as defini¢des para as observagoes
selecionadas.
Método de Ajustamento do Topcon Tools

Topcon Tools usa 0 método dos Minimos Quadrados para
ajustar a rede.

O método dos minimos quadrados requer mais esfor¢os
computacionais que um ajustamento aproximado,
fornecendo o ajustamento mais preciso possivel, na qual:

 Permite variacdo nas precisdes das observacoes.

» Minimize variacdes aleatorias nas observacoes.
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 Fornece a melhor posicéo estimada para as estagdes da
rede.

« Estatisticas de rendimento relativas a acuracia do
ajustamento e posigdes.

Para editar as propriedades do ajustamento, veja “Definicdo
das Propriedades do Processamento e do Ajustamento” na
pag 6-1.

Mdédulo Ajustamento Livre

O mddulo de ajustamento livre segue 0s passos do processo
de ajustamento. As fun¢des do modulo fornecem a
estimativa da qualidade do vetor a longo da deteccdo do erro
grosseiro e rejeicao.

O ajustamento livre é realizado nas coordenadas
topocéntricas retangulares ENZ do ponto inicial na seguinte
ordem:

1. Equaces normais sdo construidas e solucionadas.

2. Os erros padrdes posteriores da unidade de peso sdo
calculados separadamente para as coordenadas planas
3D e alturas.

3. Erros grosseiros sdo detectados usando o nivel de
confianga e os erros padrdes posteriores da unidade de
peso.

4. O vetor de maior erro é rejeitado e 0s passo 2 até 4 sdo
repetidos até que todos 0s erros grosseiros sejam
rejeitados.

5. Os vetores rejeitados ndo serdo usados no ajustamento
final.
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Localizagcéo

Localizacdo envolve a comparacdo das coordenadas locais da
obra com o sistema de referencia global.

Um sistema GPS+ disp8e de posicionamento preciso, mas as
posi¢Bes computadas sdo relativas ao sistema de referencia
global definidos em termos de latitude, longitude e altitude
geografica sobre a superficie terrestre. Para ser (til a obra, as
coordenadas globais GPS precisam ser convertidas as
coordenadas locais, definidas em termos de distancias Norte e
Este, referenciadas a algum ponto de origem e alguma distancia
acima da elevacdo do datum. Estas coordenadas, norte, este e
altitude, abreviadas de NEZ, podem ser sistema de coordenadas
regionais, por exemplo, um sistema cartografico brasileiro, ou
sistema arbitrério definido especificamente para um local. As
coordenadas NEZ devem ser definidas em termos de dados do
projeto de construcdo. Caso contrario, € necessaria uma
conversdao matematica para transformar coordenadas globais
GPS as coordenadas NEZ definidas localmente. A aproximacéo
béasica para calcular a conversdo matematica é a existéncia de
pares de coordenadas para cada Ponto de Controle do projeto.
Um par de coordenadas consiste de:

 Coordenadas locais NEZ para o ponto (arbitrarias) e
 Coordenadas latitude, longitude e altitude para o ponto.

Estes pares de coordenadas sdo necessarias na definicdo da
formula de conversdo matematica precisa, objetivando converter
todas as coordenadas globais GPS as coordenadas locais NEZ de
uma determinada obra.

A seguinte lista fornece um guia de Pontos de Controle para
assegurar a localizacdo de alta qualidade:

 Os Pontos de Controle devem ser medidos com precisdo. A
qualidade das medicdes afeta diretamente a acurécia.

« Os Pontos de Controle devem estar posicionados de forma a
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cobrir toda a area. Geralmente, quanto mais Pontos de
Controle, melhor seré a solugdo, porém se 0s tais pontos
estiverem agrupados ou se estiverem em uma parte da area,
os resultados da Localiza¢do ndo serdo ideais.

» Uma boa regra é posicionar os Pontos de Controle
distribuidos ao longo do perimetro da &rea. Ainda que ndo
estejam diretamente ligados a qualidade da Localizacéo, os
Pontos de Controle devem estar em pontos elevados, de facil
acesso e nao obstruidos por arvores, edificacbes, veiculos e
outras estruturas.

* Localizagcdo GPS necessita, no minimo 3 Pontos de
Controle, mas se recomenda utilizar 4 ou mais pontos.

@ AVISO

Importar um arquivo de coordenadas antes da
Localizagéo

Para localizar as coordenadas globais as coordenadas locais,
primeiro importe um arquivo de coordenadas locais ao arquivo
de obra e depois, importe o arquivo de pontos desejados. Caso
esteja importando o arquivo de obra TopSURV™ com a
Localizacdo pré-calculada, Topcon Tools importara também os
parametros de Localizagao.

1. Paraimportar um arquivo de controle, clique File » Import.
Na caixa de dialogo Import, navegue e selecione o arquivo
de coordenadas WGS84 desejado e entdo, clique Open
(Figura 6-11).

- STTT— | =&l
[e]

e,

Figure 6-11. Importar Arquivo de Coordenadas
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As Vistas Mapa e Tabela mostram as informagdes do
arquivo de coordenadas.

2. Clique Process » Localization ou pressione Shift+F8 para
abrir a caixa de didlogo Localization. Clique Add Point
(Figura 6-12).

% Localization

WGS Point | Local Point Use [ mDx r—
oY
Angle
Scale
HO
H
HY
Add Poirt Q —————
LonD)
FakeNothing [

Pt Exiig

T feep Soale TG
Add Foint Remove Faint

Figure 6-12. Adicionar Pontos para Localizagéo

3. Da lista WGS Point, selecione os pontos desejados a serem
incluidos na Local;izacéo (Figura 6-13).

4. Clique na coluna Local Point e selecione da lista os pontos
correspondentes (Figura 6-13).

5. Clique na coluna Use e selecione o tipo de ponto a ser usado
(Figura 6-13).

WGS Point Local Foint Use n DX

/

I

I

I

I

I

I

I

| [

Us(lono

WG Point | Lon [ N\,
5000 - alse Morthing [ T

| Local Poink:
=
S126 # [ |falze Easting Use [
EE:gTA_B_LVK 2 g}g; Hatizantal and Vertical =
CHIKPTL b Foint ‘ AP _STA_B_LVK
CHEPTZ EL1
BL2
Pz @ W [Horizontal and Vertical €
P4 BL4
CPS ELS
CPG ELo
CPT BLY e’
CPS bt

Figure 6-13. Selecionar WGS, Ponto Local e Utilizacao
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6. Clique Add Point e repitas os passo de 3 a 5 até adicionar
todos op pontos desejados na tabela de Localizacéo.

7. Clique Compute parameters para localizar as coordenadas
GPS (Figura 6-14). Para assegurar uma escala em um dos
calculos de Localizacéo, habilite Keep Scale 1.000 antes do
calculo da localizacéo.

* As colunas de residuos North, East e Height no painel
esquerdo, mostra os valores compostos apos a
Localizacdo..

* A painel direito mostra os parametros de localizagdo para
Pontos Local e WGS informados.

¥ Localization

WSS Point | Local Poine | Lise: | nDX |B23324.3732
A CP3 BL3 Horizontal and ... (nh'g |1883340. 2097
A Pz BLZ Horizontal and .. Ande [359°59%58 4052
A CP4 EL4 Horizontal and ...
& CP5 BLS Horizonkal and .. Scale [1.0000160153
& CPE BLE Horizontal and ... HO ‘5_5553
F:y
Ccpra BLE Horizontal and .. bt [0 00007 76968
& Cp7 EL7 Horizontal and ...
HY |-0.0000002564
Lat0 |37 3928 31762
Lond [121°4920.06132w
Compute p
‘ Falze Northing |0.0000
False Easting \U.UUUU
= KeepScale 1000
Add Point | Remove Point Compute parameters Close

Figure 6-14. Localized Coordinate Points

Apos calcular a Localizaco, estes parametros serdo usados
para transformar as coordenadas WGS em coordenadas
Locais e vice-versa.
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As vistas Mapa e Tabela serdo atualizadas com as

coordenadas locais. Figura 6-15 mostra antes e depois da
localizagdo.
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* o points | o o3 ocometions | 4 T3] oB®
N 7 I S S AR
. B 2y L2AME2 W LZIMFI00W  Longhude
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Figure 6-15. Vistas Mapa e Tabela Antes e Depois da Localizagéo
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Capitulo 7

Controle de Qualidade

As definigdes de Controle de Qualidade fornecem melhorias no
controle sobre as precisdes usadas e testes automaticos
realizados na obra Topcon Tools.

As fungdes de fechamento somam todos os vetores de
fechamento para obter um resultado de residuo do vetor préximo
a zero. As defini¢des do Controle de Qualidade ajudma a
identificar as falhas nos fechamentos.

Os ambos os resultados, Controle de Qualidade e de Fechamento
podem ser vistos nos relatérios para a analise adicional.

Definicdo do Controle de Qualidade

As definigdes do controle de Qualidade se encontram na caixa de
dialogo Job Configuration. Clique Job » Job configuration ou
pressione Ctrl+F2, entdo clique Quality Control no menu
arvore do painel esquerdo.

O item Controle de Qualidade tem duas abas no painel direito da
caixa de didlogo Job Configuration:

A aba Precisions define os parametros de precisdo das
observagGes com erros. (Figure 7-1 da pag 7-2).

As observagOes que ndo atendem os parametros do Controle
de Qualidade serdo destacadas em vermelho nas vistas Mapa
e Tabela, bem como no Relatério.
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2| Job configuration E‘El

Display Precisions I Automatic Tests |

Esi:ﬂi”ata Systenms T5 Distance Precision oz
T3 Wi Precision [sec | o
TS Ha Precision [sec.] ’Wi
RTEK. Horizantal Precision luuzi
RTK Vertical Precision foos
PP Static: Horizontal Precision ’Wi
PP Static Vertical Precision ,UUSi
PP Kinemalic: Horizontal Precision ooz
FP Kinematic: Yertical Precision lﬂﬂﬁi

Save configuration| List configurations

=N
[ |

Figure 7-1. Configuragcédo da Obra — Controle de Qualidade

» A aba Automatic Tests define as solugdes, precisdes, desvios,
pontos, ocupacdes e pontos sem nomes do Autotopo a serem
incluidos no relatério do Controle de Qualidade (Figura 7-2).

22 Job configuration @
Display Precisions  Automatic Tests ]
Coordinate Systems W Wain Float salutions
e ¥ PP Static Precisions
Save

Dualty Control ¥ PP Kinematic Precisions

Process ¥ Point Standard Deviations
W Identical Points
v Misnamed GPS Occupations
[~ Misnarmed Autotopo Fiovers

Save configuration| List configurations

| Ok Cancel

Figure 7-2. Configuracdo da Obra — Aba do Teste Automatico

Visualizar Relatério do Controle de
Qualidade

Apbs ajustar os dados no Topcon Tools, o relatério do controle
de qualidade fornece um resumo das precisoes e do teste
automatico.
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Clique Report » Quality Control (Figura 7-3) par aver o
Relatdrio do Controle de Qualidade.

Adjustment
GPS Observations
Paints

T3 Observations k

Report Configuration F2

Figure 7-3. View Quality Control Report

O Quality Control Report se abre em janela separada e mostra as
informac6es do ajustamento. Veja “Relatorio do Controle de
Qualidade” na pag 8-6 para detalhes.

« Para salvar o relatério como arquivo, clique no botdo Save
As. Informe a pasta destino e 0 nome e clique Save.

« Para copiar o relatérioa um editor de texto como Microsoft®
Word ou Outlook Express, clique Select All e entdo no botéo
Copy. Abra a aplicagdo desejada e clique paste para colar as
infoemacdes.

* Para imprimir o relatorio, clique no botéo Print.

Processar Fechamentos e Visualizar o
Relatorio

Os fechamentos utilizam as observacgdes (vetores) que formam
um fechamento para obter um resultado de residuo de vetor
préximo de zero. Este residuo é comparado com o valor limite
(computado com base na Configuracdo da Obra-Definicdo de
Precisfes). Caso o residuo seja maior que o limite, o fechamento
é suspeito (provavelmente contém observacdes ruins) e sera
mostrado como falha.

O Loop Closure Report mostra as seguintes informacoes
referente as observacdes estaticas GPS:
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» Fechamento — as observagdes que formam um fechamento

» ObservacBes GPS no formato de vista selecionado — mostra
o0s incrementos do vetor na op¢édo de display selecionado,
apos tes sido processado em Norte, Este e Altitude.

 Tolerancia Horz e Vert (m) — as tolerancias usadas durante o
processamento e definidas na Configuragéo da Obra.

» Comprimento (m) — o perimetro de fechamento.

* Erro de Fechamento, PPM — a acurécia do fechamento em
partes por milh&o.

1. Para gerar relatdrio de fechamento, clique Process » Loop
closures (Figura 7-4).

GPS+ PostProcessing F7
Adjustment Fa
Localization Shift+Fa

Process Properties

Figure 7-4. Ver Relatério de Fechamento

2. Natela principal (vistas Mapa ou Tabela) selecione a
observacéo estatica GPS que forma o fechamento.

3. Clique Finish na caixa de dialogo Loop closures para
mostrar o relatério de Fechamento (Figura 7-5).

Loop Closures
dHim | dEm) | dHzgm) | dUgml | Horz Tolance

ﬁ Loop Closures @

Select static GPS observations that form
a |oop. Press Finish when vou are done,
and loop closure report will be displayed

T h Corcal |

Figure 7-5. Clique Finish para Ver o Relatorio de Fechamento
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O Loop Closures Report abre uma janela separada e mostra
as informac0es referentes ao ajustamento.

« Para salvar o relatério como arquivo, cligue no botéo
Save As. Informe a pasta destino e o nome e clique
Save.

« Para copiar o relatérioa um editor de texto como
Microsoft® Word ou Outlook Express, clique Select All
e entdo no botdo Copy. Abra a aplicacao desejada e
cligue paste para colar as infoemacdes.

 Para imprimir o relatério, clique no botdo Print.
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Relatorio e Exportacao

Topcon Tools processa os relatorios baseados nas informagdes
desejadas e nos pardmetros de visualizacdo do resumo de dados.

Além dos relatdrios, Topcon Tools suporta varios formatos para
exportacdo de dados para serem usados em outros programas e
instrumentos.

Relatério Padrao

Relatdrios fornecem um modo de visualizagdo de dados offline,
ou rastrear os dados através de mudancas quando a versao do
relatério esta salva no computador. Relatdrios também fornecem
um rapido resumo das informacdes em formato relativamente
compacto.

As seguintes secdes descrevem o relatério padrédo e seu item de
relatério inicial. Veja “Personalizar Relatérios” na pag 8-9 para
modificar as informacdes do relatério.

« Para salvar o relatério como arquivo, clique no botdo Save
As. Informe a pasta destino e 0 nome e clique Save.

« Para copiar o relatérioa um editor de texto como Microsoft®
Word ou Outlook Express, clique Select All e entdo no botéo
Copy. Abra a aplicacdo desejada e clique paste para colar as
infoemacdes.

* Para imprimir o relatério, clique no botéo Print.
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Relatorio de Ajustamento

Para ver o relat6rio do resumo de ajustamento, clique
Report » Adjustment (Figura 8-1).

GRS Ohservations !

Points

Cuality Control

T5 Observations

Reeport Configuration F9
riyuie o-.1.

Figure 8-1. Ver Relatorio de Ajustamento

O relatdrio de ajustamento padrdo tem 0s seguintes campos
para informacdes aplicaveis.(Figura 8-2 da pag 8-3):

e Resumo da Obra

Resumo do Ajustamento
» Observacdes GPS Usadas

 Residuos das Observacdes GPS

Pontos de Controle

Pontos Ajustados
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B Bl b
B s
km.‘.:&w-la
&
Frojeot Surmary
Frogsetname: London Placs tp
Susamin,
el
Lmzarunt: Meters
Frgaiton SPCHT-Alghn Done 100
Gooid
Adjustment Summany
Acprdmen b= Minimal conggrant
o dence sl 96
A postenon standend emor of o reighi 1384947
Bhseher of sdurned poimsy 3
Humber of plang ontrol ponis: 41
Ryz=laay of hai gt e poins 1
Totdl mumbser of waclors §
Haumber of uzedectors §
hsedsr of reg il vy 2
Used GPS Obpereasons
Hame SeluiennType | dnjm} | de(m) dulm) Distanesm) | Heelzantol Prestsion(m] | Vestieal Fresision )
gl _SE5E0_S0ME0 Froz ARG | 05 058 | g e 0007
meslis_JBGG60 ARG Frea 4151 | 2568 1047 | L1 10M QU7
mare_EBCG-e2_EHOS Fies() 4826 | 0878 | 02 M3 .00 00
Al fAehs A5G Fresd 554 1414 11 23 1.0 i
=il el SHOG Fios 0oz | gat | A0 | L] 1 02
1 _A160ad GHDG Fioz( R I L i) 000 0.0
5 Dogaryaton Rezicuals
Hame Resniml  Reseim]  Resujsi

-0 i [l anid

y —
sl
Certral Peinls
| Hame | GndNodhingim| | GridEasngim) | Elevaten(m  Code
[ sosoen | moemsmian: | aeedmasy | imamr
Adjusted Poits
Hame: Grd Nadhing (m| | GridBasting |m) | Mlewaicn (m)  $ode
macher_BEGG TOE519,750 -3068400,230 ERE Come |
31_4160 TOEAS19,ET2 30640, 104 152,072
: 51_3HDE J06I522,774 -3062Ad 126 1z

Figure 8-2. Relatério Impresso do Resumo do Ajustamento
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Relatorio das Observacbes GPS

Para ver o relatorio das observacdes GPS, clique
Report » GPS Observations.

Adjustment

Points . k

Quality Control
T3 Cbservations
Report Configuration F9

Figure 8-3. Ver Relatério de Observacfes GPS

O relatorio das observagdes GPS tem os seguintes campos
que inclui as informacgoes aplicaveisThe default GPS
Observations report has the following fields that include
applicable information (Figura 8-4):

¢ Resumo da Obra

 Observagbes GPS

8-4

Project Summary

me Londen Placetp

I Meters.

GPS Obs Report
Hame SolutionType  dnfm) de(m) du(m)  Distance(m) | Horizontsl Precision (m)  Vertical Precision (m)

Figure 8-4. Relatério Obs GPS
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Relatério de Pontos

Para ver o relatério de pontos, clique Report » Points
(Figura 8-5).

Adjustment
GRS Observations

Quality Control [ g

T3 Cbservations
Report Configuration F9

Figure 8-5. Ver Relatorio de Pontos

O relatorio padréo de Pontos tem as seguintes informagdes
que inclui as informagdes aplicaveis. (Figura 8-6):

* Resumo da Obra

* Pontos
File Edit Help
4 B b a
Savefs.. Selectsl Copy Print
TOPCON

Project Summary

Project name: London Place.ttp
Surveyor,

Comment:

Linear unit. Meters

Projection: SPC83-Alaska (Zone 10)

Geoid:
Points
Name Grid Northing (m) | Grid Easting (m) Elevation {m) Code |
master_SBGG | 7085519,750 | -3068440,230 153,819 Dome l
s0_30W0O . 7065521,302 i -3065444,853 : 153,272 I .
51_4160 7065519,273 . -3063445,104 152,073
SQ;BHDS 7065522774 . -3068444,126 . 152,122

Figure 8-6. Relatério de Pontos
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Relatério de Controle de Qualidade

Para ver o relatorio do Controle de Qualidade, clique
Report » Quality Control (Figura 8-7).

Adjustment
GRS Observations
Paints

Quality Contral
T3 Observations
Report Configuration F9

Figure 8-7. Ver Relatério de Controle de Qualidade

O relatorio padrdo do Controle de Qualidade tem os
seguintes campos que incluem as informagoes aplicaveis
(Figura 8-8):

* Resumo da Obra
 Qualidade das Obs GPS

* Qualidade das Obs RTK

» Fechamentos

* Obs GPS Auto-Rejeitadas

 Qualidade dos Pontos Ajustados
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&

Project Summary

Progact name: London Placep
Created by

[
Lirsar il Meters
GPS Obs Quality
master_BBGG-50_BOWD | 04.08.01 130358 0,005 0,007 Finisd
mastar_t8GG-51_4160 04.09.01 130358 0.004 0.007 Fied
rastor_SBGG-52 SHDS | 040001130358 0,003 0,004 Froed
50_B0WILE1_d160 040001130358 0,003 0,004 Fixed
S0_B0WIks3_8HDS 04.09.01 130558 0.001 0003 Fied
s1_4160es2_8HDS 04.08.01 150558 0,005 0,008 Fuoed

RTK Obs Quality

Loop Closures

| 50_B0W0-82_8HDS(04 0901 130358) |
SO BOWD.ST 416004 0901 130358) | 00261 | 00027 | 00282 | 00875 00345 00856
S1_4160-52_BHDS(04.08 01 13:03.58)

1418052 BHDS | 040001130358 | 0006 | 0010 opsz |

Adjusted Paint Quality

mastar_SBGG TO5519,750 -3068440, 230 153819
=0_80wW0 TO65521,302 -3068444 653 153,272
51_4180 T065519.273 3065445104 152073
52_BHDS TOB5522,774 3068444 126 152122

Figure 8-8. Relatdrio de Controle de Qualidade
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Relatério de Observacbes ET

Para ver o relatorio das Observagfes GPS, clique
Report » TS Observations (Figura 8-9).

Adjustrent
GRS Observations
Paints

GQuality Contral

Figure 8-9. Ver Relatério das Observacdes ET

O relatério padrdo das ObservacGes ET tem o0s seguintes
campos com as informaces aplicaveis (Figura 8-10):

* Resumo da Obra

» Observacbes ETs

Prajact Susmary

Frafect nams: Londan Placelip

ST

Commen

Lisar unt Maters.

Angde st DMS.

Frepocton 5P Cik-Aiagkn Zane 164

TS Observations

v | Wrttramert Husght m) | Reectar Hight () Hornoreal Cireta | Zonkn Arire | StopeDistanea =) | Cods | Type
11 1,520 1500 EIXEI6 0000 BTG 0000 4502 BE
12 1520 1600 BZ2E16.0000 AT 0000 4508 BS
13 1,520 1600 PG T 0000 712350000 4,550 55
14 1,520 1,800 TN T 0000 71247 0000 4,958 S5
15 1,520 A 500 0170222000 TE 197020000 3448 S5
16 1,520 1600 14274356 0000 655422 0000 FA4E 55
17 1,520 1600 12004°21 0000 47540 D000 6,033 55
18 1,520 1,600 21722033 0000 80011250000 3z 55
0 1,508 01 OO 250000 04720410000 EAT STAT BE
m2 1,508 a0 15570422 0000 BN 0000 36730 ) 55
w3 1,508 2017 2560256 0000 BN D000 105 490 ] 55
" 1300 2017 FET 190000 0 15°34 0000 105 420 STAT B=
1 1,300 aam 1565514 0000 S0 0000 112750 n 55
124 P P 1435 24T 14170354 0000 LT3R 0000 122750 il BS
122 Pi P3 1835 2017 IS 0000 00°36°15 D000 44290 e 55
133 F1 P2 1.581 2017 4T1E M 0000 BEIRE 000D 247500 e B=
122 Pa Pa 1531 2017 1175407 0000 BIEIAT D000 131 oo 4 S5
i P4 PE 1,560 2077 AT 100000 B 51450000 181 2 BS
2 P4 5T 1,560 2077 153"25'10 0000 S5 0000 I 55
W3 Fa AT 1.5:0 2077 2374745 0000 2250000 3,750 55
21 -0 | MERK 1850 1,000 1423316 0000 AT W51 0000 4558 B=
21 ST MERH 1850 1,600 1423216 0000 AT W51 0000 4250 BE
23 ST ST 140 1,000 T4 SO0 AGI 00 p0) 3780 S5
24 ST 512 1850 1,600 TAT0T 50000 1001003 D000 e 55
25 M 5 1.8:0 1600 1970500 0000 84733701 0000 11267 S5

Figure 8-10. Relat6rio Observagfes ET
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Relatérios Personalizados

A personalizacédo de relatdrios permite incluir ou excluir certas
informacOes dos relatérios gerados.

Para configurar o relatério personalizado, clique
Report » Report Confiauration (Fiaura 8-11).

Adjustment

GRS Observations

Paints

GQuality Contral

T3 Cbservations

Report Configuration F9

Figure 8-11. View Report Configuration

A caixa de dialogo Report Configuration fornece um conjunto
de ferramentas para visualizar os reportes impressos. (Figura 8-
12).

« O campo Reports mostra o relatdrio atual. Clique sobre um
relatério para mostrar os itens.

* O botdo New report cria um novo relatério. Veja “Criar
Nova Configuracdo de Relatério” para detalhescreates a new
report.

* O botdo Delete report exclui o relatorio selecionado.

» O botdo Copy report as copia o relatério selecionado. Use
este botdo para copiar um relatério a ser modificado, sem
excluir o relatorio original.

» O botdo Execute abre o relatorio selecionado no arquivo de
obra, mostrando a tela de relatdrios.

* O campo Available report items mostra os itens que podem
ser incluidos no relatorio.

« O campo Included report items mostra os itns incluidos no
relatorio.
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* Os botdes de movimento esquerda (<<), direita (>>), Move
Up, e Move Down manupula o posicionamento, os itens
incluidos e a ordem dos itens do relatorio.

O mesmo item (por exemplo, com op¢oes diferentes) pode ser
incluido no mesmo relatério para mostrar as informag@es para
dados nos grupos personalizados. Usando o botdo Options (veja
“Editar Opcdo de Itens” para detalhes), 0 nome de quase todos os
itens do relatério pode ser modificado. Quando se modifica o
item nome na lista Included report items do lado direito, somente
0 nome sera modificado, o novo item néo sera adicionado. O
item ainda corresponde ao nome do item anterior da lista
Available report items do lado esquerdo.

I8 Report Configuration

RIX]

Re

[&] TS Observations
@ GP3S Observations
@ Paints
@ GQuality Contral
Mew report Delete report ‘ Copy report a3 ... Execute ‘

Available report iterms:

Topcon Logo ltem

|dentical Points Feport
Miznamed Autotopo Rovers Rep
Fepeated Obzervations Report
Froject Report

Paint Summary Report

GPS Obs Report

-

Included report items:

Topcon Logo ltem
Project Summary

[ oo |

| —

Adjustment Summary

Uszed GPS Observations
GPS Observation Residualz
Contral Paints

| Adjusted Points

o |

LTS
|

Cloze

Figure 8-12. Caixa de Didlogo da Configuracéo do Relatério

Para gerar um relatorio, selecione o relatério na caixa de dialogo
Report Configuration e clique Execute. Os relatérios
personalizados também aparecem no menu de Relatério.
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$ DICA

Personalize o botdo da barra de ferramentas para
carregar rapidamente o relatorio freqientemente
usado. Veja “Personalizando a Barra de
Ferramentas” da pag 4-32 para detalhes.

Editar Configuracdo do Relatorio

Os relatdrios e os seus contetddos podem ser editados para
fornecer somente as informacgGes desejadas.

Copiar um Relatorio

1. Selecione o relatério desejado no painel de
Relatorios e clique Copy report as. Uma
configuragdo com os mesmos itens do original sera
adicionado na Janela Reports (Figura 8-13).

) Report Configuration

Figure 8-13. Copiar Relatério Selecionado

2. Renomeie a configuragdo. Se necessario, click-
pausa-click no nome da configuracdo para ativar o
editor de nomeacao.

3. Para adicionar itens, destaque os itens a serem
incluidos na coluna esquerda e clique no botdo (>>)
para mover a direita (Figura 8-14).
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4. Para remover itens, destaque os itens a serem
removidos na coluna da direita e clique no botdo
(<<) para mover a esquerda (Figura 8-14).

5. Use os botdes Move Up e Move Down para ordenar
os itens incluidos (Figura 8-14).

Incluir

Remove

Ordena

Available repart items:

Top e
|denlical Points Renort
Misnamed Auiolopo Rovers Fep
Flepeated Observations Riepart
Fioject Report

Paint Summary Repart

GPS Obs Report ]

Included repart items:

Topcon Loga ltem
bod k Project Fepart

Paint Summary Report
Repeated Observations

Optians

—

Closa

[ ]

B
Lot

Awailable report items:

Foirt Summary Report
GPS Obs Report
diustment Report

TS Obs Report

Laop Clasures
Misnamed GP5 Decupations Fie %

Included report items:

2

Topcon Logo Item
Mave Up
GPS 0

GPS Obs Report
Loop Closures
Froject Repart

Optians

Optians

Close. |

Move Down

Awvallable report tems

Misnamed Autotopo Rovers Rep
Repeated Observations Repoart
Praject Report

Pairt Summary Frepon

GPS Obs Repart -]

Included report items

Topeon Logo ltem
s Project Report
R

epeated Observations
eport

Foint Summary Report
Identical Points Report

Optians

<«
Options

Mave Up

Cloge ‘

Figure 8-14. Editar Itens da Coluna

6. Clique Execute para ver o relatorio ou clique Done
para salvar a configuracéo.

Editar Itens do Relatério Selecionado
1. Selecione o relatério desejado no painel Relatorios.

2. Para adicionar itens, destaque os itens a serem
incluidos na coluna esquerda e cligue no botdo (>>)
para mover a direita (Figura 8-14).

4. Para remover itens, destaque os itens a serem
removidos na coluna da direita e clique no botdo
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(<<) para mover a esquerda (Figura 8-14).

5. Use os botdes Move Up e Move Down para ordenar
os itens incluidos (Figura 8-14).

6. Clique Execute para ver o relatério ou clique Done
para salvar a configuracéo.

Editar Opc¢des do Iltem

Modificando as opgdes da lista Included report items
localizado a direita, tera efeito somente no relatério
selecionado atualmente.

Modificando as opcdes da lista Available report items
localizado a esquerda, tera efeito nas opcBes padrdes
incluidas com este item e sera aplicada aos novos
relatorios. O relatorio atual ndo sera afetada, ao menos
gue seja efetuada modificagbes manuais.

Selecione uma configuragéo no painel Reports, clique no
item desejado em ambas as colunas e clique no botéo
ativado de Options.

Dependendo do item selecionado, a caixa de dialogo
Options mostra os diferentes parametros do item.

« ldentical Points Report — edite 0 nome e clique OK
(Figura 8-15).

:ﬂ Options

Figure 8-15. Item Options — Relatdrio de Pontos Idénticos

» Misnamed Autotopo Rovers Report — edite 0 nome e
clique OK (Figura 8-15).
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Figure 8-16. Item Options — Relatério de Pontos Autotopo sem Nome

* Repeated Observations — edite 0 nome e selecione o
tipo de relatério para o vetor, entdo cliqgue OK
(Figura 8-15).

Mame

Fieport Type
+ Al vectars
" GPS vectars only
" TS5 vectars only

(] 8 | Cancel ‘ ‘

Figure 8-17. Opc¢éao Item— Observagdes Repetidas

* Project Report — edite 0 nome, digite 0 modelo da
mesma maneira como é mostrado na tela ou exclua o
modelo, entdo clique OK (Figura 8-18).

&4 Options @
Namme [Froject B epor

Project name: %PROJECT NAMEZ:
Project folder: %PROJECT FOLDERX
Creation time: %PROJECT CREATION
TIMEZ

Created by: %PROJECT SURVEYOR
Comment: %PROJECT COMMENT %

Linear unit: ZLINEAR UNIT?%
Angular unit ZaMGULAR UNIT
. Projection: PROJECTION?:
Praiect Template |0 b i DATUM

Geoid: 2GEQIDZ:

(] 8 | Cancel

Figure 8-18. Opgdes Item— Relatério de Projeto
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 Point Summary Report — edite 0 nome, selecione os
parametros para incluir e excluir usando os botdes de
movimentos direito/esquerdo, ordene os parametros
usando os botdes de movimentos para cima/para
baixo, habilite o tipo de pontos para ser aplicado nos
parametros e clique OK (Figura 8-19).

:ﬁ Options @g‘
Mse oint G ummiary Fiepor
Selected columrs
Gnid Morthing ~ LatitudetNorthing
Grid E asting LongitudehE asting
Elevation Ell height\Elewation
Latitude il Caode Move Up
Longitude
Ell Height
Elevation (D atum)
WE584 Latitude
WiE584 Longitude
/G584 Ell Height
Ground Morthing AN Move Down
Ground E asting
Contral b
Select
@Al
 Adjusted
" Contral
ok Cancel

Figure 8-19. Opc¢éao Item— Relatério Resumo do Ponto

* GPS Obs Report — edite 0 nome, selecione 0s
parametros para incluir/excluir usando os botdes de
movimentos direito/esquerdo, ordene os parametros
usando os botdes de movimentos para cima/para
baixo, habilite o tipo de pontos para ser aplicado nos
parametros, selecione o método usado para 0s pontos
para aplicar nos parametros e clique OK
(Figura 8-20).
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Selected columns

dx ~

Name [GPS Obs Repor

Azimuth —
Elervation Angle
Distance
Huorizontal Prec
Wertical Precisic

Resx
Res' v

Select
[ Potential
¥ PostProcessed
[ Adjusted
[~ Auto-Rejected
[~ Disabled from Adjustment
Method

[~ RTK Topo

[~ RTK AutoTopo
¥ PP Static

v PP Stop-and-Go
[~ PP Kinematic

Mave Up

Move Down

Cancel

Figure 8-20. Opgéao Item— Relatério de Obs GPS
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* Adjustment Report — edite 0 nome, o tipo de modelo,
digite 0 nome do modelo dos itens da mesma
maneira como aparece na tela ou exclua os itens e
cliqgue OK (Figura 8-21).

MNarne [justment B epor

Adiustrment type: ZADJUSTMENT TYPEZ
Corfidence level: ZCOMFIDENCE LEVELZ %
& posterion standard emror of unit weight for free
adjustment: %4 POSTERIORI STANDARD
ERROR OF UNIT WEIGHT FOR FREE
ADJUSTMENT

& posterion standard emror of unit weight: %4
POSTERIORI STANDARD ERROR OF UNIT
WEIGHT %

Mumber of adjusted points: ¥MUMEBER OF
ADJUSTED POINTS %

Mumber of height control points: %MUMBER OF
HEIGHT CONTROL POINTS

Mumber of plane control paints: XNUMBER OF
FLANE CONTROL POINTS

Total number of vectors: 2TOTAL NUMEER OF
WECTORS %

Mumber of used vectors: 2MUMBER OF USED

ok | Cancel

Figure 8-21. Opgao Item— Relatorio de Ajustamento

Adjustment Template

* TS Obs Report — edite 0 nome, selecione os
parametros para incluir/excluir usando os botdes de
movimentos direito/esquerdo, ordene os parametros
usando os botdes de movimentos para cima/para
baixo e clique OK (Figura 8-22).

%4 Options E]@

MName

Selected columns

“ertical Angle Paint From
‘ertical Distance Paint To
Horizantal Digtane: Instrument Height
AzimLith 2 | Fieflector Height Move Up
Date Horizontal Circle
Mate Zenith Angle
Slope Digtance
Code
Type

Maove Down

d

ok | Cancel |

Figure 8-22. Opcéao Item — Relatério de Obs ET
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* Loop Closures — edite 0 nome, selecione 0s
fechamentos para o relatorio e clique OK (Figura 8-
23).

Report Loops

Al
* Failed

(] 8 | Cancel ‘ ‘

Figure 8-23. Opcgéao Item — Fechamentos

» Misnamed GPS Occupations Report — edite 0 nome
e cligue OK (Figura 8-24).

Figure 8-24. Iltem Options — Relatério Ocupagdes GPS sem Nome
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Criar Nova Configuracao de Relatorio

1. Na caixa de didlogo Report Configuration, cliqgue New
report. Um relatério com o0 nome “User report” aparece
na janela Reports (Figura 8-25).

M Report Configuration

Dimtete report |

Copy 1w ay |

bt tegn rema

Figure 8-25. Criar Novo Relatério

Selecione o item desejado da lista Available report items

e clique no botdo (>>) para mover o item na lista
Included report items. Continue selecionando e
movendo 0s itens até que todos 0s itens sejam incluidos

(Figura 8-26).

Avvailable report itemes;

=00
[ po

Fepeated Observations Report

Project Report

Point Summary Report

GPS Obs Report

Ihcluded report items:

Topcon Logo [tem
Project Repart

Options

Point Summary Fepart
Fepeated Observations

A
oo |

Figure 8-26. Incluséo de Itens no Relatério
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3. Selecione os itens e clique nos botdes Move Up e Move
Down para definir a ordem dos itens incluidos na lista
(Figura 8-27).

Available report iterms: Included report items:
Topcon Logo [tem A Topcon Logo ltem
|dentical Points Bepart ies ‘ Praject Repart Move Up
Miznamed Autatopo Rovers Rep Fepeated Observations
Fepeated Obzervations Report Paint Summary Fepart
Project Repart |dentical Paints Report
Paint Surmary Feport
GPS Obs Repaort v |

<4 i Move Down
Optionz Optionz
Cloze

Figure 8-27. Ordenar Itens Incluidos

4. Para editar as op¢0es de itens, selecione o item desejado
e clique Options. Para detalhes da varia¢do da caixa de
didlogo Options para o item selecionado, veja “Editar a
Configuracdo do Relatdrio”.

5. Clique Execute para ver o relatério ou clique Done para
salvar a configuracéao do relatorio.
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Exportar a um Arquivo

O processo de exportacdo permite que os dados sejam salvos em
outros arquivos e formatos para serem abertos nas outras obras
do Topcon Tools, nos outros softwares compativeis a estes
formatos ou transferidos para um coletor.

Topcon Tools exporta os seguintes formatos:

* Arquivo de Coordenadas * Arg. Dados Brutos GPS+
ASCII/ TSV files (*.txt) RINEX files (*.2?0; *.2?G;
. *27N)
CR-5 Files (*.CR5)
Custom Text Format files (*.*) TPD files (*.tpd)
FC-5 Points (*.xyz; *.fc5) * Arg. Localizagao (*.gc3)
GTS-210/310-10 Points (*.xyz; ¢ Obras Topcon Tools (*.ttp)

*
g « Arg. Topcon XML (*.xml)
GTS-210/310-12 Points (*.xyz;
* pnt) e Arg. TopSURV (*.tlsv)
GTS-7 Points (*.xyz; *.pnt) e Arg. Dados Brutos ET
Name,E,N,Z,Code (*.csv) FC-5 Raw (*.raw; *.fc5)
Name,Lat,Lon,Ht,Code (*.csv) GTS-210/310 Raw (*.raw;
. *.dat; *.gts)
Name,N,E,Z,Code (*.csv)
. GTS-6 Raw (*.raw; *.dat;
» Arq. Caract. Topcon (*.tdd) * gts; *.gts6)
* Arquivos GIS GTS-7 Raw (*.raw; *.gts;
DXF files (*.dxf) *.gts7)
LandXML files (*.xml) GTS-7+ Raw (*.raw; *.gts;
*.gts7)

Shape files (*.shp)
* Arquivos de Vetores GPS
O files (O*.*)
Topcon Vectors (*.tvf)

Para maiores detalhes sobre o arquivo de formatos, veja a se¢ao
correspondente no Capitulo 3. Topcon Tools exporta alguns
formatos ndo importados:
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» DXF e arquivos de Forma sdo formatos populares usados
para transferor dados CAD e GIS. DXF é um formato nativo
do AutoCAD e Forma é o formato nativo do Arcinfo. A
maioria dos softwares GIS e CAD aceitam estes formatos e
podem ser usados para transferor os resultados da medicao
(coordenadas e codigos; para for DXF, algumas linhas
criadas automaticamente através de cddigos).

 Arquivos O é o formato nativo de Ashtech para a
transferéncia de observac@es (vetores) entre softwares.

» Topcon vectors é um formato simples, delimitados por
virgulas para a transferéncia de observacgdes (vetores) entre
softwares.

Topcon Tools exporta, tanto as informacdes selecionadas, como
todo arquivo.

1. Para exportar informacdes:

 Clque Job » Export, pressione F4 ou clique no botdo
Export to File da barra de ferramentas para exportar
todas as informagdes do arquivo.

* Selecione as informagdes desejadas e clique
Job » Export, pressione F4, clique no botdo Export to
File da barra de ferramentas, ou click-direito e depois
clique Export no menu pop-up para exportar as
informac6es selecionadas.

2. Na caixa de dialogo Export, navegue até a pasta destino.

3. Selecione Format name (Figura 8-28).

> 0

Defina o formato de exportacdo antes de continuar.
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| Export
Save in: |;] Data
File: narne; |
Format name: |15 ASCIl /TSVY files (<] |
[~ Advanced op =22 Bl )
+-=¢ Coordinate File (* kxt;* CRES;* cavy® ey ®.FoS ¥, pnky* %)
F Feature File (*,tdd)

+-=¢ QIS File (*.xml;* shp;*.dxf)
+-=7 GPS Yector File (0% % bvf)
+-=r GP3+ Raw Data File (¥, kpd;*, 7r0p*, 72aG;*, 72N)

= Localization Files (*,GC3)

 Topcon Tools Job (*.Eep)

& Topcon #ML File ¢*.xml)

=1 TopSURY Database File (*.tsv)

+-=¢ T3 Raw Data File (* raw;*.fc5;* dat;* gts;*,gbse;*.gts7)

Figure 8-28. Sele¢cdo do Formato de Exportagao

4. Caso queira, selecione as opcles detalhadas de exportacao
no painel Advanced options (Figura 8-29) para exportar
coordenadas, GIS, Dados Brutos GPS+, Localizacdo, Obras
Topcon Tools, Topcon XML, Base de Dados TopSURV e
Dados Brutos ET.

5. As opcdes avangadas diferem dependendo do formato
selecionado.

@ AVISO

Sem estar selecionado, a altitude sera ortométrica
(para grid->ground) ou elipsoidal (para
longitude/latitude).

» Dependendo do formato do arquivo exportado, defina o
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tipo de projecéo, o tipo de coordenadas, o datum, 0s
parametros de transformacdo grid->ground, unidades, e 0
modelo geoidal.

Habilite Orthometric Height para exportar estas
altitudes.

Save in |._'] Data = J @
File name: |Resic Par - ProcessedlG04
Fomnal name: | < ASCIL TSV fles: % but) j

Proiection [ Mane [ [
=]

Linear Uini |UsFest

Geaid | = GesidsList.,

[¥ Orthometiic Height
Cocrdmate tupe |Ged

Save Cancel

Figure 8-29. Exportar — Exemplo de Opc¢des Avancadas

@AVISO

Sem estar selecionado ou modificado nas Opc¢des
Avancadas, Topcon Tools usara a projecao, datum
e definicdo de gedide da obra ativada.

6. Digite 0 nome para o arquivo e clique Save.
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Apéndice A

Instalacao do Geoide Global

Topcon Tools traz um conjunto de gedides mais usados. Alguns
modelos geoidais estdo no CD do Topcon Tools ou na pagina
web TPS para serem baixados. Para outros ou geoides locais,
entre em contato com o seu distribuidor.

Para instalar o getide global EGM96, que vem com o CD de
Topcon Tools ou que pode ser baixados da pagina web TPS, é
necessario adicionar dois arquivos binarios a lista de geoides.

Com o Geoide Global instalado, o Topcon Tools pode ter a sua
velocidade reduzida, especialmente em PC velhos.

Use Topcon Link para converter o Gedide Global a
um geodide regional. Ao criar o arquivo .gff, lembre-
se de selecionar o territério correto das ocupacdes
coletadas.

O gedide global EGM96 traz dois arquivos binarios::
EGM096.glc e CORRCOEF.gla.

1. Parainstalar o gedide global, sigua os passo descritos em
“Adicionar um Geoide” da pag 2-16.

2. Na caixa de dialogo Open, selecione o formato do arquivo
Gedide Global e o arquivo EGM96.glc (Figura A-1), entdo
clique Open.
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:ﬂ Open EE3
Lok in: [S&Ps obs | «|®| ek
Egm3E.gle
File name: |
Format name: Geoid File [g* bin;*. aff ;= jff . glc;s* dat;* rgm;h®. byn) j
— Geoid File (g bin;* gff.* jff.* glc:s* dat.. rgm;he. byn) % L
=

' Australian Geoid Files [#*.dat]
Canadian Geoid Files [h*.byn)

27 Geoidd3 Files (g% bin)

Global Geoid File [*.glc)

Fiegional Geoid Model Files [*.rgm)
foy Topcon Geoid files [*.aff . iff]

mill

Figure A-1. Selegdo do Formato do Arquivo de Gedide

3. Selecione o arquivo CORRCOEF.gla e clique Open(Figura
A-2).

;Hl]pen E
Lookin: | GPS Obs =l =1

File name: |EDHHEDEF Open |
Farmat name: IEGM Coeff Comection File[*.gla] j Cancel |

&

Figure A-2. Selecao de Arquivo de Correcao
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4. Para verificar a instalacdo, click-direito sobre o gedide
global da caixa de didlogo Geoids List e clique Properties
no menu pop-up. A caixa de didlogo Properties mostra as
informacg6es do geoide selecionado. (Figura A-3).

3" Properties : Global Geoid model Egm96 EE3
Mame |Egm98
Path ID:\TopTools\GF’S ObsEgm3E.glc

Minimurn Latitude |SD’DU'DD.DDDS

Minimum Longitude |1 B0°00°00. Q00w

I aximum Latitude: ISD°DD'DD.DDDN

Mairurn Longitude [180°00'00.000E

QK I Cancel | Apply |

Figure A-3. Propriedades do Modelo Geoidal Global
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Notas:
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Teclas de Atalho

Apéndice B

A seguinte tabela lista as teclas de atalhos mais comuns do

Topcon Tools.

Table B-1. Teclas de Atalho Topcon Tools

Pressione.... Para executar....
Ctrl+C Copiar
Ctrl+Vv Colar
Ctrl+X Cortar
Ctrl+Y Refazer
Ctr+Z Desfazer
Ctrl+N Novo Arquivo (obra)
Ctrl+O Abrir Arquivo (obra)
Ctrl+P Imprimir
Ctrl+S Salvar Arquivo (obra)
Ctrl+A Selecionar Todo (na janela ativa)
Ctrl+E Habilitar
Ctrl+D Desabilitar
Ctrl+Enter Propriedades
Ctrl+T Vista Tabela
Ctrl+M Vista Mapa
Alt+Backspace Desfazer
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Shift+Del Cortar

Ctrl+Insert Copiar

Shift+Insert Colar

F1 Ajuda

F2 Editar célula atual (na tabela)
F2+Ctrl Configuracdo da Obra

F3 Importar

F3+Ctrl Importar de Instrumento
F4 Exportar

F4+Ctrl Exportar ao Instrumento
F7 Pés-processamento GPS+
F8 Ajustamento

Shift+F8 Localizagéo

F9 Configuragdo de Relatério
Ctrl+Shift+N Sem selecéo (deselecionar)
Ctrl+Shift+l Insertar Selecéo
Ctrl+Shift+P Selecionar Ponto
Ctrl+Shift+T Selecionar Ocupagdo ET
Ctrl+Shift+G Selecionar Ocupagdo GPS
Ctrl+Shift+M Selecionar Obs TS
Ctrl+Shift+O Selecionat Obs GPS
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Conectores

Conector Serial C-RS232C

Apéndice C

Este cabo é usado para conectar o receptor TPS (portas A e D)
ao computador. Figura C-1 mostra os conectores do receptor.

Figure C-1. Conector do Receptor C-RS232C

Tabela C-1 mostra as especificaces deste conector.

Table C-1. Especificagdes do Conector RS232

Ndmero Nome do Sinal Dir Detalhes

1 Power_OUT Alimentacdo (1<0.2 A)
2 GND Sinal Terra

3 CTS Livre para Enviar

4 RTS Pedido de Envio

5 RXD Receber Dados

6 TXD Transmitir Dados

7 - Ndo Utilizado
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Os tipos de conectores sdo SEALED RECEPTACLE, 7- pin
W.W. FISCHER, INC, p/n DBEU 102 A056

Table C-2. Equivaléncia dos Pinos dos Conectores

DB9

Receptor TPS Fémea

N ool w N
P |IN|W [0 |N|O

Estado da Porta COM do Receptor

As seguintes opcOes de interface RS232C (Tabela C-3) séo as
configuragdes padrdo de comunicacao para softwares.

Table C-3. Configuragédo Padréo da Porta

Opcéo de Comunicagao Configuragéo Padrao

Modo de Entrada da Porta | CMD para GRIL ou Comando para PC-CDU; a
porta esta no Modo Comando. Neste modo, a
porta reconhece os comandos enviados pelo
usuario.

Hardware handshaking OFF

Baud rate da porta Serial 115200 baud

Stop bits 1
Paridade N (nula)
Data bits 8
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